MYOB New Zealand Ltd
Website: myob.co.nz/
© MYOB Technology Pty Ltd 2013
All rights reserved.

Disclaimer
Information supplied by the member companies of the MYOB group (whether in user documentation and other literature, video or audio material, training courses, websites, advice given by staff, or provided by other means) is intended only to illustrate general principles, and may not be complete, accurate or free of error. As accounting standards, taxation requirements, legislation and the circumstances of individual businesses vary widely, this information cannot be considered authoritative and may not apply to your specific situation. You should obtain competent advice from a qualified accounting, taxation, information-technology or legal professional before acting on such information. To the extent permitted by law, member companies of the MYOB group are not liable for any special, consequential, direct or indirect damages arising from loss of function, profits or data resulting from your application of such information. In the event that any of the above limitations are found to be unenforceable, the MYOB member company’s liability is limited to the return of any fees or monies paid for the purchase of the product or service.

Trademarks

Adobe®, Acrobat®, Acrobat Reader®, Adobe Reader®, PDF®, and PostScript® are trademarks or registered trademarks of Adobe Systems Incorporated. AddressBook, Apple®, iMac, AirPort, iCal, Macintosh®, and QuickTime® and the QuickTime logo are registered trademarks of Apple Inc. MobileMe™ is a service mark of Apple Inc. Mac and the Mac logo are trademarks of Apple Inc., used under licence. Brio Intelligence and Hyperion Intelligence are trademarks or registered trademarks of Hyperion Solutions Corporation, Ctree use by permission from Faircom®, Dapper used under licence with Apache Software, NIXPS used under licence, WinForms control set and DevExpress controls used under licence from Developer Express Inc. Crystal Reports® is a registered trademark of Crystal Decisions, Inc. in the United States or other countries. FlexNet Connect® is a registered trademark of Flexera Software Inc. Google Maps™ card links included with permission. MasterCard® is a registered trademark of MasterCard International Inc, xerces is licenced under Apache Software. Microsoft, Access, Azure, Excel, Internet Explorer, .Net Framework, Office, Outlook, Smart Tags, Ribbon Control Library, SQL Azure, SQL CE, Windows, Word and WFPToolkit, are registered trademarks or trademarks of Microsoft Corporation in the United States or other countries. DotNetZip is licensed under the Microsoft Public Licence. Fluent.Net is licensed under the Apache 2.0 Licence. N-Log is licensed under the BSD Licence. LLBLGen is used under licence from Solutions Design bv. New Relic is a registered trademark of New Relic, Inc. JSP.Net is licensed under the MIT licence. QuickBooks® and QuickBooks® are registered trademarks of Intuit Inc. SM2DGraphView Copyright Snowmint Creative Solutions LLC snowmints.com. VISA® is a registered trademark of Visa International Service Association. RightNow CX® is a registered trademark of RightNow Technologies Inc. Sentry Spelling Checker Engine for Windows, copyright Wintertree Software Inc. BankLink is a trademark of Media Transfer Services Inc. Other products mentioned may be service marks, trademarks or registered trademarks of their respective owners.

Writers
Suchitra Govindarajan, Merrin Hughes, Claire Mahoney, Rachael Mullins, Kylie Nicholson, Steven Rao, Ron Tierney, John Wilson.

MYOB Software Licence Agreement

IMPORTANT - READ THIS CAREFULLY BEFORE USE. This is the Software Licence Agreement ("Licence Agreement"). As you have purchased the Product (consisting of the User Documentation and the Software) following notification of the Licence Agreement you are now legally bound by its conditions.

HOWEVER, if the Licence Agreement contains anything of which you were not aware prior to purchasing the Product or do not agree to be bound by. DO NOT INSTALL THE SOFTWARE but return the Product to the seller in its entirety and a full refund of the purchase price will be made. By installing the Software and keeping the Product you are confirming that you have purchased the Product subject to this Licence Agreement and are bound by its provisions.

TRIAL VERSION SOFTWARE LIMITATION. If you use this Software on a trial basis prior to purchase, then additional restrictions govern its use. The Trial Version is intended to be used only for evaluation purposes and whilst you may create your own company data files ("Company Files") you will have access to your Company Files only until the earlier of 30 days from the date of creation of each Company File or until you have entered a total of 1000 transactions into the Company Files you have created.

Thereafter, you will be able to access the Company Files created by you only upon your purchase of the full version of the Product. Upon your purchase of the full version of the Product, the restrictions in this paragraph (Trial Version Software Limitation) shall no longer apply, but you acknowledge that your use of the full version of the Product will be conditioned on your agreeing to the terms of the Licence Agreement (including the limitation on the number of Company Files) accompanying the full version of the Product.


1 Scope of Licence

MYOB Technology Pty Ltd (the Publisher), through its local publishers and distribution agents, hereby grants to you, the original purchaser, a paid-up, personal, non-exclusive and non-transferable Licence to use the Software and the User Documentation only in the region, territory or country specified on the packaging or download, subject to the terms and conditions of this Licence Agreement.

a Activation of Company Files You must register the Product and activate the Company Files you create or upgrade with the Software. Company Files may only be activated or upgraded in respect of the business that you operate. You are entitled to activate or upgrade only the Company Files you have purchased. If you are upgrading from a previous version of the Product you are entitled to activate the same number of files as your previous version. If required, you can obtain additional Company files by contacting MYOB New Zealand Ltd.

i New Company Files You may only access each new company file you create for 30 days without registering the Product and activating the company file. After 30 days each new company file will become read-only until you activate it.

b Product Installation and usage If you have purchased:

i Single User Software Licence then you may install the Software on any computer that you operate at your principal place of business in respect of company files you have activated, provided that you do not use or permit the usage of the Software on more than one computer or computer terminal at a time. In event of an upgrade or Product exchange the Licence hereby granted shall automatically transfer to the new version or Product.

ii Multi-User Software Licence then you may use the Software on only one computer network that you operate at a single physical location and only then in respect of company files created and activated by you or by another licensed user. You may transfer the Software from one computer to another that you own or operate on this network provided that you only use or permit the usage of the Software on the number of computer or computer terminals at a time for which you have purchased user licences and do not permit the usage of the Software on more than one network at any one time, nor permit the Software to be used in respect of company files that you have not activated or have not been created by you or by another licensed user.

iii AccountRight Live subscription then you have unlimited access to download and use the Software on multiple computers in different physical locations.

c Number of Users At any given time, you or your delegated agents may only launch and simultaneously run the number of Software runtime instances equivalent to or less than the number of user licences you have purchased and open and simultaneously work with only the same number of company files, which must be created and activated by you or your related entities.

i AccountRight Live subscription At any given time, you and your nominated users may launch and simultaneously run the number of Software runtime instances equivalent to or less than the number of user licences you have purchased and open and simultaneously work with only the same number of company files, which must be created and activated by you or your related entities.

d Updates and Upgrades In the event of an upgrade, update or product exchange, the Licence hereby granted shall automatically transfer to the new version or product. All rights in respect of the original Product shall lapse and no further use of these shall be permitted.

e Portable or Home Computer and Archive Copies You may make a copy of the Software and install it on either a portable computer or a computer located in your home provided that the copy is for your own exclusive use and is not operated simultaneously with the original of the Software. Otherwise you may not copy or duplicate the Software, except as necessary solely for archival purposes, Software error verification, or to replace defective storage media, provided you keep the original and the copies. You may not alter, decompile or disassemble the Software. You may make copies of the User Documentation up to but not exceeding the number of multi-user Licences you have purchased.

i AccountRight Live subscription You may operate the original software via download simultaneously on multiple computers in different physical locations.

f Transfers You may not sub-license, lease, rent or lend the Software or the User Documentation or otherwise transfer any of your rights under this Licence Agreement. Subject to the prior written consent of the Publisher and the agreement of the transferee to be bound by the terms of this Licence Agreement, you may permanently transfer the Software (together with any backup copies you have made) and the User Documentation. However, you may not retain any copies of either the Software or the User Documentation.

g Term The Licence granted in this Licence Agreement is effective until terminated. You may terminate it at any time by destroying the Software and User Documentation, together with all copies, or by returning them to the Publisher. If you fail to meet the ongoing obligations accepted by you at the time of registration (if applicable) or if you fail to comply with any term or condition of this Licence Agreement, this Licence will terminate and, upon any such termination, you agree to destroy the Software and User Documentation, together with all copies, or return them to the Publisher. Termination of this Licence Agreement shall be in addition to and not in lieu of any other remedies available to the Publisher. In the event that the Publisher deems this product to be redundant then the Publisher may at its option supply you with an alternative product and terminate this Licence Agreement.

i AccountRight Live subscription If your subscription to AccountRight Live is terminated:

(A) If you have a Licence to use this Software, you can continue to use this Software in accordance with this Licence Agreement; or

(B) If you do not have a Licence to use this Software, you will have read only access to data you have saved locally.

h Protection and Security This Licence Agreement specifically prohibits the reverse engineering or decompiling or interference in any manner with the Software’s source code. Further you agree to use your best endeavours and to take all reasonable steps to safeguard the Software to ensure that no unauthorised person has access to the Product and that there is no unauthorised copying or distribution of the Software or User Documentation.
**Partner Program** If this Product is being used in the context of the MYOB Professional Partner Program in either Australia or New Zealand, then the usage of the Software and any Company files is strictly restricted to being within the practice itself. Without in any way limiting the scope of this restriction, the sharing of Company files or Software with any clients of the practice is specifically prohibited.

2 **Limited Warranty & Disclaimer**

The Publisher warrants that the media on which the Software is recorded or the downloaded installer and the User Documentation provided with them are free from defects in materials and workmanship under normal use for a period of 90 days from the date of your original purchase. Except for the limited warranty described above, the Software is sold 'as is', and you are assuming the entire risk as to its quality and performance. It is your responsibility to verify the results obtained from the use of the Software.

If during the 90 day limited warranty period, you discover physical defects in the media on which the Software was recorded or the downloaded installer or in the User Documentation, the Publisher will replace them at no charge to you, provided you return the item to be replaced with proof of purchase to the Publisher. THIS IS YOUR SOLE REMEDY. IN NO EVENT WILL THE PUBLISHER BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR SIMILAR DAMAGES, EVEN IF THE PUBLISHER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow the exclusion or limitation of implied warranties or of liability for incidental or consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific legal rights and you may also have other rights that vary across regions. In the event that any of the above limitations or exclusions are held to be unenforceable, the Publisher's total liability shall not exceed the amount of the Licence fee you paid.

3 **Entire Agreement**

This Licence Agreement constitutes the entire agreement between the Publisher and the Licensee and any prior representations, statement or undertaking howsoever made are expressly cancelled. No amendment or modification to this Licence Agreement shall be valid unless it shall be in writing and signed by an authorised representative of the Publisher.

---

**Definitions**

Some words in these Terms have particular meanings:

- **Bank Feeds** or **BF** means the service which enables you to electronically receive daily or monthly updates of bank account transaction details for your nominated accounts, including your business account and credit card.
- **Bank Statement Information** means the transaction information relating to any account linked to the BF and that is available for you to access as part of MYOB AccountRight Live.
- **BankLink** means Media Transfer Services Limited trading as BankLink.
- **Business Day** means a week day, except for a national public holiday;
- **Business** means the business for which the application is made and accepted for MYOB AccountRight Live.
- **Fees** means fees and charges relating to the provision of MYOB AccountRight Live.
- **Loss or Claim** means any loss, liability, action, proceeding, damage, cost or expense (including all reasonable legal costs and expenses), including liability in tort and consequential and economic losses.
- **Microsoft** means Microsoft Regional Sales Corporation and Microsoft Operations Pte. Ltd, and includes any successor, assignee or replacement organisations.
- **Minimum Term** means the minimum term of your subscription to MYOB AccountRight Live that you agree to when you subscribe.
- **MYOB AccountRight Live** means the features and services which we make available to you from time to time and which comprise a bundle of features (including online features) and services which you choose to use with your MYOB AccountRight product.
- **Personal Information** means that term as defined in the Privacy Act. Basically, this is information about an identifiable individual.
- **Privacy Act** means the Privacy Act 1988 (Cth) as updated, amended or replaced from time to time.
- **Professional Partner** means a person who provides bookkeeping, accounting or similar services to you, and who you appoint as a User.
- **Third Party** means any person we have contracted with to help us provide MYOB AccountRight Live services. This may include Microsoft, BankLink and all other service providers engaged by us for the delivery, maintenance and administration of MYOB AccountRight Live.
- **User** means a person authorised by you to use MYOB AccountRight Live (including a Professional Partner).
- **We, us and our** means MYOB NZ Limited.
- **You** means the Business, including each User.
2 GENERAL TERMS

a Protecting your username and password

i) Unless you take adequate security precautions, it could be possible for an unauthorised person to gain access to your MYOB AccountRight Live. It is important to take all reasonable precautions to ensure your username and password are not misused, and remain secure and confidential. In particular:

(A) you must not tell anyone your username or password, including any member of your family;
(B) you must not let anyone else, whether acting as your agent or not, access MYOB AccountRight Live using your username and password; and
(C) you must be extra careful when accessing MYOB AccountRight Live from public computers.

ii) If you think anyone else might know your password you should reset your password from within your MYOB AccountRight product, or contact us as soon as possible to arrange a new password.

iii) You agree to be liable if your login details are used by an unauthorised person.

b Other responsibilities you have as a User

i) No interference with MYOB AccountRight Live – You will not:

(A) interfere with the operation of MYOB AccountRight Live;
(B) reverse-engineer, reverse-assemble, decompile, or otherwise attempt to discover source code, formulas or processes in respect of the software behind MYOB AccountRight Live;
(C) copy, reproduce, alter, modify, create derivative works, or publicly display, any part of any content from MYOB AccountRight Live, except where we have given you permission;
(D) use MYOB AccountRight Live in a way that is prohibited by law, regulation or government order in any relevant jurisdiction, or in a way that violates a third party’s legal rights;
(E) use MYOB AccountRight Live in a way that could harm or impair anyone else’s use of it;
(F) use MYOB AccountRight Live to gain unauthorised access to any service, data, account or network by any means;
(G) falsify any protocol or email header information (e.g. spoofing);
(H) use MYOB AccountRight Live to send “spam” or otherwise make available any offering designed to violate these Terms; or
(I) remove, modify, tamper with any regulatory or legal notice or link that is incorporated into MYOB AccountRight Live.

ii) Cooperation and limited authority in relation to Third Parties – You:

(A) must do all things we consider appropriate to enable us to fulfil our obligations to Third Parties in relation to MYOB AccountRight Live; and

(B) authorise us to give a Third Party or other person any authority, consent or instruction in respect of MYOB AccountRight Live, to enable us to provide MYOB AccountRight Live to you.

iii) Giving access to other Users – You can authorise other users (including a Professional Partner) to have access to your MYOB AccountRight Live data. Subject to the access rights you grant, they will be able to view and modify your data. Their use of MYOB AccountRight Live is subject to these Terms, so we suggest that you provide them with a copy. You are responsible for their use of MYOB AccountRight Live. You can stop or change their access rights by updating your user list within your my.MYOB personal management centre or by contacting us.

iv) Change of details – You must let us know of any changes to your details which you have provided to us in relation to MYOB AccountRight Live, and provide any proof of the change we require.

c Use of MYOB AccountRight Live and our intellectual property

i) What you can do – until your use of MYOB AccountRight Live is terminated, you have a non-exclusive and non-transferable licence to use MYOB AccountRight Live in the way that we authorise from time to time.

ii) We retain our intellectual property rights – except where specifically set out in these Terms, these Terms do not give you any intellectual property or other rights in any of our:

(A) software, documents, templates, marketing material, trademarks, business names, logos, trading styles, get-up, processes or methodologies; or
(B) other intellectual property,

iii) and you (including your staff, agents or contractors) must not otherwise use, reproduce or modify these intellectual property rights.

iv) Third Party intellectual property rights – these Terms do not give you any intellectual property or other rights in any of the software or other intellectual property supplied by any Third Party as a part of MYOB AccountRight Live, and you (including your staff, agents or contractors) must not otherwise use, reproduce or modify these intellectual property rights.

d Payment of Fees

i) You must pay us all Fees due to us in relation to your use of MYOB AccountRight Live, on the due date and otherwise in accordance with the payment terms you have entered into with us. If you cancel your participation before the end of the Minimum Term, then you must pay to us the subscription fees for the remainder of that Minimum Term.

ii) If a another person (for example, a Professional Partner) who pays the Fees in relation to your use of MYOB AccountRight Live stops paying the Fees due to us, then you will need to pay the Fees due to us to continue your use of MYOB AccountRight Live.

iii) By giving you at least 20 Business Days’ notice before the change takes effect, we may:

(A) change the amount of any Fee and introduce a new Fee; and
(B) change the circumstances in which, or frequency with which, a Fee is payable.

iv) Section 8 tells you about the ways in which we can give you notice.

v) You authorise us to deduct the periodical instalments and any other Fees payable to us in respect of your use of MYOB AccountRight Live. You give us this authority by providing us with your credit card or other payment details. The authority continues after the end of the Minimum Term until your participation in MYOB AccountRight Live is terminated in accordance with these Terms.

e Goods and services tax (GST) and duties

i) All payments due to us (eg. Fees, reimbursement by you to us of any amounts or payments under indemnities), unless already stated to be GST inclusive, are to be increased by the amount of any GST liability we have in relation to supplies we make to which those payments relate.

ii) You must pay all duties (eg. stamp duty, other government charges or financial institution account fees) payable in relation to your use of MYOB AccountRight Live. If we have paid them, they must be reimbursed by you on our request.

3 BANK FEES (BF)

The following terms and conditions apply only to the use of Bank Feeds:

a Access to Bank Statement Information - Using BF, you can receive Bank Statement Information for all nominated bank accounts that you have linked to the BF. If you want to use the BF, you will need to provide an authority form that will enable BankLink to request your bank to provide Bank Statement Information to you.

b Bank Accounts - You may only use the BF service for bank accounts attached to your Business.

c Fees - If the bank whose accounts are linked to the BF charges you directly for fees in connection with your account and your use of the BF in relation to that account, you are responsible for and must pay those fees. If you don’t do this, we may not be able to provide the BF to you.

d Fair Use Policy for Bank Feeds - Although we do not currently apply a fee on the number of bank statement transactions received through the BF, you acknowledge and agree that we may, in our sole discretion, apply a fee for excess transactions at any time. Without limiting our rights under this section, we reserve the right to charge for transactions if the number of transactions in a month exceeds 300, at a rate not greater than $0.10 per transaction in excess of 300 transactions.

4 AVAILABILITY OF ACCOUNTRIGHT LIVE

MYOB AccountRight Live could be disrupted if system(s) failure occurs due to technology used by either us or Third Parties involved in providing MYOB AccountRight Live. Online services are subject to interruption, breakdown, viruses, delays, interception, interference and other errors involving communications networks, computer systems, servers, providers, computer equipment and software. Delayed receipt of Bank Statement Information could result in transactions not being available on a particular day.

In relation to any device which you use to access MYOB AccountRight Live, we recommend that you obtain and maintain up-to-date virus, security and intrusion prevention and scanning software which is specifically designed for all devices you use to access MYOB AccountRight Live.

MYOB AccountRight Live may also be unavailable for short periods because of necessary or desirable system maintenance or upgrades. If this is needed, we will try to inform you beforehand.

Subject to the terms of section 6 below, we are not responsible or liable to you or the Business for any Loss or Claim arising from MYOB AccountRight Live or any part of them being delayed, disrupted or unavailable.

In order to maximise your business continuity, we encourage you to take steps to back up and archive your data on a regular basis.

5 TERMINATION

a How can you end your participation in MYOB AccountRight Live?

You can cancel your participation in MYOB AccountRight Live by giving us at least 20 days written notice before the end of the current period of your chosen monthly or annual subscription. The effective date of termination will be the last day of the current period of your subscription.

Your participation in MYOB AccountRight Live will cease on the effective date of termination. However, during the notice period, you are still liable for any Fees in relation to your use of MYOB AccountRight Live up to the effective date of termination.

If you cancel your participation before the end of the Minimum Term, then you must pay to us the subscription fees for the remainder of that Minimum Term. Refer also to section c below for other important content about what happens on the effective date of termination.

b When we can suspend or terminate your participation in MYOB AccountRight Live without prior notice

i) Circumstances

These are the situations in which we can suspend or terminate your participation in MYOB AccountRight Live without prior notice. We will notify you of your suspension or termination as soon as possible.

The situations are:

(A) A breach occurs:

– you fail to remedy a material breach of these terms and conditions within 5 Business Days after we notify you of the breach;

(B) Something threatens MYOB AccountRight Live:

– in our opinion, a change to any Third Party arrangement necessary for MYOB AccountRight Live renders the ongoing operation of MYOB AccountRight Live substantially unworkable or non-functional;
—in our opinion, the actions of a regulator or a change in law or regulation makes the ongoing operation of MYOB AccountRight Live substantially unworkable or non-functional; or
—we believe this is necessary either to protect the security, integrity or reputation of MYOB AccountRight Live or any MYOB AccountRight Live function, service or facility, or to otherwise protect our interests;
(C) There is a material change to your Business:
—you go into liquidation, administration, insolvency, bankruptcy or such other similar arrangement with creditors, or in our opinion, it is reasonably likely you will do so; or
—there is a change in who owns or controls your Business.

ii) Notification
(A) We will make reasonable attempts to notify you in writing (which includes by email) of the suspension or termination.
(B) We can reinstate a suspension or termination in our absolute discretion by written notice to you, and this takes effect on receipt or any later time specified in the notice, subject to you meeting any conditions set out in the notice.
(C) If you become aware that a circumstance which would permit us to suspend or terminate your participation or use under section 5b(i)(C) above has arisen or may arise, you must advise us in writing as soon as possible.

c What happens on the effective date of termination?

i) Limited period for data extraction: subject to any of our arrangements with Third Parties, you will have 30 days from the effective date of termination to extract your data from MYOB AccountRight Live. After the effective date of termination, you and other Users (including your Professional Partner) will be able to access it as read-only files or access it and amend it (read and write files), depending on the rights designated by us. We strongly recommend that you extract your data for archive purposes as soon as possible. We may take steps to delete your data from our servers at any time after 30 days following the effective date of termination, whether or not you have extracted your data.

<table>
<thead>
<tr>
<th>Licence and/or Subscription</th>
<th>Company File access if MYOB AccountRight Live subscription terminated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop software licence and MYOB AccountRight Live subscription</td>
<td>Read and write access on desktop only</td>
</tr>
<tr>
<td>MYOB AccountRight Live subscription</td>
<td>Read only access on desktop only</td>
</tr>
<tr>
<td>No desktop software licence</td>
<td></td>
</tr>
</tbody>
</table>

ii) Continuation of limitations on liability: any limitations on liability which you have given under the Terms continue after termination in relation to your use of MYOB AccountRight Live.

6 LIABILITY, WARRANTIES, REPRESENTATIONS AND INDEMNITIES

Subject to section 1 and to the extent permitted by law:

a Liability for guarantees, conditions or warranties

i) Our maximum aggregate liability to you:
(A) for failure to comply with a consumer guarantee in respect of the supply, failure to supply or unavailability of MYOB AccountRight Live; or
(B) for loss or damage suffered by you as a result of any misrepresentation, negligence, default or breach of these Terms by MYOB, is limited, at MYOB’s option in its sole discretion to:
(C) the resupply of MYOB AccountRight Live; or
(D) the payment of the cost of resupply of MYOB AccountRight Live, and all representations, conditions, warranties and terms (including claims in relation to our performance, the performance of MYOB AccountRight Live or any service associated with MYOB AccountRight Live) that would otherwise be expressed or implied in these Terms by general law, statute or custom are expressly excluded (to the extent that such representations, conditions, warranties and terms can be excluded at law).

ii) You acknowledge and agree that nothing in these Terms is intended to limit any of the liability terms and exclusions set out in the software licence agreement for your MYOB AccountRight product.
b When we and Third Parties will not be liable to you

We and Third Parties (including Microsoft and BankLink) are not responsible or liable to you or the Business for:

i) any Loss or Claim relating to the provision of the data (including Bank Statement Information) made available through MYOB AccountRight Live, including delays, disruptions, inaccuracies or the loss of data;
ii) any Loss or Claim relating to your use of, or reliance upon data (including Bank Statement Information) provided to you through MYOB AccountRight Live;
iii) the actions or inaction of Third Parties or other persons (including those which may be negligent or unauthorised) relating to MYOB AccountRight Live;
iv) any Loss or Claim arising from a failure by us to comply with the Terms for any cause which could not reasonably be controlled or prevented by us; or
v) any Loss or Claim arising from a failure by you or the Business to maintain back up copies or archive records of your data.

c Indemnity to us and Third Parties

i) You indemnify us, our staff and Third Parties (including Microsoft and BankLink) (Indemnified Parties) against any Loss or Claim suffered or incurred by the Indemnified Parties or any of them arising from your action including negligence, misrepresentation, fraud, breach of law or breach of the Terms. You indemnify the Indemnified Parties for any Loss or Claim suffered or incurred from the unauthorised use of your Username or a Password.

ii) If the Indemnified Party caused or contributed to a Loss or Claim, then your liability under section (c)(i) above is limited to the amount of the Loss or Claim which is directly attributable to your conduct.

d Consumer Guarantees Act

You acknowledge and accept that you are using MYOB AccountRight Live for the purposes of a business and the provisions of the Consumer Guarantees Act 1993 do not apply in relation to the provision of MYOB AccountRight Live.

7 CHANGES TO TERMS

a What can we do? We may change any of the Terms (including the Fees, which are specifically dealt with in section 2d(ii) above).

b Prior notice - We’ll endeavour to give you at least 10 days’ prior notice (longer if required by legislation or any other code of conduct we subscribe to) of any change that is likely to materially affect or disrupt the manner in which you use MYOB AccountRight Live, except in circumstances where such a change is due to a change by a Third Party and we were not aware of the change in advance. In these circumstances we will endeavour to notify you in a reasonable time period after becoming aware of the change.

c Urgent changes - However, if we need to restore or maintain the security of MYOB AccountRight Live immediately, we may change your use and access to MYOB AccountRight Live without advance notice.

8 NOTICES

You will agree that all communications between you and us in relation to MYOB AccountRight Live will be by email, by notification through your MYOB AccountRight product or by us posting a notification on the MYOB website (myob.com), unless another method is agreed to by the addressee.

Any notice or other communication to or by a party by email is regarded as being given by the sender and received by the addressee when a delivery confirmation report is received by the sender which records the time that the email was delivered to the addressee’s email address (unless the sender receives a delivery failure notification indicating that the email has not been delivered to the addressee).

If the delivery or receipt is on a day which is not a Business Day or is after 5.00pm (addressee’s time) it is regarded as received at 9.00am on the following Business Day.

We may provide a notice or other communication to you by a posting to the MYOB website. That notice or other communication is regarded as being given by us and received by you when the posting is made to the MYOB website. We recommend that you bookmark and regularly check the MYOB website (myob.com) for notices or other communications.

9 LEGAL

You should note a few things about the Terms:

a Our complete agreement – The Terms, the software licence agreement for your MYOB AccountRight product and any other documents incorporated by reference, contain the whole of the agreement between us and you in relation to MYOB AccountRight Live. Any representations or warranties made by our staff before you are accepted for participation in MYOB AccountRight Live are not effective unless expressly set out in the Terms or the other documents specified above. Any waiver of our rights or powers under these Terms may only be given in writing signed by our authorised officer.

b What happens if some of the Terms can’t operate? If any part or provision of these Terms is void, unenforceable or illegal in a jurisdiction, that part or provision does not apply in that jurisdiction. However, the remainder of the Terms continue in operation in that jurisdiction unless this would alter the basic agreement between you and us, in which case we can terminate your use of MYOB AccountRight Live at our election.

c No waiver by us – If we do not insist upon strict performance of any part or provision of these Terms, that waiver will not be deemed to be a waiver of a subsequent breach or default of these Terms.

d Assignment – You cannot assign or otherwise transfer the benefit of the agreement between us and you without our prior written consent. We can assign or otherwise transfer the benefit of the agreement between us and you.

e Which laws apply to the Terms? The Terms are governed by the laws of Victoria and the courts of Victoria have jurisdiction over the parties to the Terms (being you and us).
10 YOUR PRIVACY

a The collection of limited Personal Information is essential to our ability to provide MYOB AccountRight Live. The collection, use and disclosure of your Personal Information by us is regulated by the Privacy Act and other laws which protect your privacy. For more about our policy on the management of your Personal Information generally, see our Privacy Policy which is available by request or on the MYOB website at http://myob.co.nz/pages/privacy-policy-1257828257267.

b You consent to the sharing of information including your Personal Information between us and Microsoft in relation to your use of MYOB AccountRight Live. You acknowledge and consent that MYOB, Microsoft and its agents may, in providing part of MYOB AccountRight Live transfer, host and process your information, including your Personal Information and any information entered into MYOB AccountRight Live, which may include the Personal Information of third parties (such as your employees, suppliers or contractors), in Singapore, the United States and other countries. You acknowledge that while service providers will often be subject to other confidentiality or privacy obligations, they may not in all cases be subject to the specific requirements of Australian privacy laws.

c You consent to the sharing of information including your Personal Information between us and BankLink in relation to your application for, and if you are approved, the ongoing administration of your use of the BF.

d Notwithstanding the Privacy Policy, we may observe your use of MYOB AccountRight Live and access all information you input or can access through MYOB AccountRight Live. This will enable us to assist you with problems and make improvements for future versions of MYOB AccountRight Live and other products and services. Microsoft may also use your data, including Personal information, to provide part of MYOB AccountRight Live. This includes Microsoft: (1) troubleshooting problems affecting the operation of the Microsoft services relevant to MYOB AccountRight Live; (2) improving features that detect and protect against emerging and evolving threats (e.g. malware); and (3) obtaining statistical data, trends and usage information for the purposes of providing, operating, maintaining and/or improving their service. For further information on how Microsoft may use your information please read their Windows Azure Platform Privacy Statement (current at the date of these Terms) at http://www.microsoft.com/online/legal/en-us/azure_privacy_statement.htm

e You must ensure that all Users read this ‘Your privacy’ section and the policies described above before using MYOB AccountRight Live or providing their Personal Information to us.

f If you provide any Personal Information about third party individuals to us, you must take reasonable steps to ensure that those individuals are aware of the matters in this ‘Your Privacy’ section and that we may collect, use and disclose their information to provide you with MYOB AccountRight Live.
Contents

1 Introduction ................................................................. 13
  Learning about AccountRight .............................................. 13
  Where to start .................................................................. 15
  Exploring AccountRight ...................................................... 17
  About AccountRight Live .................................................... 22

2 Creating a company file .................................................. 25
  Overview ........................................................................ 25
  Create a company file ....................................................... 26
  Activate the company file ................................................... 29
  Set up accounts ................................................................ 30
  Enter account opening balances ........................................ 33
  Set up preferences .......................................................... 35
  Set up user access ............................................................ 35

3 Setting up ....................................................................... 41
  Overview ........................................................................ 41
  Set up sales .................................................................... 42
  Set up electronic payments ............................................... 44
  Do an initial bank reconciliation ......................................... 46
  Set up bank feeds ............................................................ 49
  Create item records ......................................................... 51

4 Working online ............................................................... 53
  Get started online ............................................................ 53
  Set up a file for online access ............................................ 54
  Work on an online company file ........................................ 55
  Synchronise a company file .............................................. 56
  Work offline (checking out) ................................................ 58
  Troubleshoot AccountRight Live ....................................... 60

5 Banking ...................................................................... 65
  About bank feeds ............................................................ 66
  Approving a bank feed ...................................................... 68
  Using bank feed rules ........................................................ 70
  Recording money you have spent and received ..................... 74
  Preparing a bank deposit .................................................... 78
  Electronic payments ........................................................ 79
  Transferring money between accounts ................................ 80
  Reconciling your bank accounts ......................................... 82

6 Sales ............................................................................ 87
  Creating a customer card ................................................... 87
  Entering sales .................................................................. 89
  Changing a sale’s type ....................................................... 93
  Reviewing your sales information ...................................... 94
  Receiving payments ........................................................ 95
  Printing payment receipts ................................................ 98
  Credit control .................................................................. 98
  Customer credits ................................................................ 100
  Accounting for bad debts .................................................. 103

7 Lists ............................................................................. 105
  Adding a record ................................................................ 105
  Setting up GST codes ...................................................... 106
  Finding a record ............................................................... 108
  Changing a record ........................................................... 109
  Inactivating or reactivating a record ................................... 109
  Deleting a record ............................................................. 110
  Combining records ........................................................... 110
  Customising item records ................................................ 112

8 Transactions ................................................................. 115
  Finding a transaction ......................................................... 115
  Changing or deleting a transaction ..................................... 117
  Reversing a transaction ..................................................... 119
  Recurring transactions .................................................... 120
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Reports</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td>Producing reports</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td>Customising reports</td>
<td>127</td>
</tr>
<tr>
<td>10</td>
<td>Forms</td>
<td>133</td>
</tr>
<tr>
<td></td>
<td>Finding forms</td>
<td>133</td>
</tr>
<tr>
<td></td>
<td>Sending forms</td>
<td>134</td>
</tr>
<tr>
<td></td>
<td>Customising forms</td>
<td>137</td>
</tr>
<tr>
<td></td>
<td>Adding and editing form elements</td>
<td>138</td>
</tr>
<tr>
<td></td>
<td>Saving customised forms</td>
<td>143</td>
</tr>
<tr>
<td></td>
<td>Exporting and importing customised forms</td>
<td>144</td>
</tr>
<tr>
<td>11</td>
<td>Contact management</td>
<td>145</td>
</tr>
<tr>
<td></td>
<td>Creating a card</td>
<td>145</td>
</tr>
<tr>
<td></td>
<td>Keeping in touch with your contacts</td>
<td>146</td>
</tr>
<tr>
<td></td>
<td>Grouping your contacts</td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>Synchronising cards with Microsoft Outlook contacts</td>
<td>152</td>
</tr>
<tr>
<td></td>
<td>Customising cards</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>Reviewing your contact information</td>
<td>160</td>
</tr>
<tr>
<td>12</td>
<td>Financial control</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>Tracking financial information</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>Budgets</td>
<td>163</td>
</tr>
<tr>
<td></td>
<td>Reviewing financial information</td>
<td>166</td>
</tr>
<tr>
<td>13</td>
<td>End-of-period procedures</td>
<td>169</td>
</tr>
<tr>
<td></td>
<td>Month-end procedures</td>
<td>169</td>
</tr>
<tr>
<td></td>
<td>Closing a financial year</td>
<td>176</td>
</tr>
<tr>
<td>14</td>
<td>Managing user accounts and company files</td>
<td>179</td>
</tr>
<tr>
<td></td>
<td>Manage users</td>
<td>179</td>
</tr>
<tr>
<td></td>
<td>Manage bank feeds</td>
<td>182</td>
</tr>
<tr>
<td></td>
<td>Manage libraries</td>
<td>185</td>
</tr>
<tr>
<td></td>
<td>Backing up and restoring company files</td>
<td>186</td>
</tr>
<tr>
<td></td>
<td>Company file security</td>
<td>189</td>
</tr>
<tr>
<td></td>
<td>Confirming activated company files</td>
<td>190</td>
</tr>
<tr>
<td></td>
<td>Managing software updates</td>
<td>191</td>
</tr>
<tr>
<td>15</td>
<td>Importing and exporting data</td>
<td>193</td>
</tr>
<tr>
<td></td>
<td>Exporting data</td>
<td>194</td>
</tr>
<tr>
<td></td>
<td>Importing data</td>
<td>195</td>
</tr>
<tr>
<td></td>
<td>Glossary</td>
<td>197</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>205</td>
</tr>
</tbody>
</table>
1 Introduction

Before you begin, take some time to explore the software and find out about the basic features of navigation and transaction entry. This chapter provides an overview of your software and describes the tools, resources and primary features of AccountRight.

Note that the term AccountRight refers to AccountRight Basics.

Learning about AccountRight

MYOB is committed to developing accounting software that is easy to use. To that end, AccountRight is accompanied by comprehensive information resources to help you learn about your software and to provide support as you set up your records and enter transactions.

Help Centre

The Help Centre is a comprehensive resource that describes all functions and features of your software. It also includes window descriptions and tips for helping solve common problems.

The Help Centre is installed when you install your software, however we recommend you use the online version of help if you are usually connected to the Internet. The online version of help is updated regularly between product releases and may contain new help topics relevant to you.

To use the online help version

1. Open your company file.
2. Go to the Setup menu and choose Preferences. The Preferences window appears.
3. Select the I Prefer to Use Help From the Internet, Rather Than My Computer option and click OK.

To display the Help Centre

- In any window, press the F1 key.
- In any window—other than command centre windows—click Help (Help) and choose Help for this Window.
- Choose Search from the Help menu.
- Go to help.myob.co.nz
**Help in AccountRight windows**

Opening the Help Centre from any window—other than command centre windows—displays descriptions or procedures relevant to that window. Click **Help (F1)** and choose **Help for this Window, Tell Me About** or **Search**.

These options are described below.

<table>
<thead>
<tr>
<th>Select...</th>
<th>If you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help for this Window</td>
<td>see a description of the window, which includes links to topics that give you tips to solving common problems and direct you to other sources of help.</td>
</tr>
<tr>
<td>Tell Me About</td>
<td>display a list of topics that tell you how to perform various tasks in the window, or other related tasks.</td>
</tr>
<tr>
<td>Search</td>
<td>search the help using keywords.</td>
</tr>
</tbody>
</table>

**Help in command centres**

The main windows in your AccountRight software are known as **command centres**. You can view help for a command centre by going to the **Help** menu and selecting **Help for this Window**.

The Help Centre displays a description of the command centre and its various functions.

For more information, see ‘Command centres’ on page 17.

**Help in fields**

You can choose to display a short description of buttons, text fields, columns and command centre items when you hover the mouse over them.

To turn field help on or off, go to the **Setup** menu and choose **Preferences**. In the **Preferences** window that appears, go to the **Windows** tab and select or deselect the **Show Field Help When Hovering Over a Field** option.

**Show Me How videos**

Show Me How videos demonstrate how to use many of the new features, and run between one and four minutes. Note that internet access is required to view videos.

**To view Show Me How videos**

1. Go to the **Help** menu and select **Learning Centre**. The Help Centre appears.
2. In the **Videos** section, click **View all videos**. A list of available videos appears in your browser.
3. Click the video you want to view.
Manuals

MYOB provides supporting documentation to help you install and use AccountRight. These documents are provided as part of the software CD you purchased, or can be downloaded from the MYOB website. Note that you need a PDF viewer to view the manuals.

Getting Started guide The Getting Started guide is provided to first-time users ofAccountRight. It contains information on how to install and register the software and how to obtain technical support. A printed version of this guide is provided with the AccountRight software CD.

Release Notes The Release Notes are provided to existing users of AccountRight software. They explain how to upgrade your software and describe new features and software changes.

User Guide The User Guide introduces the principal features, functions and capabilities of your AccountRight software. It is designed to be used as a reference for everyday transaction entry and periodic tasks, such as issuing invoices, making payments and end-of-period processing.

The user guide is provided as a PDF on the AccountRight software CD, and is also available to download from the MYOB website. Note that all of the content in the user guide is available through the Help Centre.

Where to start

When you start your AccountRight software, a welcome window appears. Depending on whether you’re new to AccountRight or if you’ve just upgraded to a new version, choose from the following options.

<table>
<thead>
<tr>
<th>Click</th>
<th>To do this...</th>
</tr>
</thead>
</table>
| Open a company file    | view a list of company files you can open. This list might include company files stored in a library on your computer, on another computer in your network or online. For more information, see ‘About libraries’, on page 16.  
|                        | **Recently opened files**  
|                        | If the welcome window displays a list of files you have recently opened, you can just click a file to open it. To remove a company file from the list, right-click it and select Remove from list.  
| Create a company file  | create a new company file for recording your business data. For detailed information about creating a new file, see Chapter 2, ‘Creating a company file,’ starting on page 25.  
|                        | upgrade a company file you created with a previous version of AccountRight. You need to upgrade a file so you can use it with a new software version.  
| Explore a sample company | Experiment with a sample company’s data and learn how to use AccountRight.  
| Restore a backup file  | Restore a previous version of your company file from a backup up version.  
| Help Centre            | Access the Help Centre and learn about this version of AccountRight.  

W H E R E T O S T A R T  

15
About libraries

A library refers to a location where your AccountRight company file is stored. When you create a file, it must be saved to one of the following library locations:

- **My library**—This library is located on your computer, in the My AccountRight Files folder. This library folder is automatically created when you install AccountRight.
  - Windows XP—C:\Documents and Settings\All Users\Shared Documents\MYOB\My AccountRight Files
  - Windows Vista or Windows 7—C:\Users\Public\Public Documents\MYOB\My AccountRight Files

For more information about libraries, see ‘Manage libraries’ on page 185.

Save your company file here if you do not want to share the file online, or save it to your computer network. Note that you can move your company file later, if you want to.

- **Network Library**—This library is located on another computer in your network, in the same folder location as above. You might choose to store your company file in a network library, so others in the network can access it. For information about accessing a network library, see ‘Manage libraries’ on page 185.

- **Online**—If you share your company file online, you will save it to an online location. For more information, see ‘Working online’, on page 53.

Experiment with sample data

Before you create a new company file, we recommend that you experiment with a sample company’s data. There is also a tutorial you can use to help you get to know the core features and functions of AccountRight.

Explore the Clearwater company file

1. Start your AccountRight software and, in the welcome window that appears, click Explore a sample company. The Open a company file window appears.

2. Open the Samples folder to view a list of sample company files for different AccountRight products.

3. Select the Clearwater company file you want to explore and click Open. The Sign-on window for the sample file appears.

4. Click OK. The command centre window appears.

A command centre window always appears when a company file is opened. Notice that the name of the sample company, Clearwater Ltd, appears in the command centre.

Now that the sample company file is open, you can browse through the software, explore the transactions that have already been entered and enter some transactions yourself.

Complete the AccountRight tutorial

A tutorial has been provided for you to learn how to set up and use AccountRight, using the Clearwater sample file. You can access the tutorial PDF through the online help.

Go to help.myob.co.nz/tutorials to download the tutorial.
Exploring AccountRight

You should become familiar with the following tools and aids:

<table>
<thead>
<tr>
<th>Tool</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command centres</td>
<td>below</td>
</tr>
<tr>
<td>Date-entry calendars</td>
<td>page 19</td>
</tr>
<tr>
<td>The business calendar</td>
<td>page 19</td>
</tr>
<tr>
<td>Calculators</td>
<td>page 20</td>
</tr>
<tr>
<td>Zoom arrows</td>
<td>page 20</td>
</tr>
<tr>
<td>Selection lists</td>
<td>page 20</td>
</tr>
<tr>
<td>Select columns</td>
<td>page 20</td>
</tr>
<tr>
<td>Mouse shortcuts</td>
<td>page 20</td>
</tr>
<tr>
<td>Shortcut keys</td>
<td>page 21</td>
</tr>
<tr>
<td>Spell-check</td>
<td>page 22</td>
</tr>
</tbody>
</table>

Command centres

There are four command centres in AccountRight Basics.
The following is an illustration of the Sales command centre.

Each command centre contains a row of icons in the top section of the window. These icons allow you to switch between command centres.
The selected icon represents the current command centre, and the flowchart displayed below the icons illustrates the major tasks associated with that command centre. (For example, when the Sales icon is selected, tasks such as Enter Sales and Print/Email Statements—typical tasks you would complete in relation to sales—appear in the command centre’s flowchart.)
There are four menus at the bottom of each command centre. The options available from these menus are described below.

<table>
<thead>
<tr>
<th>Select...</th>
<th>If you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Do List</td>
<td>record and manage tasks that need your attention, such as paying invoices to take advantage of early-payment discounts.</td>
</tr>
<tr>
<td>Find Transactions</td>
<td>find transactions relating to accounts, sales, cards and jobs.</td>
</tr>
<tr>
<td>Reports</td>
<td>view a list of the available reports.</td>
</tr>
<tr>
<td>Business Insights</td>
<td>view information you require day-to-day to run your business.</td>
</tr>
</tbody>
</table>

There are two ways to select an option:
- Click the menu name to display the window relevant to the command centre you are in.
- Click the arrow (↑) next to the menu name and select from a list of the available options for all command centres (not just the command centre you are currently in).

### Status bar menu

The status bar menu appears in the AccountRight window just above your system tray. It shows you the state of your company file and gives you options for managing the file.

For online files, the states are:
- **Online**—This status appears when you open a file that’s online. All invited users can work with it.
- **Offline (Checked Out)**—This status appears when you have checked out the online file, enabling you to work offline. Other users can’t edit the online file.

- **Offline**—This status appears when someone else has checked out the online file to work on it exclusively. You can only view the copy of the file that’s on your computer.

Click the menu arrow next to the status to perform a task related to your file (some options are only available if you are an AccountRight Live administrator).

- **Work Offline (Check Out)**—Check out a copy of the online file and lock the online file to prevent anyone entering changes while you have it checked out.
- **Undo Checkout (Discard Changes)**—Discard any changes you have made offline. Other users will be able to work online with the company file.
- **Work Online (Check In)**—Check in the file that you have worked on offline. Other users will be able to work online with the company file.
- **User Access**—Launches the User Access window, where you can add and edit company file users, or change online access to your company files.
- **Sync Company File**—Copies the online file to your computer, (first time) or updates your existing local copy with any changes made since the last synchronisation.
- **Enable/Disable Auto Sync**—When Auto Sync is on, your local copy of the online company file is updated every 20 minutes when you’re working online. Without Auto-sync, you need to manually sync your changes.
Date-entry calendars

The calendar simplifies date entry. For example, suppose you’re entering a sale and have promised the goods to the customer on the last Friday of the month. Rather than figuring out the date and entering it manually, you can display the calendar in the Promised Date field of the Sales window and click the date.

To display the calendar, click the arrow next to the date field or put the cursor in a date field and press the SPACEBAR on your keyboard. Select a date by clicking it. The selected date appears in the date field.

To close the calendar without selecting a date, press Esc.

The business calendar

You can use the business calendar to specify which days of the week your business is open, as well as holidays and important business events.

As well as being a handy reference, the business calendar affects the Contact Alert function in the To Do list. If you set a reminder to call a customer on a day that your business is indicated in the business calendar as being closed, the reminder will appear in the To Do List window on the business day before the task is due.

For example, if a reminder is scheduled for Saturday but your business is closed on Saturdays, the reminder will appear in the To Do List window on Friday.

To set up your business calendar

1. Go to the Setup menu and choose Business Calendar. The Business Calendar window appears.

2. If you want to mark a specific day as closed, click the date in the calendar.

   If your business is always open or closed on a specific day of the week, click that day in the Shortcut for setting average business week section. A message will confirm that you are changing the day’s status.

3. Add any important events that occur during the month in the Important Days section.

4. If you want to enter information for other months in the business calendar, click the arrows at the top of the calendar.

5. Click OK to close the business calendar.
Calculators

A pop-up calculator is available to simplify calculating and entering numeric data, including money amounts, item quantities and units. The calculator is available in every field where you may need to calculate an amount or total figure.

To display the calculator, click the arrow next to the numeric data field or press = (equals) or the SPACEBAR when the cursor is in a numeric data field. In the calculator, enter your calculation and then press ENTER. The result appears in the numeric data field.

Zoom arrows

Zoom arrows, displayed next to various fields, allow you to display more detailed information about a specific entry, such as a transaction or customer record.

A blue zoom arrow ( ) indicates that you can display more detailed information about a record and make changes to or delete it.

A grey zoom arrow ( ) allows you to display more detailed information, but the information cannot be changed. If you want to change the information, you can reverse the transaction and re-enter it (see ‘Reversing a transaction’ on page 119). Alternatively, you can change your security preference selection to make all transactions changeable (see ‘Set up preferences’ on page 35).

Selection lists

Search icons ( ) displayed next to various fields allow you to open selection lists containing records that you have previously entered, such as customers and shipping methods, or records provided by default.

Select columns

Select columns allow you to select items from a list. There are two select icons: the Select icon for each entry in the list and the Select/Deselect All icon located at the top of the column.

Select an item by clicking the Select icon next to it. You can select all listed items by clicking the Select/Deselect All icon, and deselect them by clicking the Select/Deselect All icon again.

Mouse shortcuts

You can right-click in a window to open a shortcut menu with options relevant to the window and to the field you are entering data in.

Mouse shortcuts are an easy way to erase a transaction, find transactions, or get help for a window.
If you are entering information in a text field, right-click options include Cut, Copy, Paste, Clear and Spelling.

Shortcut keys

You can use shortcut keys to speed up data entry. All the shortcut keys correspond to menu commands. Listed below are the shortcuts relating to the menu commands.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New (Company File)</td>
<td>CTRL+N</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>CTRL+O</td>
</tr>
<tr>
<td></td>
<td>Close Window</td>
<td>ESC</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Edit</td>
<td>Undo</td>
<td>CTRL+Z or ALT+BACKSPACE</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>CTRL+X or SHIFT+DELETE</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>CTRL+C or CTRL+INSERT</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>CTRL+V or SHIFT+INSERT</td>
</tr>
<tr>
<td></td>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
<tr>
<td></td>
<td>Select from List</td>
<td>CTRL+L</td>
</tr>
<tr>
<td></td>
<td>Recap Transaction</td>
<td>CTRL+R</td>
</tr>
<tr>
<td></td>
<td>Delete Line</td>
<td>CTRL+SHIFT+D</td>
</tr>
<tr>
<td></td>
<td>Insert Blank Line</td>
<td>CTRL+SHIFT+L</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Centres (All)</td>
<td>To Do List</td>
<td>CTRL+T</td>
</tr>
<tr>
<td>Command Centres (All)</td>
<td>Find Transactions</td>
<td>CTRL+Y</td>
</tr>
<tr>
<td>Command Centres &gt; Accounts</td>
<td>Command Centre</td>
<td>CTRL+1</td>
</tr>
<tr>
<td></td>
<td>Record Journal Entry</td>
<td>CTRL+G</td>
</tr>
<tr>
<td>Command Centres &gt; Banking</td>
<td>Bank Register</td>
<td>CTRL+K</td>
</tr>
<tr>
<td></td>
<td>Command Centre</td>
<td>CTRL+2</td>
</tr>
<tr>
<td></td>
<td>Spend Money</td>
<td>CTRL+H</td>
</tr>
<tr>
<td></td>
<td>Receive Money</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Command Centres &gt; Sales</td>
<td>Command Centre</td>
<td>CTRL+3</td>
</tr>
<tr>
<td></td>
<td>Enter Invoices</td>
<td>CTRL+J</td>
</tr>
<tr>
<td></td>
<td>Receive Payments</td>
<td>CTRL+B</td>
</tr>
<tr>
<td>Command Centres &gt; Card File</td>
<td>Command Centre</td>
<td>CTRL+8</td>
</tr>
<tr>
<td>Lists</td>
<td>Cards List</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Reports</td>
<td>Index to Reports</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>Window</td>
<td>Refresh All</td>
<td>F5</td>
</tr>
<tr>
<td>Help</td>
<td>MYOB Help</td>
<td>F1</td>
</tr>
</tbody>
</table>

We also support the following shortcut key combinations:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Close Window</td>
<td>CTRL+F4</td>
</tr>
<tr>
<td></td>
<td>Next Window</td>
<td>CTRL+F6 or CTRL+TAB</td>
</tr>
<tr>
<td></td>
<td>Cycle Task</td>
<td>ALT+TAB or ALT+ESC</td>
</tr>
</tbody>
</table>
Spell-check

When entering sale or item information, you can check your spelling in most text fields, including memos, descriptions, addresses and item names.

You can choose to set a preference to automatically check spelling or manually check spelling. To manually check spelling, click Spell.

When you check the spelling in a field, the Spelling window appears. You can also customise your spelling preferences. For example, you can change the main dictionary language and choose a preference to ignore words that include numbers.

To set spelling preferences

1. Go to the Setup menu and choose Preferences. The Preferences window appears.
2. Click the Windows tab.
3. If you want to automatically check spelling, select the Automatically Check Spelling in Text Fields Before Recording Transactions option.
4. If you want to customise your spelling preferences, click Spelling. The Spelling Options window appears.
5. Select your preferences and click OK.

For more information about the spelling feature, see the Help Centre.

About AccountRight Live

AccountRight Live is a subscription-based service that adds new capabilities to your AccountRight software.

Following are some of the benefits of subscribing to AccountRight Live. If you’re not already subscribed, visit http://myob.co.nz/arlive to learn more about these benefits and how to get on board.

Work online, or not—it’s your choice

With an AccountRight Live subscription you have the option of conveniently and securely storing your company data online.

Working online enables you to:

- **Get access anywhere:** You can have multiple users work on your accounts from multiple locations, at the same time. Your staff can enter sales out front, while you look up a client’s details, and your bookkeeper across town reconciles your bank accounts.

- **Work how you want to:** If you won’t have access to the internet for a while, you can opt to work offline with your file and synchronise your changes later. So if you’re about to get on a plane, or your internet connection isn’t behaving, you can go offline and keep working.

- **Work with others:** You control who has access to your data online and for how long. For example, you can give short-term access to your accountant. There’s no limit to the number of users you can invite to work on your file online, and you can have up to five users signed on to your company file at any time.

If you’re subscribed to AccountRight Live, and want to work online, see ‘Working online’ on page 53.
Get bank feeds and save time

If you’re using accounting software for the first time, here’s some good news—you don’t need to manually enter every payment that you make and receive. With an AccountRight Live subscription you can choose to receive information about your bank transactions (known as a bank feed) directly into your AccountRight software.

The bank feeds feature also makes it easy to reconcile the statements you receive from your bank with what’s recorded in your company file.

If you’re subscribed to AccountRight Live, and want to receive bank feeds, see ‘Set up bank feeds’ on page 49.

Support and updates, 24x7

Another benefit of subscribing to AccountRight Live, is the support you’ll receive from MYOB, including:

- **Software updates**: You’ll receive regular software updates direct to your software.
- **24x7 support** – MYOB software experts are available to answer your queries on the phone and online, 24 hours a day, 7 days a week.

For more information about AccountRight Live, visit http://myob.co.nz/arlive.
Creating a company file

Your financial data is stored in a company file. If you don’t already have a company file, you must create it before you can begin recording transactions.

Overview

When you create a company file, you record basic information about your business, such as the business name and your contact details. You must also specify the month and financial year in which you want to start recording transactions.

Depending on the features you want to use, there are some tasks that you should complete. This chapter guides you through the essential ones.

**Essential tasks**  The tasks you need to do depend on whether your accountant has created and set up a company file for you, the information you currently have and when your business started.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a company file page 26</td>
</tr>
<tr>
<td>2</td>
<td>Activate the company file page 29</td>
</tr>
<tr>
<td>3</td>
<td>Set up accounts page 30</td>
</tr>
<tr>
<td>4</td>
<td>Enter account opening balances page 33</td>
</tr>
<tr>
<td>5</td>
<td>Set up preferences page 35</td>
</tr>
<tr>
<td>6</td>
<td>Set up user access page 35</td>
</tr>
</tbody>
</table>

**Additional tasks**  Once you have completed the essential tasks, you can start recording transactions. However, before you use some features of this software, such as the sales feature, you will need to do further setup tasks. These tasks are covered in Chapter 3, ‘Setting up,’ starting on page 41.
Create a company file

You can create a company file using the New Company File Assistant. This assistant is a series of interactive windows that guide you through the process of creating a new company file.

NOTE: Do you already have a company file? If your accountant or MYOB partner has provided you with a company file, or if you want to use a file that you created with a test drive version of this software, you don’t need to create a company file. To upload your existing company file and share it online, see ‘Set up a file for online access’ on page 54

Before you start:

<table>
<thead>
<tr>
<th>You need to know...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your my.myob login details (for sharing files online)</td>
<td>If you subscribe to AccountRight Live and you are going to share this company file online, you need to have a my.MYOB login to upload the file. Your login details were set up when you subscribed.</td>
</tr>
<tr>
<td>Your current financial year</td>
<td>This is the financial year for which you want to start recording transactions in your company file. Note that a financial year is represented by the calendar year in which the financial year ends. For example, if your financial year ends in March 2013, your financial year is 2013.</td>
</tr>
<tr>
<td>The last month of your financial year</td>
<td>This is the month in which your financial year ends. For most businesses the last month is March.</td>
</tr>
<tr>
<td>Your conversion month</td>
<td>This is the earliest month for which you want to record transactions. For example, if you want to enter transactions dated 1 September or later, your conversion month is September. You cannot enter transactions dated before the conversion month.</td>
</tr>
</tbody>
</table>

You need to know...

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts are the categories that you will allocate each of your transactions to. When you create a company file, you need to select a default list of accounts. You can:</td>
</tr>
<tr>
<td>- start with an accounts list provided by MYOB. You can select a predefined accounts list suitable for your business.</td>
</tr>
<tr>
<td>- import a list of accounts. You can import an accounts list from another company file or from one that has been provided by your accountant or MYOB Certified Consultant.</td>
</tr>
<tr>
<td>- build your own list. You can start with an accounts list that has the minimum accounts required by your AccountRight software and then add to it. Note that you can modify your accounts list after creating your company file.</td>
</tr>
</tbody>
</table>

To create a company file

1. Start your AccountRight software. A welcome window appears.
2. Click Create a company file. The New Company File Assistant appears.
3 Select the AccountRight product you want to create a company file for. This should be the product you are licensed to use, unless you want to evaluate another AccountRight product.

If you are not licensed to use the selected product, the company file can only be edited for 30 days, after which it will become a read-only file.

4 Click **Next**. The **Company Information** window appears.

5 Enter your business contact and registration details. If available, also enter your AccountRight serial number.

6 Click **Next**. The **Financial Year** window appears.

7 Enter your financial year details and conversion month.

   **NOTE:** Set your financial year. Remember that this is the financial year for which you want to start recording transactions in your company file. It does not need to be the financial year that your business is currently operating in.

8 Click **Next**. The **Accounts List Options** window appears.

9 Select the default accounts list you want to start with.

10 Click **Next**. The **Accounts List Selection** window appears.

11 Select the industry that best matches your own business.

A suitable accounts list for the industry you selected appears. If you want to print the list, click **Print**. Later you can tailor the list to meet the needs of your business.
12 Click Next. The Create Company File window appears.

13 If you want to change your company file name, you can edit it in the Company File Name field.

14 Select where you want to store your company file. Note that it must be stored in an AccountRight library, unless you are sharing it online.

NOTE: AccountRight libraries An AccountRight library is a folder on your computer, or a network computer, where company files may be saved. Only files saved in an AccountRight library can be opened.

The company file gets created and the Conclusion window appears.

15 If the file is online, and you want your accountant or bookkeeper to finish setting up your company file, invite them as a company file user and give them online access. For more information, see ‘Add new company file users’, on page 36

16 Click Command Centre to display the Command Centre window.

If you want to...  Then...

Save the company file on your computer

1 Select the Locally option and click Create Company File.

Save the company file on another computer in the network (Note that the network computer must have an AccountRight library already set up on it.)

1 Select the Locally option and then click Change Location. The Library Browser window appears.
2 Select the network location you want to save the file in.
3 If the library location does not appear in the list, click Add a network library.

Need help with this task? Click the help icon for more information and help.
4 Click OK.
5 Click Create Company File.

Share the company file online (Note that your software must be registered, and you need to have an active AccountRight Live subscription to save a file online)

1 Select the Online option.
2 If you are an accountant or bookkeeper and you create files for a number of clients, you may not want to keep a copy of this file on your computer.
Deselect the Synchronise my online file with this computer option.
3 Click Create Company File.
If you are not logged in to AccountRight Live, a message appears prompting you to log in.
4 Click Log in and log in using your my.MYOB credentials.
5 Click OK.
Activate the company file

Before you begin

Before you can activate a company file, you need to:

- **Know your product serial number.** If you didn’t enter your serial number when creating the company file, you will need to enter it during the activation process. You can find your serial number on the software CD sleeve.
- **Register your software.** Registration enables MYOB to contact you should there be any issues with your software. See the Getting Started guide for information on how to register your software.

To activate a company file

1. Open the company file to be activated and sign on.

   The Activation Assistant appears.

**Before you begin**

Before you can activate a company file, you need to:

- **Know your product serial number.** If you didn’t enter your serial number when creating the company file, you will need to enter it during the activation process. You can find your serial number on the software CD sleeve.
- **Register your software.** Registration enables MYOB to contact you should there be any issues with your software. See the Getting Started guide for information on how to register your software.

**To activate a company file**

1. Open the company file to be activated and sign on.

   The Activation Assistant appears.

**Activation limits**

The number of company files you can activate depends on your software licence. If you need to activate more company files than your licence permits (for example, yours is a bookkeeping business looking after many clients), you’ll need to obtain licence extensions to activate additional company files. Contact MYOB Customer Service about obtaining licence extensions.
Click I use this company file to record or edit my business transactions, then choose an activation option:

<table>
<thead>
<tr>
<th>Method</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Online</td>
<td>1 Ensure you are connected to the Internet.</td>
</tr>
<tr>
<td>(Recommended)</td>
<td>2 Choose Activate Online and then click Next. The Details window appears.</td>
</tr>
<tr>
<td></td>
<td>3 If you have not previously entered your serial number, type it in the Serial Number field.</td>
</tr>
<tr>
<td></td>
<td>4 Click Activate to activate the file.</td>
</tr>
<tr>
<td>Activate by Phone</td>
<td>1 Choose Activate by Phone and then click Next. The Details window appears.</td>
</tr>
<tr>
<td></td>
<td>2 If you have not previously entered your serial number, type it in the Serial Number field.</td>
</tr>
<tr>
<td></td>
<td>3 Call MYOB on the phone number displayed above the Serial Number field and request a licence file to be emailed to you.</td>
</tr>
<tr>
<td></td>
<td>4 Once you have received the email, detach your licence file.</td>
</tr>
<tr>
<td></td>
<td>5 Click Browse next to the Select the licence file to load field to locate the licence file.</td>
</tr>
<tr>
<td></td>
<td>6 Click Activate to activate the file.</td>
</tr>
</tbody>
</table>

Set up accounts

Accounts provide a means for grouping similar transactions. For example, if your business pays rent for the use of its premises, you would create a rent account and then allocate all rent payments to that account.

The accounts you use for your business are grouped in an accounts list.

**NOTE:** Do you need to complete this task? If your accountant or MYOB Approved Partner has provided you with a company file, this task may have been completed for you. In this case, go to ‘Enter account opening balances’, on page 33.

When you created your company file, you selected a default accounts list to start with. This list may already have the accounts you need. If not, you can change the list to suit your needs. If you are unsure, ask your accountant which accounts you should create, edit or delete.
If you chose to import a list of accounts, you should import this list now. See ‘Importing data’ on page 195.

NOTE: Invite your accountant or bookkeeper to help you If your company file is shared online with AccountRight Live and you want your accountant or bookkeeper to help you with this task, invite them to work online. See ‘Set up user access’ on page 35.

Account numbers Each account is identified by a unique five-digit number. The first digit indicates the account’s classification (for example, accounts starting with 1 are asset accounts). The remaining four digits determine its location within the classification. The lower the number, the higher up in the list it appears. For example, account 1-1100 appears above 1-1200.

Account classifications and types The accounts list groups accounts into eight classifications—Asset, Liability, Equity, Income, Cost of Sales, Expense, Other Income and Other Expense. Within each account classification there is at least one account type.

Account classifications and types are described in the following table.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset (1-xxxx)</td>
<td>Bank</td>
<td>Money in the bank, for example, in a cheque or savings account.</td>
</tr>
<tr>
<td></td>
<td>Accounts Receivable</td>
<td>Money owed to you by your customers.</td>
</tr>
<tr>
<td></td>
<td>Other Current Asset</td>
<td>Assets that, if required, can be turned into cash within a year. These may include your term deposits.</td>
</tr>
<tr>
<td></td>
<td>Fixed Asset</td>
<td>Assets which have a long life, for example, buildings, cars and computers. Fixed assets are usually depreciated.</td>
</tr>
<tr>
<td></td>
<td>Other Asset</td>
<td>Other assets you own such as loans made to others and goodwill.</td>
</tr>
<tr>
<td>Liability (2-xxxx)</td>
<td>Credit Card</td>
<td>Repayments required to service credit card debt.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Classification</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equity (3-xxxx)</td>
<td>Equity</td>
<td>The business’s net worth, that is, its assets minus its liabilities. Common equity accounts are current year earnings, retained earnings and shareholders’ equity.</td>
</tr>
<tr>
<td>Income (4-xxxx)</td>
<td>Income</td>
<td>Revenue from the sale of goods and services.</td>
</tr>
<tr>
<td>Cost of Sales (5-xxxx)</td>
<td>Cost of Sales</td>
<td>The direct cost of selling your goods and providing services, for example, purchase costs and freight charges.</td>
</tr>
<tr>
<td>Expense (6-xxxx)</td>
<td>Expense</td>
<td>The day-to-day expenses of running your business, for example, utility bills, employee wages and cleaning.</td>
</tr>
<tr>
<td>Other Income (8-xxxx)</td>
<td>Other Income</td>
<td>Other revenues, for example, interest earned on savings and dividends paid from shares.</td>
</tr>
<tr>
<td>Other Expense (9-xxxx)</td>
<td>Other Expense</td>
<td>Other expenses, for example, interest charged.</td>
</tr>
</tbody>
</table>

Header and detail accounts Your accounts list consists of detail accounts (the accounts to which you allocate transactions) and header accounts. Header accounts group related detail accounts to help you organise your accounts list.

For example, you could group your telephone, electricity and gas expense accounts using a Utilities header account. This makes it easier for you to locate the utility expense accounts in the accounts list and to see your combined utility expenses.
You group accounts by indenting the detail accounts located directly below a header account. For more information, see ‘To group detail accounts with a header account’ on page 33.

Note that:
- You cannot allocate transactions to a header account.
- The balance of a header account is the sum of the detail accounts indented directly below it.
- You can have up to three header account levels as shown in the example above.
- How you group your accounts can affect how totals and subtotals are calculated on reports.

Setting up accounts

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an account</td>
<td>below</td>
</tr>
<tr>
<td>Delete an account</td>
<td>page 110</td>
</tr>
<tr>
<td>Change the details of an account</td>
<td>page 109</td>
</tr>
<tr>
<td>Group detail accounts with a header account</td>
<td>page 33</td>
</tr>
<tr>
<td>Import an accounts list</td>
<td>page 195</td>
</tr>
</tbody>
</table>

To create an account

1. Go to the Accounts command centre and click Accounts List. The Accounts List window appears.
2. Click New. The Account Information window appears.
3. If you want to create a header account, select the Header Account option or if you want to create a detail account, select Detail.
4. Select the account type from the Account Type list. The Account Classification field changes according to the selection you make. For more information on account classifications, see ‘Account classifications and types’ on page 31.
5. Enter a four-digit number for the account in the Account Number field. The number must be unique within each account classification.
6. Press Tab and type a name for the account.
7 Click the Details tab.

![Image of Details tab]

8 If you want, type a brief description of the account in the Description field.

9 In the GST Code field, enter the GST code that you use most often with transactions that will be posted to this account.

10 If you are creating an asset, liability or equity account (other than an asset with the account type of Bank), select an option from the Classification for Statement of Cash Flows list.

11 If you are creating a bank or credit card account, and you want to keep a record of your bank account details, or make electronic payments, click the Banking tab and enter your account details.

12 [Detail accounts only] If you want to enter historical balances for the last financial year, click the History tab and complete the Last FY column. That way you can compare the monthly account balances for this year and last year.

13 Click OK when you have finished. The account now appears in your accounts list.

To group detail accounts with a header account

You group accounts by indenting the accounts located below a header account.

1 Go to the Accounts command centre and click Accounts List. The Accounts List window appears.

2 Select the detail account you want to group.

3 Click the Down button at the bottom of the window to group the account with the header located above it.

---

**Enter account opening balances**

Account opening balances are the balances of your accounts as at the first day of your conversion month.

**NOTE:** Do you need to complete this task? If you were in business prior to your conversion month, most of your accounts probably already have balances. If you want to produce financial reports that include these balances (such as a balance sheet), or you want to track the balance of accounts with a cumulative balance (such as your bank account), you need to enter these balances.

You can find your account opening balances on a trial balance report, a balance sheet or a profit & loss report prepared for the period immediately prior to your conversion date. You can ask your accountant to prepare these reports.

**NOTE:** Invite your accountant or bookkeeper to help you If your company file is shared online with AccountRight Live and you want your accountant or bookkeeper to help you with this task, invite them to work online. See ‘Set up user access’ on page 35.
You may also be able to find your account opening balances using your previous accounting software or paper-based records.

The balances you enter depend on whether your conversion month is also the first month of your financial year. If your conversion month:

- **is the first month of your financial year**, you enter the opening balances of your asset, liability and equity accounts only.
- **is not the first month of your financial year** (for example, if your financial year starts in April but your conversion month is August), you can enter the opening balances of all your accounts.

**Opening bank account balances**  You can enter the following amounts as the opening balance of a bank account:

- the bank account balance that appears on your balance sheet or trial balance reports as at the day prior to your conversion date. For example, if your conversion date is 1 April 2013, this is the bank account balance as at 31 March 2013.
  - These reports can be provided by your accountant, or, if you were previously using other accounting software, printed using that software.
- the cashbook balance of the account as at the end of the day prior to your conversion date. You can calculate your cashbook balance by taking into account the transactions not yet cleared by your bank as at the conversion date and the balance that appears on your bank statement at that date.
  - For example, assume that $500 worth of deposits and $1000 worth of payments were uncleared as at your conversion date (that is, they had not appeared on a bank statement). The cashbook balance would be calculated as shown below:

| Bank statement balance as at the conversion date | $21,000.00 |
| ADD uncleared deposits | + $500.00 |
| SUBTRACT uncleared payments | – $1,000.00 |
| **Cashbook balance as at the conversion date** | **$20,500.00** |

**To enter opening balances**

1. Go to the **Setup** menu, choose **Balances** and then **Account Opening Balances**. The **Account Opening Balances** window appears.

2. Enter the balances in the **Opening Balance** column.

   **NOTE:** Enter opening balances as positive numbers. Don’t, for example, enter your liability account balances as negative numbers. Enter negative amounts only if accounts truly have negative balances. As a rule, these will be asset accounts that record accumulated depreciation.

3. Check that the amount in the **Amount left to be allocated** field at the bottom of the window shows $0.00.

   If this field displays an amount other than $0.00, check your opening balances again because they are either incomplete or incorrect. However, you can continue the setup process if there is an amount in the **Amount left to be allocated** field. The amount will be assigned to a special equity account called Historical Balancing.

4. Click **OK**.
Set up preferences

Preferences are settings that enable you to tailor AccountRight to your business requirements and processes. For example, you can choose to automatically print invoices after recording them, or prevent users from editing transactions.

**NOTE:** Do you need to complete this task? While you can complete this step later, you should review the default preferences that have been set before you start entering transactions.

Before setting preferences, close any open windows (apart from the Command Centre). You will not be able to change preferences if you have other windows open.

You can set up your preferences using the:

- **Customise Easy Setup Assistant.** This assistant guides you through setting up some key preferences. To access the assistant, go to the Setup menu, choose Easy Setup Assistant and then click **Customise**.
- **Preferences** window. This window lists all of the preferences. To view this window, go to the Setup menu and choose **Preferences**.

Some preferences you should consider choosing include:

- **Transactions CAN’T be Changed; They Must be Reversed** If you don’t want to allow users to edit or delete transactions, select this option. If they want to change or delete a transaction, they will need to do so by recording a reversal transaction. For more information, see ‘Reversing a transaction’ on page 119.
- **Select and Display Account Name, Not Account Number** If you want to search for accounts by their names rather than by their numbers, select this option. This allows you to enter accounts and sort your account search lists alphabetically using the name of the accounts rather than the numbers.
- **Warn if Customer has an Outstanding Credit Before Applying a Payment** If you want to be notified whether a customer has any outstanding credits before you apply their payment to a sale, select this option.
- **Apply Customer Payments Automatically to Oldest Invoice First** If you’d like payments from customers to be applied to the oldest outstanding sales first, set this preference in the **Sales** view of the **Preferences** window.

Set up user access

You need to set up company file access for the people you want to work with your data. To do this, you first set them up with a user ID and password, and then assign them a **role**, which determines what areas of the company file they can work with.

Setting up file users enables you to:

- control who accesses to the company file
- track transaction record history
- set up online access for users (AccountRight Live subscribers).

Before you create users in a new company file, you should set a password for the Administrator account.
Set a password for the Administrator

When you created your company file, a user called Administrator was automatically created.

By default, the Administrator user does not have a password assigned. Anyone who signs on with the Administrator user ID will have access to all command centres, functions and windows and will be able to create, edit and delete other user accounts.

To set a password for the Administrator user ID

1. Start AccountRight and open your company file to the Sign-on window.
2. Type Administrator in the User ID field and then click Change Password. The Change Password window appears.
3. Leave the Existing Password field blank, type the password in both the Password and Confirm Password fields.
4. Click Record.
5. If more than one person will be accessing your company file, you need to set them up as a user and specify their access restrictions for the file. For more information, see ‘Add new company file users’ below.

Add new company file users

You need to set up each person who will work with your company file, as a company file user. This means giving them a User ID and password, which they will use to sign on to the company file each time they open it. Only a valid user can sign on to your company file, and depending on the user role you assign, they can only access the areas of your file (command centres and windows) that you give them access to.

User roles A role is a predefined profile that determines what windows a user can access and what tasks they can perform in a company file. For example, a user assigned the ‘sales’ role can access features in the Sales and Card File command centres, and other sales related areas, such as lists. A user can be assigned more than one role. For a more detailed explanation of roles, click the help link in the User Access window.

Who can create and manage users? Only users assigned the ‘Administrator’ role are able to set up other users in this company file. Users assigned this role also need to have online administrator access to be able to invite users to work online. For more information, see ‘Inviting a user to work online’, on page 38.

Tracking changes by User ID Whenever a user enters a transaction, it is labelled with their User ID. You can view a report to see what transactions users have entered. For more information, see ‘Checking for unauthorised transactions’ on page 189.

To add a new user

1. Open the company file.
Go to the Setup menu and choose Users. The User Access window appears.

**NOTE:** This window will look different if you don’t store your file online. If your company file is not stored online, the online section of the window will not appear.

3. Click New.

Set up company file sign-on details

4. Type the user’s name in the User ID field, then type the password in the Password and Confirm Password fields.

**NOTE:** Company file sign-on details You will need to advise the user of these sign-on details before they can access the file. They will have the option to change their password the first time they sign on.

Select user roles

5. In the Roles list, select the roles you want to assign to this user account.

For example, if you want to give the user access to all banking features, select the Banking role.

6. Click Save.

- If this company file is an online company file, continue with step 7 below.
- If you do not share your company file online, the record is saved and the user setup is complete.

Invite the user to work online (optional)

7. If a message appears asking if you want to invite this user now, click Log in. Your internet browser opens and you are prompted to log in to my.MYOB to continue.

8. Enter your my.MYOB login details. An invitation screen appears.

9. Enter the user’s email address, first name and last name in the fields provided.

10. Select the type of online access you want them to have. For more information about online access types, see ‘Inviting a user to work online’ on page 38.

11. Click Invite. The Manage online access screen appears and an invitation email is sent to the user.
Inviting a user to work online

With AccountRight Live, you can give others access to your company files online. You do this by inviting them. Note that online access is different to company file access.

Types of online access

Depending on who you are giving access to, you can set up two types of online access:

- **Online file user**—A file user can access any of the online company files they have accepted an invitation to use. This is the level of access you would grant most of your users, who you just need to work with the file.

- **Online administrator**—an online administrator can work with any company file that is listed under the owner’s software serial number. In addition to this, an online administrator can:
  - purchase additional online files
  - invite file users to use a company file online
  - manage your AccountRight Live subscription
  - get bank feeds.

You might enable administrator access to a person you need to perform these additional functions for you. For example, your office manager or your bookkeeper.

**Who can you invite?** You can invite anyone to have online access to your file. But they also need to be a company file user, to open the file online. You can invite your bookkeeper or accountant to help you set up your file online or manage users for you.

To invite a user to work online

- Refer to the table below:

<table>
<thead>
<tr>
<th>If you...</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>already have a company file online</td>
<td>1 Open the company file.</td>
</tr>
<tr>
<td></td>
<td>2 Go to the Setup menu and choose User Access. The User Access window appears.</td>
</tr>
<tr>
<td></td>
<td>3 Click Online Access in the right panel. Your internet browser opens and you are prompted to log in to AccountRight Live.</td>
</tr>
<tr>
<td></td>
<td>4 Enter your my.MYOB login details. An invitation screen appears.</td>
</tr>
<tr>
<td></td>
<td>5 Enter the user’s email address, first name and last name in the fields provided.</td>
</tr>
<tr>
<td></td>
<td>6 Select the type of online access you want them to have. See ‘Types of online access’ above.</td>
</tr>
<tr>
<td></td>
<td>7 Click Invite. The Manage online access page appears with a confirmation showing at the top, and the user appears as ‘Invited’ in the relevant list.</td>
</tr>
</tbody>
</table>

| want to invite someone to create an online file for you | 1 Go to my.myob.com.au and log in. |
|  | 2 In the My Products menu, choose Manage AccountRight Live. |
|  | 3 Click Invite new online administrator. An invitation page opens. |
|  | 4 Enter the user’s email address, first name and last name in the fields provided. |
|  | 5 Click Invite. The Manage online access page appears with a confirmation showing at the top, and the user appears as ‘Invited’ in the list of administrators. |
What happens now?

This person will be sent an invitation via email. When they accept the invitation, they will be set up with my.MYOB login details, which will enable them to access the online company file.

They will not be able to sign on to the company file unless they have company file access as well. If you have not already set them up in the company file as a user, see ‘Add new company file users’ on page 36. If you have already set them up, remember to send them their company file sign-on details.
Setting up

When you have created a company file and completed the company file setup tasks (see Chapter 2, Creating a company file, on page 25), you can start recording transactions in your company file. However, if you want to use other features of your software (such as tracking amounts you owe or the quantity of items sold), you need to complete additional setup tasks. This chapter details the additional tasks.

Overview

The setup tasks you need to complete depend on the features you want to use and whether your business was operating prior to your conversion month.

NOTE: Invite your accountant or bookkeeper to help set up your company file. If you want your accountant or bookkeeper to finish setting up your company file, invite them as a company file user and give them online access. For more information, see ‘Set up user access’, on page 35.

What features do you want to use?

The following table provides some examples of different setup requirements.

<table>
<thead>
<tr>
<th>Your needs</th>
<th>Setup required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banking</td>
<td>If you only want to use your software to fulfil basic accounting requirements (such as reporting GST payable or producing a year-end balance sheet), you may only need to do an initial bank reconciliation for each of your bank accounts. Reconciling accounts helps ensure the integrity of the information you record in your company file (see ‘Do an initial bank reconciliation’ on page 46).</td>
</tr>
<tr>
<td>Sales</td>
<td>If you want to track the money that you are owed by customers, you will need to use the Sales command centre. Before you can use this command centre you need to complete the sales setup tasks in this chapter.</td>
</tr>
</tbody>
</table>
When did your business start operating?

The setup tasks you need to complete will also depend on whether your business was operating prior to your conversion month.

The following table describes the setup required for new and existing businesses.

<table>
<thead>
<tr>
<th>Business status</th>
<th>Setup required</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>If you have just started your business, you may have very little information about your future customers, suppliers, employees and items that you sell. You can add these details later when you have more information. However, you should read through the setup tasks to see which features you might use and the tasks you need to complete to start using them.</td>
</tr>
<tr>
<td>Existing</td>
<td>If your business was operating prior to your conversion month, it is likely that transactions that occurred prior to your conversion month still affect your business. For example, a customer may owe you money for sales you made prior to your conversion month. You will need to enter these historical details in your company file.</td>
</tr>
</tbody>
</table>

Setup tasks

You may not need to do every task. An introduction to each task helps you determine whether you need to do the task and, if so, the information you need.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Set up sales</td>
<td>below</td>
</tr>
<tr>
<td>2 Set up electronic payments</td>
<td>page 44</td>
</tr>
<tr>
<td>3 Do an initial bank reconciliation</td>
<td>page 46</td>
</tr>
<tr>
<td>4 Create item records</td>
<td>page 51</td>
</tr>
</tbody>
</table>

Set up sales

You can use the sales features to:

- prepare sales quotes and invoices
- generate statements
- view customer sales history
- see how much your customers owe you.

**NOTE: Do you need to do this task?** If you want to record sales and print invoices or statements, you need to set up the sales features.

Before you start using the sales features, you should use the Sales Easy Setup Assistant to enter the following information:

- **Credit terms and credit limits** Enter the credit terms and credit limits you generally extend to your customers.
- **Customer details** Create a record for each of your customers and enter details such as their addresses and phone numbers.
- **Pre-conversion sales** [Existing businesses only] If customers owed you money on the first day of your conversion month, you will need to record some details about the corresponding sales, such as the invoice date and the amount that is outstanding.
To access the assistant, go to the Setup menu, choose Easy Setup Assistant, and then click Sales.

You can also use the Sales Easy Setup Assistant to specify your preferred invoice layout, the income account you will allocate most of your sales to, and several other settings. These settings will automatically be selected for new customer records you create; however, you can change them as required.

Optional sales setup tasks

In addition to the Sales Easy Setup Assistant tasks, you may also want to do the following tasks if they are relevant to your business.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customise forms</td>
<td>Change the appearance of the default invoice and statement forms.</td>
</tr>
<tr>
<td>Import cards</td>
<td>Import customer information from:</td>
</tr>
<tr>
<td></td>
<td>• another company file</td>
</tr>
<tr>
<td></td>
<td>• another accounting system</td>
</tr>
<tr>
<td></td>
<td>• a spreadsheet</td>
</tr>
<tr>
<td></td>
<td>• a text file</td>
</tr>
<tr>
<td>Synchronise customer records with Outlook</td>
<td>Synchronise your customer records with your contact records in Microsoft Outlook.</td>
</tr>
<tr>
<td>Create job records</td>
<td>Create job records to track the progress and profitability of the work you do for your clients.</td>
</tr>
<tr>
<td>Group cards</td>
<td>Use identifiers and custom lists to group the cards of customers who have similar attributes.</td>
</tr>
</tbody>
</table>
Set up electronic payments

If you want, you can use your AccountRight software to pay your suppliers and employees electronically.

**NOTE:** Do you need to complete this task? If you want to pay your suppliers and employees electronically using AccountRight, you need to set up this feature.

Before you can create an electronic payment file, you need to complete the following steps:

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record your bank account details below</td>
</tr>
<tr>
<td>2</td>
<td>Set up a clearing account page 45</td>
</tr>
<tr>
<td>3</td>
<td>Record the bank details of suppliers page 45</td>
</tr>
<tr>
<td>4</td>
<td>Record the bank details of employees page 46</td>
</tr>
</tbody>
</table>

**Task 1: Record your bank account details**

To record your bank account details:

1. Go to the Accounts command centre and click Accounts List. The Accounts List window appears.
2. Select a bank account (that is, an account with a Bank or Credit Card account type) that you want use for electronic payments.

3. Click **Edit**. The **Account Information** window appears.
4. Click the **Banking** tab.
5 Enter your bank account details in the fields. Copy this information exactly as it appears on your bank statement or chequebook.

NOTE: HSBC and Citibank account number formats If you are setting up an HSBC bank account for electronic payments, you need to enter your 12-digit internal account number in the Particulars field to allow your bank to process direct credit files. If you are setting up a Citibank bank account for electronic payments, you need to enter your internal account number in the Reference field to allow your bank to process direct credit files.

6 Click OK to return to the Accounts List window.
7 Repeat from step 2 for each bank account you want to make electronic payments from.

Task 2: Set up a clearing account

When you record a transaction you want to pay electronically, the transaction is posted to a temporary holding account until you create the electronic payment file. This holding account is called a clearing account.

Check your accounts list for an account named ‘Electronic Clearing Account’. If it doesn’t exist, you need to create it (see ‘Setting up accounts’ on page 32) and then make this account the linked (default) account for electronic payments.

To link the clearing account

1 Go to the Setup menu, choose Linked Accounts and then Accounts & Banking Accounts. The Accounts & Banking Linked Accounts window appears.
2 In the Bank Account for Electronic Payments field, type or select the Electronic Clearing Account.
3 Click OK.

Task 3: Record the bank details of suppliers

To record the bank details of a supplier

1 Go to the Card File command centre and click Cards List. The Cards List window appears.
2 Locate a supplier you pay electronically and click Edit. The Card Information window appears.
3 Click the Payment Details tab.

4 Enter the supplier’s bank account details.
5 In the Particulars, Code and Reference fields, enter the default details that will help the supplier identify your payments on their bank statements. If required, you can change these details when entering a payment.
6 Click OK to return to the Cards List window.
7 Repeat from step 2 for each supplier you pay electronically.
Task 4: Record the bank details of employees

To record the bank details of an employee

1. Go to the Card File command centre and click Cards List. The Cards List window appears.
2. Locate the employee you pay electronically and click Edit. The Card Information window appears.

   **NOTE:** If you haven’t created a card for the employee... You can create an employee card now by clicking New in the Cards List window and entering the employee’s details.

3. Click the Payment Details tab.
4. Enter the employee’s bank account details.
5. In the Particulars, Code and Reference fields, enter the default details that will help the employee identify your payments on their bank statements. If required, you can change these details when entering a payment.
6. Click OK to return to the Cards List window.
7. Repeat from step 2 above for each employee you pay electronically.

---

Do an initial bank reconciliation

To ensure the accuracy of your business records, you should ensure that the record of your bank account balances matches the amounts on your bank statements. This task is called *reconciling accounts*.

If your business traded prior to your conversion month and you have uncleared banking transactions as at the first day of your conversion month, you need to do an initial bank reconciliation.

Uncleared banking transactions are withdrawals and deposits that have not been cleared by your bank as at the start of your conversion month.

**NOTE:** Do you need to complete this task? The initial bank reconciliation needs to be done for each bank account that had uncleared transactions as at the first day of your conversion month.

---

To do an initial bank reconciliation:

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Identify uncleared withdrawals and deposits</td>
</tr>
<tr>
<td>2</td>
<td>Record uncleared withdrawals and deposits</td>
</tr>
<tr>
<td>3</td>
<td>Reconcile</td>
</tr>
</tbody>
</table>
Task 1: Identify uncleared withdrawals and deposits

Compare your banking source information (such as your chequebook and deposit book) with your bank statements for the period that includes your conversion date. If you find transactions that have not been cleared by your bank as at this date, you will need to record the details of these transactions in your company file.

For example, in March, the month prior to your conversion month, you wrote a cheque for $1,000 and deposited $500 you received from a customer. If these transactions had not appeared on a bank statement by 31 March, you need to record both transactions in your company file.

To enter uncleared withdrawals
1. Go to the Banking command centre and click Spend Money. The Spend Money window appears.
2. In the Pay from Account field, type or select the bank account you want to reconcile.
3. In the Cheque No. field, enter a reference number for the withdrawal.
4. In the Date field, type the first day of your conversion month. For example, if your conversion month is April 2013, enter 01/04/13.
5. In the Amount field, type the amount of the withdrawal.
6. In the Acct No. field, type or select the bank account you want to reconcile. This must be the account entered in step 2 above.
7. In the GST field, select the N-T GST code.
8. Enter details of the withdrawal in the Memo field.

To enter uncleared deposits
1. Go to the Banking command centre and click Receive Money. The Receive Money window appears.
2. In the Deposit to Account field, type or select the bank account you want to reconcile.
3. In the Date field, type the first day of your conversion month. For example, if your conversion month is April 2013, enter 01/04/13.
4. In the Amount Received field, type the amount of the deposit.
5. In the Acct No. field, type or select the bank account you want to reconcile. This must be the account entered in step 2 above.
6. In the GST field, select the N-T GST code.
7. Click Record.
8. Repeat from step 3 above for each uncleared withdrawal.
9. Repeat from step 5 above for each uncleared deposit.
7 Enter details of the deposit in the Memo field.

4 In the Bank Statement Date field, enter the first date of your conversion month. (For example, if your conversion month is April 2013, enter 01/04/13.) Your uncleared transactions appear.

When you recorded uncleared transactions, the same account was debited and credited. Therefore, an uncleared transaction appears as both a deposit and a withdrawal.

5 For each uncleared withdrawal, click the select column next to the deposit.

6 For each uncleared deposit, click the select column next to the withdrawal. When each uncleared transaction is selected, $0.00 appears in the Out of Balance field.

8 Click Record.

9 Repeat from step 3 for each uncleared deposit.

Task 3: Reconcile

To reconcile the account

1 Go to the Banking command centre and click Reconcile Accounts. The Reconcile Accounts window appears.

2 In the Account field, select the bank account you want to reconcile.

3 In the Closing Statement Balance field, enter the closing bank balance as at the day prior to your conversion month (for example, the closing balance as at 31/03/2013).

7 Click Reconcile. A confirmation window appears. If you want, do one of the following:

- To print a report, click Print Report. When the report is printed, click Reconcile.

- To reconcile without printing a report, click Reconcile.

- To change any details you entered in the Reconcile Accounts window, click Cancel and make the required changes.
Set up bank feeds

You can use the bank feeds feature to:

- easily compare your bank account and credit card transactions with those recorded in AccountRight
- automatically check for and match transactions that correlate with the bank feed information
- pre-clear matched transactions to speed up your bank reconciliation.

To set up a bank feed, you first need to specify your account details, and then authorise BankLink (who manage bank feeds) to set up a connection to your bank.

You'll need to have:

- internet access
- your bank account or credit card details, exactly as they appear on your statement information.

To set up a bank feed

1. Start AccountRight.
2. Go to the Banking command centre and click Bank Feeds. If:
   - you are already working with bank feeds, the Bank Feeds window appears. Click Add or remove a bank account.
   - this is your first bank feed, the Manage Bank Accounts window appears. Click Get Started with Bank Feeds.
3. An internet browser window opens and the my.MYOB Log In page appears.
4. Log in with your my.MYOB login details.
5. Follow the onscreen instructions.
6. On the Print the BankLink authority form page:
   a. Click Print Form. The BankLink authority form and cover sheet appear. A copy of the authority form is also sent to you by email.
   b. Print the form.
   c. Read the cover sheet and check your account details.
   d. Sign the form and mail it to BankLink. You need to do this because BankLink require an original signature to be authorised to set up bank feeds.
6 Click Done. The My Products page appears. This shows details about your AccountRight Live subscription and Live Services. The Bank Feeds section is updated with the details of the bank feed you have just applied for.

7 If you want to:
   - apply for another bank feed, click Add more bank accounts or Add more credit cards and continue from step 4 above.
   - return to AccountRight, close the internet browser.

What happens next?  When your bank feed is ready, we will notify you by email. This may take a couple of weeks. To complete your bank feed setup, associate an account from the Accounts List.

To associate an account for a bank feed
To complete setting up a bank feed, you need to associate an account from the Accounts List to it. This is the account that the bank feed will be compared to.

1 Open AccountRight and go to the Banking command centre.
2 Click Bank Feeds. The Bank Feeds window appears.
3 Click Manage Bank Accounts. The Manage Bank Accounts window appears. This window shows the status of your bank feeds applications so you can follow their progress.
Create item records

You can use item records to store information about a product and to track the quantities you sell. You can also create records for each type of service you provide.

**NOTE:** Do you need to complete this task? If you sell items, such as finished goods, components used in production and raw materials, you need to create records for them.

Item records enable you to view the sales history of the products you sell or use in production. You can determine which items are your best sellers. This can help you identify sales trends.

You can also create item records for the services you provide. This enables you to list the items and services you sell on the same invoice. For example, if you are a plumber, you could set up items for the materials you use in order to carry out your work. You could also set up item records for the services you provide, such as installation and repairs. You can then record the labour and material charges on the same invoice.

For more information about creating item records, see ‘Creating items’ below.

What happens next? When your bank feed is ready, you can start working with bank feeds, see ‘Approving a bank feed’ on page 68.

Optional item setup tasks

You may want to do the following tasks if they are relevant to your business.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import items</td>
<td>Import item information from:</td>
</tr>
<tr>
<td></td>
<td>- another company file</td>
</tr>
<tr>
<td></td>
<td>- another accounting system</td>
</tr>
<tr>
<td></td>
<td>- a spreadsheet</td>
</tr>
<tr>
<td></td>
<td>- a text file.</td>
</tr>
<tr>
<td>Group items using custom lists</td>
<td>Group and sort items by assigning attributes to your items from custom lists you define.</td>
</tr>
<tr>
<td>Create custom fields</td>
<td>Set up fields to record additional information about your.</td>
</tr>
</tbody>
</table>

Creating items

Before you can use items in your sales transactions, you need to create a record for each item you plan to sell. An item can be:

- a physical unit that your company sells
- a service that your company wants to include on item invoices, for example, ‘Shipping’ or ‘Handling’.

When you create an item record, you need to select the default income account that will be used to track sales of this item, the price of the item and the GST code to be used when you sell the item.
To create an item

1. Go to the Lists menu and select Items. The Items List window appears.

2. Click New. The Item Information window appears.

3. In the Item Number field, type a unique identifier and press TAB.
   
   **Tip:** Use the backslash character for service items. The backslash character (\) serves a special purpose: any item number that begins with a backslash won’t appear on printed forms. This is useful for service-type items (such as labour) for which you don’t want to print an item number on the invoice.

4. Enter details about the item in the relevant fields:

   - **A** Type a unique identifier for the item.
   - **B** Type a name for the item.
   - **C** Select the account you want to use to record the income you receive from the sale of this item.
   - **D** Enter the retail price of one selling unit. If this price includes GST, select the Prices are GST Inclusive option. If the price is GST exclusive, deselect this option.

5. Click the Item Details tab and enter additional information about the item or add a picture of the item.

6. [Optional] If you want to enter sales history for the item, click the History tab and enter the sales figures for the previous 12 months.

7. Click OK.
4 Working online

If you are subscribed to AccountRight Live, you can store your company file online, so that you, your accountant and other authorised users can access the file using any computer that has AccountRight installed. This chapter explains how you can access your company file online using AccountRight Live.

With AccountRight Live, you can:

- work online when you have an internet connection. See ‘Work on an online company file’ on page 55.
- work offline when you want to work without an internet connection. See ‘Work offline (checking out)’ on page 58.
- regularly synchronise changes made in the online company file to a copy of the file on your computer. You can view this file when you unexpectedly lose your internet connection. See ‘Synchronise a company file’ on page 56.
- invite others to access your online company file. See ‘Set a password for the Administrator’ on page 36.

Get started online

Before you get started with AccountRight Live, ensure that you have:

- the current version of AccountRight installed on each computer that will access the online company file. You can’t access online company files using an internet browser.
- an AccountRight Live subscription for each company file you create or upload. To purchase a subscription, visit my.MYOB.co.nz.

Use the following table to learn how to get started online:

<table>
<thead>
<tr>
<th>I have a company file</th>
<th>I don’t have a company file</th>
<th>I’ve been invited to work online</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Upload the company file. See ‘Set up a file for online access’ on page 54.</td>
<td>1. Create a company file. See ‘Create a company file’ on page 26.</td>
<td>1. Accept the invitation. See ‘Accept an invitation to work online’ on page 56.</td>
</tr>
<tr>
<td>2. Invite others to access the file. See ‘Set a password for the Administrator’ on page 36.</td>
<td>2. Invite others to access the file. See ‘Set a password for the Administrator’ on page 36.</td>
<td>2. Install AccountRight on your computer. See the Getting Started guide for instructions.</td>
</tr>
<tr>
<td>3. Work online.</td>
<td>3. Work online.</td>
<td>3. Open the company file and work online. See ‘Open an online company file’ on page 55.</td>
</tr>
</tbody>
</table>

* Your accountant can also create the file for you. First however, you will need to invite them to become an AccountRight Live administrator. For details, see ‘Set a password for the Administrator’ on page 36.
Set up a file for online access

With AccountRight Live, you can access your company file online. This means you can:

- access your company file anytime, from any computer that has AccountRight installed
- give your accountant online access to your company file, making it easier to do reviews and prepare reports
- have up to five people working on your online company file at the same time.

**NOTE:** Creating company files  This section explains how to upload an existing company file so you can access it using AccountRight Live. If you want to create a new company file online, see ‘Create a company file’ on page 26.

Requirements

To set up online access for an existing company file, you need to:

- have registered your AccountRight product at my.MYOB.co.nz
- have a current AccountRight Live subscription. You will need a subscription for each company file that you want to create or upload. To purchase additional subscriptions, visit my.MYOB.co.nz.
- have activated the company file. See ‘Activate the company file’ on page 29.
- have company file administrator access, as well as online (AccountRight Live) administrator access.

To set up online access for an existing company file

2. Click Open a company file. The Library Browser appears.
3. Open the company file that you want to access online.
   - Note that the company file must be in the AccountRight library on the computer you are uploading from, not on the network.
4. Go to the File menu and choose Go Online (Upload This File).
   - A message appears, explaining that the file may take some time to upload, depending on its size and the speed of your internet connection.
5. If the MYOB AccountRight Live Log In window appears, log in using your my.MYOB login details.
6. Click Upload now.
   - When the file has finished uploading, a confirmation message appears.
7. Click Sign on to open the online company file.

To give others access to your online company file, see ‘Add new company file users’ on page 36.
Work on an online company file

When a company file is online, you can access it from any computer that has a compatible version of AccountRight installed.

Once you log in to AccountRight Live, you can access all the company files that you have uploaded or created online, and the files that other AccountRight users have invited you to work on.

Open an online company file

If you have been invited to work on an online company file, you need to do the following before you can access the file.

- Accept the invitation to work with the company file.
- Install AccountRight on your computer.

For more information, see ‘Accept an invitation to work online’ on page 56.

To open an online company file


   **TIP:** Reopening a file Your most recently opened company files appear in the Welcome window. If the file you want to open appears in the list, you can click it to open the file. If you haven’t already logged in to AccountRight Live, you will be prompted to do so.

2. Click Open a company file. The Library Browser appears.

3. Click Online. The Log in to AccountRight Live fields appear.

4. Log in to AccountRight Live using your my.MYOB login details.

   **NOTE:** (Invitees only) Login details If you have been invited to work online, enter the email address and password that you used when accepting the invitation. For more information, see ‘Accept an invitation to work online’ on page 56.

5. In the Company files online list, double-click the company file you want to open, or select it and click Open.

   The Sign-on window for the company file appears.

6. Sign on with your company file user ID and password.

   **NOTE:** (Invitees only) If you don’t have a User ID If you have been invited to work on an online company file, but you don’t have a User ID for the file, contact the person who invited you. They will need to set you up as a company file user. For more information, see ‘Add new company file users’ on page 36.

   The Command Centre appears. You can now work on the online company file.
Accept an invitation to work online

This section describes the process of accepting an invitation to work with a file online, then setting up your details to access the file.

Task 1: Accept the invitation (set up your my.MYOB login)

1. Open the email you received and click the Accept Invitation link. A webpage is launched where you will complete the acceptance process.
2. Follow the onscreen instructions to accept.

NOTE: Your my.MYOB login details You will be prompted to set up a my.MYOB email address and password, or to confirm your current my.MYOB details as part of the acceptance process. These details will also be your AccountRight Live login details.

Task 2: Install AccountRight

You don’t need to own AccountRight in order to work with an AccountRight file you’ve been invited to use. But you do need it installed on each computer that you want to access the online company file from.

For example, if you want to access the file from your home computer as well as the office computer, you need to install AccountRight on both machines.

You can download a test drive version of the software and get access to all features.

- To download a test drive, visit www.myob.co.nz/testdrives.

Task 3: Get your company file sign-on details

The person who invited you to use the company file will have set you up with a user ID and password for signing on to the company file. These details are different to your my.MYOB login details, as they are unique to each company file.

You’ll need to contact the person who invited you to be an AccountRight Live user, to get your company file sign-on details.

Task 4: Open the company file

- See ‘Open an online company file’ on page 55.

Synchronise a company file

When you create an online company file, you can choose to automatically synchronise the file to your computer.

Synchronising means that changes that you or other users make in the online company file are downloaded to a copy of the file stored on your computer. This is referred to as the ‘offline’ copy of your file.

Your offline company file will be synchronised automatically every 20 minutes, while the company file is open. You can also manually synchronise your file.

By synchronising regularly, you ensure that a recent copy of your online company file is available on your computer to view when you don’t have internet access.

NOTE: Enable automatic synchronisation If you chose not to automatically synchronise your company file when you created it, you can change this option anytime. For more information, see ‘Automatic synchronisation’ on page 57.
Synchronisation versus backup  The synchronised offline file that’s saved on your computer is not a backup of the online company file. You should continue to make backups whenever you want to save a copy of your file as at a point in time. For information about the importance of backing up, see ‘Backing up and restoring company files’ on page 186.

Where is the offline file stored?  The offline copy of your company file is stored in the following hidden folder:

- Windows 7 and 8:
  C:\Users\{name}\AppData\Local\MYOB\AccountRight\Offline\sync
- Windows XP:
  C:\Documents and Settings\{name}\Local Settings\Application Data\MYOB\AccountRight\Offline\sync

Do not delete or rename this folder or the contents of this folder. If another user signs on to Windows, and synchronises the company file, a copy of the online file will be downloaded again to that user’s sync folder.

Automatic synchronisation

By default, your company file will be synchronised every 20 minutes, while it is open online. You can disable this automatic synchronisation if necessary.

When synchronisation begins, you can track the progress by checking the status bar.

To enable automatic synchronisation

If you haven’t previously synchronised the online company file on your computer, you will need to manually synchronise it. See ‘Manual synchronisation’ on page 58. The file will then synchronise automatically every 20 minutes.

If the company file has previously been synchronised on your computer, but automatic synchronisation has been disabled, you can re-enable it from the:

- Status bar menu: Open the company file for which you want to enable synchronisation. Then, choose Enable Auto Sync from the status bar menu.

- Library Browser: Open the online library and sign on to AccountRight Live. Then, right-click the company file you want to enable synchronisation for, and choose Enable Auto Sync.

To disable automatic synchronisation

You can disable automatic synchronisation from the:

- Status bar menu: Open the company file for which you want to disable synchronisation. Then, choose Disable Auto Sync from the status bar menu.

- Library Browser: Open the online library and sign on to AccountRight Live. Then, right-click the company file you want to disable synchronisation for, and choose Disable Auto Sync.
Manual synchronisation

You can manually synchronise whenever you want. For example, you may want to manually synchronise before closing your company file, even if automatic synchronisation is enabled. This will ensure that any online changes made before closing the file are synchronised.

Note that the first time you manually synchronise, a full copy of the online company file will be downloaded to your computer. This can take a while and you won’t be able to work on the file while it is being synchronised. Subsequent synchronisation will be automatic, only updating the offline file with changes that are made online. If you want to disable automatic synchronisation, see ‘To disable automatic synchronisation’ on page 57.

To manually synchronise your company file

1. Open the company file you want to synchronise.
2. Go to the File menu or the status bar menu and choose Sync Company File. The Ready to synchronise message appears.
3. Click Synchronise. If you
   - have synchronised the company file before, you can continue working on the file while it is being synchronised.
   - are synchronising for the first time, this can take a while and you won’t be able to work on the file while it is being synchronised.

The status bar will show the progress of the synchronisation.

When synchronisation has completed, a confirmation message

Work offline (checking out)

You can choose to work offline with your company file. In AccountRight, working offline means that you will be checking out the file to your computer—this locks the online file from being modified by others, although they can still view the file.

You would work offline if:

- you know you won’t have internet access for a while. For example, you will be travelling and won’t have a constant internet connection.
- you don’t want to be connected to the internet all day. For example, your internet is slow or your connection is unreliable.
- you want exclusive access to your company file. For example, you want to prepare end-of-period reports.

When you check out:

- the online company file will become read-only, which means other users can view the online company file, but they can’t make changes until you check in the company file.

To check out an online company file

1. Open the online company file that you want to check out.
2. Go to the File menu and choose Work Offline (Check Out).
   - If you haven’t synchronised your company file before, a message appears, explaining that the check out may take a while.
3 Click **Check out**.
   When the file has finished synchronising and has been checked out, a message appears, explaining that you need to sign on to your company file again.
4 Click **Sign on**. The **Sign on** window appears.
5 Sign on to the company file. The checked out company file is opened.

**To check in your online company file**

**NOTE:** **Administrator access required** To check in a company file, you need to log in to AccountRight Live as an AccountRight Live administrator.

You can check in the changes you’ve made offline:

- while working in a checked out company file: Go to the **File** menu and choose **Work Online (Check In)**
- when opening the checked out company file: Click **Check in** when the **You’re working offline** message appears.

**NOTE:** **Undo check out** In certain situations, you may not want to check in your files. For details on how to undo the check out and discard any changes you’ve made, see *Checking in without saving changes*, below.

**Checking in without saving changes**

If you make changes to your company file while offline, and choose not to check them in (that is, you want to lose the changes you made offline, and not update the online company file), you will need to undo the check out.

A check out can be undone from the computer on which the online company file was checked out, or from another computer.

You will need to undo a check out if the company file can no longer be accessed (for example, the computer on which changes were made has been stolen, or the drive has become corrupt). It is also useful when the user who checked out the file is unavailable for a long period of time.

**To undo a check out (discarding changes)**

**NOTE:** **Online administrator access required** To do this task, you need to have online administrator access. For more information, see *Inviting a user to work online* on page 38.

1 Start AccountRight and click **Open** in the **Welcome** window.
2 The **Library Browser** appears.
3 Click **Online**. The **Log in to AccountRight Live** fields appear.
4 If you haven’t already done so, log in to AccountRight Live as an AccountRight Live administrator.
5 In the list of online company files, find the company file whose check out you want to undo.
6 Right-click the company name and select **Undo Check Out (Discard Changes)**. A message appears asking to confirm that you want to discard your offline changes.
7 Click **Yes**.

When the offline changes have been discarded, a message appears explaining that you can now sign on to the online company file to continue working.
Recovering a discarded file  When you undo a check out, or you open a checked out file that has been undone from another computer, a copy of the offline file will be saved for you in the following folder:

C:\Users\{name}\AppData\Local\MYOB\AccountRight\Offline\Discarded Files.

To reopen this file, you need to copy it into your AccountRight library.

Troubleshoot AccountRight Live

If you have problems connecting to an online company file, check the following:

- **Internet connection issues**: To check for internet issues, try opening a webpage in your internet browser. If you can't access webpages, check your network cables, try unplugging your modem and router and wait a minute before reconnecting them, or contact your internet service provider.

- **Company file is being upgraded or restored**: An online company file can't be opened while it is being upgraded or restored. If you or another AccountRight Live administrator have recently started an upgrade or restore, you can check the status of the task in the Library Browser (click Open a company file in the Welcome window).

- **AccountRight Live maintenance**: To check for scheduled maintenance, or known issues with the AccountRight Live service, visit.

If you can't connect to an online company file, and need to access your company information, see:

- ‘When your online file is temporarily unavailable’ below
- ‘When internet access isn’t available for a while’ on page 61.

When your online file is temporarily unavailable

If automatic synchronisation is enabled on your computer, or you manually synchronise your online company file, you can view the read-only copy of your online file. See ‘Synchronise a company file’ on page 56.

The read-only copy will be current as at the last time it was synchronised. You can use this file to view transactions and records, and to print reports and forms, but you can’t make changes to the file.

To view a read-only copy of your online file

1. Start AccountRight and click Open in the Welcome window. The Library Browser appears.
2 Click **Online**.

3 In the list of online company files, find the company file you want to open. The **Last Sync** column shows the date that each company file was last synchronised.

   **NOTE:** **Company file not listed?** If your company file does not appear in the list, this means that a read-only copy of your online company file is not available for you to view on this computer. You will not be able to continue with this procedure, and you will need to wait until your internet connection becomes available again.

4 Right-click the company name of the file you want to view and select **View a read-only copy (offline)**.

5 Sign on to the company file.

**What you should know**  If you choose to do the following, note:

- the online company file can still be edited by other users who can connect to the internet
- when your internet is restored, you can’t check in the changes you make offline, however you can import data into the online file
- you can choose to replace the online company file with the offline copy of the file that you work on.

**Task 1: Work on an offline copy of your online file**

1 Start AccountRight and click **Open** in the **Welcome** window. The **Library Browser** appears.

2 Click **Online**.

3 In the list of online company files, find the company file you want to open. The **Last Sync** column shows the date that each company file was last synchronised.

   **NOTE:** **Company file not listed?** If your company file does not appear in the list, this means that a read-only copy of your online company file is not available for you to view on this computer. You will not be able to continue with this procedure, and you will need to wait until your internet connection becomes available again.
4 Right-click the company name of the file you want to view and select View a read-only copy (offline).

5 Sign on to the company file.
   A message appears, explaining that you are opening a read-only file. Click Close.

6 Go to the File menu and choose Back Up.
   The Back Up Company File window appears.

7 Give the backup file a name that will help you identify it, and then click Back Up.

8 Go to the File menu and choose Restore.
   The Restore Backup File window appears.

9 Click Browse and select the file that you just backed up.

10 Give the restored file a unique name.

11 Select the option labelled in a library on my computer or my network.

12 Click Restore.
   When the file has finished restoring, the Sign-on window appears.

13 Sign on to your company file. You can now work offline on your company file.

   **TIP:** Let your other users know that you’re working offline. To avoid losing information in the online company file, you should contact the other users and let them know that you are working on the file offline. They should not enter or modify transactions and records in the online file until you are able to work online again.

**Task 2: Update the online company file**

When your internet access is restored, you can resolve the changes you made offline by exporting the transactions or records you entered offline, and importing them into the online company file. For more information, see ‘Importing and exporting data’ on page 193.

Alternatively, you can restore your company file online. Note that this option is suitable only if no changes were made to the online file, or you are wanting to replace the online file with the copy you have on your computer.

Follow the steps below to restore your company file online.

   **NOTE:** Administrator access required To restore a company file, you will need to log in to AccountRight Live as an AccountRight Live administrator.

1 In the offline company file you have been working on, go to the File menu and choose Back Up.
   The Back Up Company File window appears.

2 Give the backup file a name that will help you identify it, and then click Back Up.

3 When the backup is complete, go to the File menu and choose Restore.
The **Restore Backup File** window appears.

4. Click **Browse** and select the file that you just backed up.
5. In the **Restore Backup File** window, select the **online with AccountRight Live** option.
6. Click **Restore**. A message appears, warning that restoring can’t be undone. Click **Yes** to continue.
7. If the **MYOB AccountRight Live Log In** window appears, log in as an AccountRight Live administrator.
8. When the file has finished restoring, the **Sign-on** window appears.
9. Sign on to your online company file. You can now work online.
Use AccountRight’s banking features to record your bank and cash transactions and keep on top of your finances. You can:

- record the money that goes in and out of your bank accounts and credit card accounts
- manage money that you deposit in a batch, such as customer payments made by cash, cheque or credit card
- record cash payments and purchases, such as petty cash expenses
- reconcile transactions shown on your bank statement with the information you’ve recorded in AccountRight, to check that your records are up to date
- prepare payments to process electronically using your internet banking software or website.

Bank feeds help you keep up to date

If you’re subscribed to AccountRight Live, you can sign up to the bank feeds service and have all of your bank transaction details automatically fed into your company file. You’ll just need to check and approve the information before it’s committed to your file.

Using bank feeds is the easiest way to keep your financial records up to date and accurate. Because you’re approving transactions as you go, bank reconciliation is largely done for you.

If you’re not using bank feeds...

If you haven’t signed up to the bank feeds service, or you have bank or credit card accounts that don’t work with the service, you can still keep your information up to date in AccountRight. Most of your transactions can be entered from the one window (see ‘Entering transactions in the Bank Register window’ on page 74) and there are smart features that will help you speed up your data entry too (see ‘Recurring transactions’ on page 110).
About bank feeds

Bank feeds lets you compare your bank account and credit card transactions with the information you have in AccountRight and easily add transactions.

Before you can use bank feeds, you need to register the bank or credit card account you want to use. You also need an AccountRight Live subscription. For information on how to receive a feed for your bank or credit card account, see ‘Set up bank feeds’ on page 48.

Note that how often your bank feeds are updated depends on your bank. For information on feed frequency and for a list of supported banks and accounts, see myob.co.nz/arlive/banks.

How bank feeds can work for you

It’s simple to work with bank feeds. First you get your bank feed, then you compare the information you receive from the bank with the information available in AccountRight. If necessary, you can add a transaction if it is not already recorded in AccountRight. Then, you just need to confirm that everything received from the bank agrees with what you’ve got in your software. This is called ‘approving’ (see ‘Approving a bank feed’, on page 68 for more information).

You can use bank feeds to reflect the way you maintain your business records. For example, you can use bank feeds:

- **For transaction entry.** Use bank feeds as a key way of entering information in AccountRight. Bank feeds speeds up transaction entry, as a lot of the work is done for you.

- **To get up-to-date bank information.** Depending on how frequently your bank updates your feed, you can get information from bank feeds faster than from other sources. Instead of waiting for a remittance, you’ll know when a customer has paid you the moment it appears in your bank feed.

- **As a reconciliation tool.** When you confirm that the information from your bank matches the information in AccountRight, your AccountRight transactions are automatically prepared for reconciliation. You have a lot less work to do when it comes time to reconcile your accounts.

**The Bank Feeds window** When you get your bank feed, the bank account transactions and your matching AccountRight transactions appear side by side in the Bank Feeds window. This is where you work with bank feeds.

---

A Bank Statement These are your bank feed transactions from your bank. You can sort them by clicking a column heading. For example, click Date to sort your transactions by date.

B Manage Rules Create or edit rules to automate the matching process. See ‘Using bank feed rules’ on page 70.
How matching works

Bank feeds work by matching transactions from your bank to those recorded in AccountRight. Where possible, AccountRight will try to automatically match bank transactions to AccountRight transactions. You can also create rules that will tell AccountRight what to do if a bank transaction matches predefined criteria.

Where no automatic match occurs, you’ll need to manually match a transaction.

Automatic matching

When you receive a bank feed, AccountRight tries to automatically match transactions from your feed with existing AccountRight transactions.

A bank transaction and AccountRight transaction are matched if they have the same date and amount and the AccountRight transaction is the correct type (such as Spend Money).

Example:

A payment for Metropolitan Electricity of $400 comes out of your bank account on 16 November 2013. When this payment appears in your bank feed, it is automatically matched to a Spend Money transaction recorded for $400 recorded on 16 November 2013.

Of course, if there are two identical transactions, a match won’t happen (you will be able to review the identical transactions).

Rule matching

You can set up rules to automatically prepare matching transactions in AccountRight. The more rules you set up, the more matching is automated and the less transactions you have to find or create.

Rules work by searching for bank transactions based on search criteria you set.

You can set up invoice rules to record invoice payments and transaction rules for all other receipts and expenses. For more information on setting up rules, see ‘Using bank feed rules’, on page 70.

Manual matching

If there isn’t an automatic match, (for example because of a rounding difference in the amounts), you can easily find the AccountRight transaction, edit it, and manually match it. Or, if it is yet to be recorded in AccountRight, you can create a matching transaction in the Bank Feeds window. See ‘Approving a bank feed’, on page 68.

Watch the following video for an overview of how bank feeds can help you keep on top of your banking.
Approving a bank feed

To approve your bank feed, you need to bring your bank transactions into AccountRight and approve the automatic matches. For any transactions that remain unmatched, you can either find a transaction you’ve previously entered in AccountRight, or create a new transaction in AccountRight.

To approve a bank feed

1. Go to the Banking command centre and click Bank Feeds. The Bank Feeds window appears.
2. In the Account field, select the account you want to receive feeds from.
3. Click Get Bank Transactions. The Bank Statement column will refresh and display any new bank transactions that have occurred since your last update. Note that bank feeds are updated for all accounts.

Any bank feed transaction that exactly matches a transaction already entered into AccountRight, or any transaction that has a transaction rule applied to it will be automatically matched.

To approve matched transactions

4. Review the matched transactions.
   • If the transactions have been matched correctly, click Approve.
   • If a transaction has been matched incorrectly, you can undo the match. Click the unmatch icon (X). This undoes the match and the AccountRight transaction disappears from the right side of the Bank Feeds window.

   NOTE: Undoing a match

   Undoing a match does not delete the AccountRight transaction. You will also need to find another AccountRight transaction, or create a new transaction to match the bank feed transaction.

To approve unmatched transactions

5. If you’ve already entered the transaction into AccountRight:
   a. In the Bank Feeds window, select an unmatched bank feed transaction and click Find. The Find a Matching Transaction window appears.

   ![Find a matching transaction window](image)

   If the transaction you want doesn’t appear in this window, change the amount and date ranges and click Update to filter your search. Note that only unreconciled transactions appear.
   b. Select a transaction. If the amount of the transaction does not exactly match the bank feed transaction amount, you’ll need to edit it. You can do this by clicking the zoom arrow next to it.
   c. Click Match & approve. The Bank Feeds window reappears with the AccountRight transaction matched and approved to the bank feed transaction.
If you haven’t entered the transaction into AccountRight:

a. In the Bank Feeds window, select an unmatched bank feed transaction, click New and select the type of transaction you want to create. The relevant transaction window appears.

b. Complete the transaction. As the aim is to create a matching transaction, some fields, such as Amount, Date and Memo, automatically contain information from the bank feed transaction and greyed-out fields, such as Pay from Account, cannot be edited.

c. Click Record. The transaction is recorded and the Bank Feeds window reappears with the AccountRight transaction matched and approved to the bank feed transaction.

To hide a transaction

- In the Bank Feeds window, right-click the transaction and choose Hide Transaction. The hidden transaction disappears from the Bank Feeds window.

To view a hidden transaction

1. Go to the Show field and select Hidden. If the transaction you want doesn’t appear, change the date filters and click Update.
2. Select a transaction and click Unhide. The transaction disappears from the Bank Feeds window.
3. Go to the Show field and select Current Transactions. The hidden transaction now reappears in the Bank Feeds window with the rest of your bank feed transactions.

Unapproving matched transactions

If a match has been incorrectly approved, you need to undo the approval. In the Bank Feeds window, select the approved match and click Undo. The Undo button changes to Approve and the tick next to the AccountRight transaction is replaced with the unmatch icon (X). You can then undo the match, by clicking the unmatch icon.

```
TIP: Redisplay approvals If you close the Bank Feeds window, any approved matches will no longer appear the next time you open the window. To redisplay approved matches, select Approved in the Show field. All approved matches for the selected account appear.
```
Using bank feed rules

If you have transactions that regularly appear in your bank feeds, you can set up rules to automatically create matching transactions in AccountRight, or to help match payments to invoices.

Rules search for a word or phrase in your bank feed and, when found, an AccountRight transaction is suggested as a match, or created and matched, ready for you to approve. You can make the search as simple or as complex as you need. For more information about searches see ‘Search options’ on page 72.

The type of rule you apply, and the way the rule works depends on the type of transaction. There are two types of rules you can create in bank feeds: transaction rules and invoice rules.

**Transaction Rules**  Use transaction rules when you receive or pay money that is not for an invoice or bill you’ve recorded in AccountRight. A transaction rule can create a transaction and allocate the transaction amount to one or more accounts, jobs or GST codes.

Say you regularly buy stationery from a business called Office Supplies, you can create a transaction rule, so that each time a transaction from Office Supplies comes through in your bank feed, a matching transaction is automatically created and matched in AccountRight.

You can create similar rules for utility payments, rent, petrol purchases or other Spend Money or Receive Money transactions. For information on how to set up transaction rules, see ‘To create a transaction rule from a bank feed transaction’ below.

**Invoice Rules**  Use invoice rules to help match customer payments to the invoice they relate to. When the rule is applied in AccountRight, a list of possible invoice matches are provided, all you need to do is select the correct one and approve it.

**TIP:** Online invoice payments from customers  If a lot of your customers transfer their payment directly to your account, you can ask them to add their name or customer reference number to their internet banking transfer, to help with the matching process.

You can create a rule from a bank feed transaction, as in the following example, or you can create a rule from the Manage Rules window.

**To create a transaction rule from a bank feed transaction**

1. Go to the Banking command centre and click Bank Feeds. The Bank Feeds window appears.

2. Select the bank statement transaction that you want to create the rule for and click New > Transaction Rule. The New Rule window appears.

   ![New Rule window](image)

   Note that the rule name automatically contains the description from the bank feed transaction. You can change this if you want.

3. Choose whether to apply the rule to one selected account, or all bank feeds accounts.
4 Enter the word or phrase that the bank feed transaction should contain. If the text is found in the bank feed transaction’s description, the rule will be applied. For more information, see ‘Search options’, on page 72.

5 Enter the allocation details. If you want to allocate to more than one account, job or GST code, click Show advanced options. For more information see ‘Search options’, on page 72.

6 Click OK. The Bank Feeds window reappears. The rule you have created is applied to the bank feed transaction.

The next time a bank feed transaction appears matching the rule conditions you have selected, the rule will be automatically applied.

To create an invoice rule from a bank feed transaction

1 Go to the Banking command centre and click Bank Feeds. The Bank Feeds window appears.

2 Select the bank statement transaction that you want to create the rule for and click New > Invoice Rule. The New Invoice Rule window appears.

Note that the rule automatically contains the description from the bank feed transaction. You can change this if you want.

3 Choose whether to apply the rule to one selected account or all bank feeds accounts.

4 Enter the customer you want to create the rule for. When the rule is applied, all open invoices for this customer will be found.

5 Click OK. The Bank Feeds window reappears. The rule you have created is applied to the bank feed transaction and the Possible invoice match link appears.

The next time a bank feed transaction appears matching the rule conditions you have selected, the rule will be automatically applied.
To edit a rule

1. Go to the Banking command centre and click Bank Feeds. The Bank Feeds window appears.
2. Click Manage Rules. The Manage Rules window appears.
3. Select a rule and click Edit.
4. In the window that appears, make the changes to the rule and click OK. The Manage Rules window reappears.
5. Click Close. The Bank Feeds window reappears.
6. Click the refresh icon ( ) to update the Bank Feeds window with the changes.

To delete a rule

1. Go to the Banking command centre and click Bank Feeds. The Bank Feeds window appears.
2. Click Manage Rules. The Manage Rules window appears.
3. Select a rule and click the delete icon ( ). The rule disappears from the Manage Rules window.
4. Click Close. The Bank Feeds window reappears.
5. Click the refresh icon ( ) to update the Bank Feeds window with the change.

Search options

When you create a rule, you specify the words you want to search for in the bank transaction description. You can also use additional options to narrow the range of this search.

You can search for an exact word or phrase that appears in your bank transaction description. If the description varies, for example, you purchase petrol from different retailers, enter additional search terms.

The New Rule window contains two search fields:

<table>
<thead>
<tr>
<th>Exact word or phrase</th>
<th>Search for an exact term (including punctuation) in the bank transaction description.</th>
</tr>
</thead>
<tbody>
<tr>
<td>And/or these words</td>
<td>Search for additional words or phrases. When you combine an exact word or phrase search with an and/or search, you can make the rule look for very specific combinations of text.</td>
</tr>
</tbody>
</table>

Note the following about search conditions:

- Search conditions are not case sensitive.
- You do not need to enter terms in both fields. The rule will skip a search field you leave blank.
- Words entered in both fields are treated as an ‘and’ phrase.
- Separate words or phrases in the and/or field must be separated by commas.
- Phrases in the and/or field must be enclosed in quotation marks.

The following table shows different search combinations and what they can find:

<table>
<thead>
<tr>
<th>This word or phrase:</th>
<th>...and/or these words:</th>
<th>...finds:</th>
</tr>
</thead>
<tbody>
<tr>
<td>BANK</td>
<td>FEE</td>
<td>• BANK FEE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• FEE - BANK</td>
</tr>
</tbody>
</table>
Example: Allocating a credit card merchant fee

To account for bank charges or merchant fees, or to track interest on a bank loan, you can also allocate negative percentages and negative amounts in a rule.

Example:

Clearwater receives a regular credit card payment for servicing a customer’s water coolers. The amount of the payment varies, but a merchant fee of 1.5 percent is always deducted from the payment before it is deposited into Clearwater’s account. The rule set up below shows an allocation for the payment and a negative allocation of 1.5 percent for the merchant fee:

Note that as the total percentage allocated must equal 100, the percentage allocated for the service payment is 101.5 percent.

In December, Clearwater receives a payment of $443.96. When the rule is approved, the following transaction is created:
Recording money you have spent and received

If you have an account that’s not associated to a bank feed, an easy way to record the money that flows in to and out of the account is to use the Bank Register window. This includes payments for customer invoices and supplier purchases, as well as any other receipts and payments.

If you want to record a lot of detail for your transactions, use the Spend Money and Receive Money windows.

Entering transactions in the Bank Register window

**NOTE:** Are you working with an account associated to a bank feed? If so, use the Bank Register window when you want to add a transaction to AccountRight before it appears in your bank feed.

You can enter the following transactions in the Bank Register window: cheques, deposits, payments to suppliers, payments from customers and sales.

The main advantages of using the Bank Register window to enter transactions instead of using transaction windows such as Spend Money, are speed and convenience. For example, you can record a customer payment and then write a cheque without having to open multiple windows and switch between them. As transactions can be recorded with minimum detail, you save time when entering a batch of transactions. Note that you cannot use the Bank Register window to record electronic payments.

**Importing your online bank and credit card statements** You can also use the Bank Register window to import your bank and credit card statements. If a statement contains any transactions that you have not entered, you can add them quickly in the Bank Register window. For more information, see ‘To reconcile by importing a bank statement’ on page 84.

To enter a transaction in the Bank Register window

1. Go to the Banking command centre and click Bank Register. The Bank Register window appears.
2. In the Account field, select the bank or credit card account that will be used for this transaction.
3. In the lower part of the window, select the transaction type from the Type list. The transaction type you select depends on whether or not the payment is for a customer invoice or supplier purchase.

   If the payment is for a:
   - customer invoice, select Receive Payment
   - receipt other than an invoice payment, select Receive Money
   - purchase, select Spend Money.
Enter a transaction reference:
- If you select Spend Money from the Type list, enter a cheque number (or other transaction reference) in the Cheque No. field.
- If you select Receive Payment, Receive Money or Enter Sale from the Type list, type a transaction reference in the adjacent ID No. field.

5 In the Date field, enter the date of the transaction.
6 In the Card field, enter the card for this transaction.
7 In the Amount field, type the total amount of the transaction, including GST.

**TIP:** To void a cheque If you want to void a cheque because, for example, you made a mistake when writing the cheque manually, leave the Amount field and the account allocation fields blank.

8 If you want to allocate the amount to only one account, enter the account that will be used for this transaction in the Account field [not applicable for Receive Payment].

9 If you want to allocate the amount to more than one account, click Split. The corresponding transaction window will appear, and you can then allocate the amount to multiple accounts of your choice. Note that you can also click Split to:
- apply payments to a particular invoice
- enter the payment method
- print the transaction.

**NOTE:** When the Split button is not available If the transaction type is Enter Sale, Split is not available. To open the transaction window, you will need to record the transaction, then click the zoom arrow (🔍) next to the transaction in the Bank Register window.

10 Select the appropriate GST code in the GST field (not applicable for Receive Payment).
11 [Optional] Assign the payment to a job by entering the job code in the Job field (not applicable for Receive Payment).
12 [Optional] If you want to record the purpose of the transaction, type a description in the Memo field.

**TIP:** Save the transaction as recurring If you want to store the transaction as a recurring transaction, click Save as Recurring. In the Recurring Schedule Information window, enter the necessary information and click OK. (Note that in the Bank Register this option is available only for Spend Money and Receive Money transaction types.) For more information, see ‘Recurring transactions’ on page 110.

13 Click Record.

**Entering detailed transactions**

**NOTE:** Are you working with an account associated to a bank feed? If so, only use the Spend Money and Receive Money windows to add a transaction to AccountRight before it appears in your bank feed.

**To record money you receive**

1 Go to the Banking command centre and click Receive Money. The Receive Money window appears.
2 Choose the account that will be used to record the money.
   - Deposit to Account. Select this option if the money was deposited directly to your bank account.
   - Group with Undeposited Funds. Select this option if the money will be deposited at a later time. For information about undeposited funds and preparing bank deposits, see ‘Approving a bank feed’ on page 68.
3 If the deposit amount included GST, select the GST Inclusive option.
4 In the Payor field, enter the payor’s card.
5 In the Amount Received field, type the amount received.
6 [Optional] In the Payment Method field, select the payment method.
[Optional] If you want to record additional details about the transaction, such as a cheque number, click Details and record the details in the Applied Payment Details window that appears.

Enter the date of the transaction.

[Optional] Type a detailed comment in the Memo field to help you identify the transaction later.

Allocate the amount to the appropriate account.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acct No.</td>
<td>Name</td>
<td>Amount</td>
<td>GST</td>
<td>Memo</td>
</tr>
<tr>
<td>1-100</td>
<td>Name of Capital</td>
<td>1000</td>
<td>0.05</td>
<td>Memo</td>
</tr>
</tbody>
</table>

A  Enter an account to which you want to assign the transaction or part of the transaction.

B  Type the amount you want to assign to this account. The total amount in this column must equal the amount in the Amount Received field before you can record the transaction.

C  [Optional] Assign the amount to a job by entering the job code here.

D  [Optional] Type a memo for each entry in the transaction.

E  The GST code that is linked to the allocation account appears here automatically. You can change it if necessary.

If the payment covers more than one account, repeat step 10 on page 76 on a new transaction line.

If you want to view or change the GST amounts assigned to the transaction, click the zoom arrow () next to the GST field.

[Optional] If you use categories and want to assign the transaction to a particular category, select a category from the Category list.

TIP: Save the deposit as a recurring transaction To store the transaction as a recurring transaction so that you can use it again, click Save as Recurring. In the Recurring Schedule Information window, enter the necessary information and click OK. For more information, see ‘Recurring transactions’ on page 110.

Click Record.

To record money you spend

1  Go to the Banking command centre and click Spend Money. The Spend Money window appears.

2  Select how the payment is to be made.
   - If you are paying electronically—that is, if you will be generating an electronic payment file for this payment—click Group with Electronic Payments.
     - If you are paying by some other means—such as by cash, cheque, credit card or internet banking—enter the account you are paying from in the Pay from Account field.

3  If the payment amounts you are entering are GST inclusive, select the GST Inclusive option.

NOTE: Make your selection now Don’t select or deselect the GST Inclusive option after you enter an amount in the Amount field.

4  Fill in the information in the cheque area of the window. Enter the payee card, cheque number (or other identification number), amount, memo, etc.

   If you are paying electronically, enter your own unique reference in the Statement Text field or accept the default. The text entered in this field will appear on the payee’s bank statement.

5  If you want to change the default payee address, enter the payee’s address in the Payee field.

Click Record.
Allocate the payment to the appropriate account.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset No.</td>
<td>Description</td>
<td>Amount</td>
<td>Sub</td>
<td>Memo</td>
</tr>
</tbody>
</table>

A  Enter the account you want to assign the payment to.

B  Type the allocation amount.

C  [Optional] Assign the payment to a job by entering the job code here.

D  [Optional] Type a memo to describe the payment.

E  The GST code that is linked to the allocation account appears here automatically. You change or delete it if necessary.

If your payment covers more than one account, repeat step 6. You would do this, for example, when paying for a purchase with a number of different types of purchases on it: postage, magazines, stationery, etc.

If you want to view or change the GST amounts assigned to the payment, click the zoom arrow (🔍) next to the GST field.

TIP: Recap transaction  Before you record this transaction, you can use the Recap Transaction feature to view the journal entries that will be created when the transaction is recorded. This is useful for confirming that the journal entries are posted to the correct accounts. To recap, choose Recap Transaction from the Edit menu.

Complete the payment

9  If you are paying by cheque and have already written a cheque, select the Cheque Already Printed option.

10  If you want to send remittance advice in a batch, select an option from the Remittance Advice Delivery Status list.

   After you have recorded a number of payments, say, the day’s payments, you can print or email remittance advices in a batch. For more information, see ‘Sending forms’ on page 126.

11  If you want to preview the remittance advice or cheque for this transaction, click Print and then choose Preview Cheque or Preview Remittance Advice. Note that the transaction is recorded before it is displayed.

12  If you want to print a cheque or remittance advice now, click Print and select the form type you want to print. Note that the payment is recorded before it is printed.

   TIP:  Save the payment as a recurring transaction  If you want to store the payment as a recurring transaction click Save as Recurring. In the Recurring Schedule Information window, enter the necessary information and click OK. For more information, see ‘Recurring transactions’ on page 110.

13  Click Record.
Preparing a bank deposit

Use the Prepare Bank Deposit feature to deposit payments you hold in a temporary holding account (known as an Undeposited Funds account) to your bank account.

You will have payments in an Undeposited Funds account if you selected the Group with Undeposited Funds option in the Receive Money or Receive Payments windows when you recorded the payments.

To prepare a bank deposit

1. Go to the Banking command centre and click Prepare Bank Deposit. The Prepare Bank Deposit window appears.
2. In the Deposit to Account field, enter the account you want to deposit funds into.
3. If you want to group receipts by payment method:
   a. In the Select Receipts by field, select Payment Method.
   b. In the adjacent field that appears, enter one or more payment types. (For credit cards, select one or more credit card types.) Only payments made using that method are listed.
4. Enter a date to display undeposited funds up to and including that date.
5. [Optional] Type a description of the bank deposit in the Memo field to help you identify the payment later.
6. Select the receipts you want to include in the bank deposit by clicking in the Deposit column next to them. If you want to select or deselect all receipts, click the select icon (✓) at the top of the Deposit column.
7. [Optional] If you need to enter an adjustment transaction—for example, to record credit card transaction fees or to keep part of
the deposit as cash—click Deposit Adjustment. The Bank and Deposit Adjustments window appears.

In the Fees and Cash Back and/or the Adjustment for Excess Funds sections:

a. Type the adjustment amount.
b. Type the date and an ID number.
c. Select an expense or income account—as appropriate—for the adjustment amounts.
d. Type a description in the Memo field and complete other fields as necessary.
e. Click Record. If you need to record additional adjustments or fees, click Deposit Adjustment again.

8. Click Record to record the bank deposit.

Electronic payments

If you pay your suppliers electronically, select the Group with Electronic Payments option when you record a supplier payment in the Spend Money window. You then prepare an electronic payment file for your bank to process the payments.

Electronic payment files contain the payment information for your bank to process, including your bank details, your payees’ bank details and the amounts you want to pay.

When you have prepared an electronic payment file, you can send it to your bank for processing (for example, by using online banking software provided by your bank). Contact your bank for more information on how to send electronic payment files for processing.

Setting up electronic payments Before you can prepare an electronic payment file, you need to complete the electronic payment setup tasks. For more information, see ‘Set up electronic payments’ on page 43.

Once you have recorded all the supplier payments you want to pay electronically, you can prepare an electronic payment file.
To prepare an electronic payment file

1. Go to the Banking command centre and click Prepare Electronic Payments. The Prepare Electronic Payments window appears.

2. In the Pay From Account field, select the bank account from which you are paying. The banking details of the account you select are included in the file that you send to the bank for processing.

3. In the Your Bank Statement Text field, type the text you want to appear on your bank statement.

4. In the Bank Processing Date field, enter the date you want the payment to be processed.

5. Click in the select column ( ) next to those payments you want to process.

6. Click Bank File. A window appears, informing you that the payment will be recorded before the bank file is created.

7. Click OK. The Save As window appears.

8. Select the destination folder and name for the electronic payment file and click Save. The payment information is saved as a file which you can send to your bank for processing.

9. If you want to prepare another electronic payment file, repeat from step 2.

10. Click Cancel to exit the Prepare Electronic Payments window.

Transferring money between accounts

You can transfer money between bank accounts, including bank and credit card accounts, using the Transfer Money window. For example, if you have a petty cash account set up as a bank account, you can transfer funds to it to top up the balance of your petty cash float. For information on setting up accounts see ‘Setting up accounts’, on page 32.

You can also record payments to credit card providers by transferring funds to credit card accounts.

TIP: Transferring money using bank feeds If you use bank feeds, you can transfer money as you check your bank transactions. For more information, see ‘About bank feeds’, on page 66.
To transfer money between accounts

1. Go to the Accounts command centre and click Transfer Money. The Transfer Money window appears.

2. Enter or select a date for the transfer.
3. In the Transfer Money From field, enter the account from which the funds will be paid.
4. In the Transfer Money To field, enter the account to which the funds will be paid.
5. In the Amount field, type the amount to be transferred.
6. If you want to record the purpose of the transaction, type a description in the Memo field.

**TIP:** Saving as a recurring transaction If you want to store the transaction as a recurring transaction, click Save as Recurring. Enter details of the recurring transaction in the Recurring Schedule Information window and click OK. For more information about recurring transactions, see ‘Recurring transactions’ on page 110.

7. Click Record.
Reconciling your bank accounts

Even if you use bank feeds to bring your bank account and credit card information into AccountRight, you still need to reconcile your accounts. Reconciling ensures that the bank account balances in your company file match your bank’s records.

If you are reconciling your bank account for the first time since you started using AccountRight, see ‘Do an initial bank reconciliation’ on page 46.

To reconcile an account you receive bank feeds for

TIP: If the Bank Feeds window lists bank statement transactions that you have already reconciled, you can hide them. See ‘Hiding transactions’ on page 69.

Follow this procedure for banking accounts that you receive bank feeds for.

1. Check that you have received all bank feed transactions for the period you want to reconcile, and they have been matched and approved. For information, see ‘About bank feeds’ on page 66.

2. Go to the Banking command centre and click Reconcile Accounts. The Reconcile Accounts window appears.

3. In the Account field, enter the account you want to reconcile.

4. In the Closing Statement Balance field, type the closing balance that appears on the statement your bank sent you.

   If you are reconciling as at the end of the week or month, and your statement has transactions dated after that date, type the closing balance for the last day of the period you’re reconciling.

5. In the Bank Statement Date field, enter the closing date that appears on your bank statement and then press Tab. Only unreconciled transactions dated on or before that date will appear.

   If you are reconciling as at the end of a week or month, and your statement has transactions dated later, type the last day of the period you’re reconciling.

6. Review the list of transactions. All bank feed transactions you have approved are marked as cleared.

   If there are uncleared transactions, mark them as cleared if they have appeared on your bank statement.

   This might be the case if, for example, you are performing a monthly reconciliation but you applied for bank feeds part way through the month.
To manually reconcile an account

Follow this procedure for banking accounts that you manually enter transactions into, that is, accounts that don’t have bank feeds, and accounts you don’t import bank statements for.

1. Go to the Banking command centre and click Reconcile Accounts. The Reconcile Accounts window appears.

2. In the Account field, enter the account you want to reconcile.

3. In the Closing Statement Balance field, type the closing balance that appears on the statement your bank sent you.

   If you are reconciling as at the end of the week or month, and your statement has transactions dated after that date, type the closing balance for the last day of the period you’re reconciling.

4. In the Bank Statement Date field, enter the closing date that appears on your bank statement and then press Tab. Only unreconciled transactions dated on or before that date will appear.

   If you are reconciling as at the end of a week or month, and your statement has transactions dated later, type the last day of the period you’re reconciling.

5. For each entry on your bank statement, select the corresponding transaction by clicking in the select column ( )

6. If there are entries on the statement relating to bank charges or bank interest that do not appear among the transactions on the Reconcile Accounts window, you need to manually enter these transactions.

   a. Click Bank Entry. The Bank and Deposit Adjustments window appears.

   b. Fill in the appropriate transaction details and click Record. The Reconcile Accounts window reappears.

7. Click Reconcile.

   If your account is reconciled, you have the option of printing a confirmation report. You’ll need to click Reconcile again after printing the report. If you don’t want to print the report, click Reconcile to finish.

   If your account is out of balance, see ‘Reconciliation problems’, on page 85.
To reconcile by importing a bank statement

Follow this procedure for accounts that you download statement files for, from your financial institution's online banking website.

1. Download the statement file from your bank.
   
   Your bank’s website should provide instructions on how to download this file. The following file formats are supported: OFX, QFX, QIF and OFC.

2. Go to the Banking command centre and click Reconcile Accounts. The Reconcile Accounts window appears.

3. In the Account field, enter the account you want to reconcile.

4. In the Closing Statement Balance field, type the closing balance that appears on the statement your bank sent you.

5. In the Bank Statement Date field, enter the closing date that appears on your bank statement and then press Tab. Only unreconciled transactions dated on or before that date will appear.


7. Locate and select the statement file you downloaded in step 1.

8. Click Open. The Get Statement window appears.

9. Click OK. The statement transactions are automatically matched with the transactions in your company file using the cheque number, date and amount as the criteria for matching withdrawals and deposits.

10. If the Unmatched Statement Transactions window appears, choose what you want to do for each unmatched transaction:

    - **Match:** If you have already entered a transaction that matches a statement transaction, select the statement transaction and click Match Transaction. In the Match Transaction window, select the transaction that you want to match and click Match.

    - **Add:** If you want to add the statement transaction to your company file, select it and click Add Transaction. The Spend Money window or the Receive Money window (depending on the type of transaction you are adding) appears. Enter the details of the transaction and record it.

11. When you have finished matching and adding all statement transactions, click Done. The Reconcile Accounts window appears.
12 Click Reconcile.
If your account is reconciled, you have the option of printing a confirmation report. If you don’t want to print the report, click Reconcile to finish.
If your account is out of balance, see ‘Reconciliation problems’ below.

Reconciliation problems

If you can’t reconcile because there’s an out of balance amount
1 Check the following:
- Did you type the correct figure in the Closing Statement Balance field? You need to type the closing balance from your bank statement, not the opening balance.
- Did you enter the correct date (that of the closing balance from your bank statement) in the Bank Statement Date field? An incorrect date may prevent some transactions from appearing in the list.
- Did you select all the transactions that appear on the bank statement? If not, some transactions might not have been accounted for in the reconciled balance.
- Did you select, by mistake, a transaction that didn’t appear on your bank statement? If yes, you need to deselect this transaction.
- Did you record all bank charges and bank interest entries that appear on the bank statement? If not, you need to record them and select them for reconciliation. See step 6 in ‘To manually reconcile an account’, on page 83.
2 Repeat the reconciliation procedure.
3 If your account is still out of balance, then you might have deleted a transaction that has been reconciled previously.
   If you have deleted a reconciled transaction, re-enter it and then select it in the Reconcile Accounts window when performing the reconciliation.

If there’s a problem with a period you’ve already reconciled

If you have reconciled a transaction in error or deleted a previously reconciled transaction, you can undo the previous account reconciliation. When you undo a reconciliation, all transactions for that period return to an unreconciled status.
If the error was made in a reconciliation earlier than your last reconciliation, you can undo several reconciliation periods in succession in your current financial year.
1 Go to the Banking command centre and click Reconcile Accounts. The Reconcile Accounts window appears.
2 In the Account field, enter the account for which you want to undo the reconciliation.
3 Click Undo Reconciliation. The Undo Last Reconciliation window appears, confirming the account and date of the reconciliation you are undoing.
4 Click Undo Reconciliation. A confirmation window appears.
5 Click OK. The Reconcile Accounts window reappears.
6 Sales

This chapter explains how to enter information about sales to your customers. You record a sale by specifying the customer’s details, the invoice layout (item, service, professional or miscellaneous), the type of the sale (quote or invoice) and the details of the items or services sold. The chapter also explains the various ways of sending an invoice, how to record customer payments, how to issue a customer credit, and how to analyse sales activities with a variety of reports and other analytical tools.

Creating a customer card

Before you can record a sale, you need to create a card for your customer.

To create a customer card

1. Go to the Card File command centre and click Cards List. The Cards List window appears.

2. Click New. The Card Information window appears.

3. Select Customer from the Card Type list.
Select the designation of the card: company or individual.

Type the customer name. If you use codes to identify customers, type the code for the customer in the Card ID field. For more information, see ‘Card identification codes’ on page 158.

Enter contact details for the customer. If you want to enter more contact information, select Address 2 from the Locations list and enter the additional details. You can enter contact details for five locations.

Click the Card Details tab. You can enter notes about the customer, insert a picture and assign attributes.

If you want to...

<table>
<thead>
<tr>
<th>Insert a picture</th>
<th>See page 159</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign identifiers to the card</td>
<td>See page 150</td>
</tr>
<tr>
<td>Assign an attribute from a custom list</td>
<td>See page 151</td>
</tr>
<tr>
<td>Enter additional information in a custom field</td>
<td>See page 158</td>
</tr>
</tbody>
</table>

Click the Selling Details tab and enter your selling details.

The selections you make here will be used, by default, on quotes and invoices that you create for this customer. You can override these selections when recording a sale.

The customer’s GST information is entered here. If the customer’s GST status takes precedence over that of the item or service being sold, select the Use Customer’s GST Code option. See ‘Setting up GST codes’ on page 106.

The credit terms entered here are used as the default terms for all sales to the customer, but can be changed at any time.

Click the Payment Details tab and select the method of payment your customer will use to pay you.

[Optional] Click the Jobs tab and enter the details of each job you have started or are about to start for the customer. For more information about jobs, see ‘Jobs’ on page 161.

[Optional] Click the History tab and type the dollar value of the sales made prior to your conversion month. You can also enter the date that the contact became a customer.

Click OK to save the card.
**Entering sales**

You enter a sale as a quote or invoice.

- A **quote** records an estimated price you have quoted to a customer. A quote can be changed to an invoice when your customer is ready to buy.
- An **invoice** is usually created when you deliver the items or services the customer ordered. Invoices can be open (unpaid), closed (paid) or credit (negative sale). An invoice can’t be changed to a quote.

You can enter a sale in:

- the **Sales** window
- the **Bank Register** window.

The procedure described in this chapter is for entering sales in the **Sales** window, which allows you to record full details about a transaction.

**Bank Register window** Entering a sale in the **Bank Register** window is a fast way to enter a sales transaction. However, you can enter less detail about the sale than if you entered it in the **Sales** window. For more information, see ‘Recording money you have spent and received’ on page 74.

**Entering a sales transaction**

Complete the following steps to enter a sales transaction:

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Enter information about the customer below</td>
</tr>
<tr>
<td>2</td>
<td>Choose the type of sale</td>
</tr>
<tr>
<td>3</td>
<td>Enter items or services you are selling</td>
</tr>
</tbody>
</table>

**Task 1: Enter information about the customer**

1. Go to the **Sales** command centre and click **Enter Sales**. The **Sales** window appears.
2. In the **Customer** field, enter the customer’s name and press **TAB**. The terms and ship-to address shown in the **Sales** window are the details recorded in the customer’s card.

**NOTE:** **Customer credit limits and accounts on hold** You may not be able to record sales for customers who have exceeded their credit limit or whose account has been placed on hold. For more information, see ‘Credit control’ on page 98.

3. Complete the fields as described in the following table.

   ![Diagram](chart.png)

   **A** Click the zoom arrow ( ) to alter the credit terms for this sale only. Note that if you want to change the credit terms for all future sales to this customer, you must make that change on the **Selling Details** tab of the customer’s card.
Task 2: Choose the type of sale

Choose the type and layout for the sale. The default layout displayed in the Sales window is determined by the selection you made when setting up sales details (using the Sales Easy Setup Assistant) or when creating the customer’s card.

1. If you want to, change the layout.
   - a. Click Layout. The Select Layout window appears.
   - b. Select the appropriate layout and click OK.

   **NOTE:** Miscellaneous layout The Miscellaneous layout is used only for sales where a form does not need to be printed or emailed.

2. Select the type from the Sales Type list in the top left corner: Quote or Invoice.

   **NOTE:** Recording customer orders You can track customer orders by entering the transaction as an invoice sale and entering the deposit paid by the customer in the Paid Today field. When you supply the item, record the customer’s payment as you normally would, using the Receive Payments window. For more information, see ‘Receiving payments’ on page 95.

Task 3: Enter items or services you are selling

The scrolling list in the middle of the Sales window is where you enter details of what you are selling. In this area you will enter item numbers, descriptions, account numbers (or account names) and other information to describe your transaction.

One row in the scrolling list is one line item of the transaction. You can enter as many line items for a sale as you want. The fields that appear in the scrolling list will depend on the sales layout you chose.

The following illustration shows the fields for a sale with an Item layout and an Invoice type.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship</td>
<td>Item Number</td>
<td>Description</td>
<td>Price</td>
<td>Disc%</td>
<td>Total</td>
<td>Job</td>
<td>GST</td>
</tr>
</tbody>
</table>

A Ship The quantity to be delivered.

B Item Number Enter an item from your item list.

C Description A description of the item appears automatically. You can change this if you want. If you want to check spelling in this field, click Spell. For more information, see ‘Spell-check’ on page 22.

D Price The price of the item appears automatically. You can change the price if you want.

E Disc\% [Optional] Type a volume discount as a percentage.

F Total The total price of the items is calculated automatically.

G Job [Optional] Select a job number here to assign a line item to a specific job.

H GST The default GST for an item appears here. If you want to change the GST code, enter the required GST code.
The following illustration shows the fields for a sale with a Service layout and an Invoice type. These fields also apply to the Professional and Miscellaneous layouts.

### Service sale

<table>
<thead>
<tr>
<th>A</th>
<th>Description</th>
<th>A description of the goods or services being sold. If you want to check spelling in this field, click Spell. For more information, see ‘Spell-check’ on page 22.</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Acct No. or Account Name</td>
<td>Enter the account to which to allocate the sale. This is usually an income account. You should not select your trade debtors account for ordinary sales.</td>
</tr>
<tr>
<td>C</td>
<td>Amount</td>
<td>The amount of the sale.</td>
</tr>
<tr>
<td>D</td>
<td>Job</td>
<td>[Optional] Select a job number here to assign a line item to a job.</td>
</tr>
<tr>
<td>E</td>
<td>GST</td>
<td>Select a GST code for the sale.</td>
</tr>
</tbody>
</table>

**NOTE:** Add lines, subtotals and headers to sales transactions You can add lines, headers and subtotals to invoices to make it easy to separate and subtotal different groups of line items on one invoice. For more information, see ‘Adding and deleting lines, headers and subtotals’ on page 92.

### Task 4: Enter additional information about the sale

The fields that appear at the bottom of the Sales window depend on the type of sale you are creating.

| A | Optional fields | Enter optional information, such as a comment, shipping method and the promised date of goods or services. |
| B | Invoice Delivery Status | If you want to print or email the invoice in a batch, select the required delivery method from the list. For more information, see ‘Sending forms’ on page 134. |
| C | Journal Memo | The journal memo is generated automatically. You can change it if you want. |
| D | Freight | Enter any charges for freight. |
| E | Freight GST | Enter the GST code for the freight charges. |
| F | GST | Click the zoom arrow ( ) if you want to view or change the GST amounts assigned to the sale. |
| G | Paid Today | Enter an amount here to indicate how much money the customer paid you at the time of the sale. |
| H | Payment Method | Enter the payment method. Click Details if you want to enter details about the payment. For example, if you are being paid by credit card, you can record the last four digits of the credit card number. |
Task 5: Complete the sale

There are several ways to complete the transaction.

**TIP:** Save the sale as a recurring sale  You can save the sale as a recurring transaction so you can use it again. Click Save as Recurring. In the Recurring Schedule Information window, enter the necessary information and click OK. For more information, see ‘Recurring transactions’ on page 120.

- If you want to record the sale without printing or sending it, click Record (for a sales quote, click Save Quote).
- If you want to record the sale and print, send or save it as a PDF, complete the relevant procedure below.

<table>
<thead>
<tr>
<th>To...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>• Click Print</td>
</tr>
<tr>
<td>Print preview</td>
<td>Click Print and choose Preview to preview the sales form for this transaction. Note that the transaction will be recorded before the form is displayed.</td>
</tr>
<tr>
<td>Email</td>
<td>Click Send To and choose Email. Review and make entries in the Email window and click Send. The email, which will include a PDF (Portable Document Format) attachment, will be sent to the outbox of your default email software. Send the email from your email software.</td>
</tr>
<tr>
<td>Save as PDF</td>
<td>Click Send To and choose Disk. In the window that appears, enter a name and location for the PDF file and click Save.</td>
</tr>
</tbody>
</table>

Adding and deleting lines, headers and subtotals

You can add blank lines, transaction lines, headers and subtotals to sales transactions.

**To insert a blank line**

A blank line can be left blank, or you can enter text that will appear on the printed form.

1. In the Sales window, click in the line below where the line is to appear.
2. Go to the Edit menu and choose Insert Blank Line.

**To insert a transaction line**

Add a transaction line if you need to enter more services or items than are allowed for on the screen.

1. In the Sales window, click in the line below where the transaction line is to appear.
2. Go to the Edit menu and choose Insert Transaction Line.

**To insert a header**

You can group several line items by inserting a header. For example you may want to separate ‘materials’ and ‘labour’.

1. In the Sales window, click in the line below where the header is to appear.
2. Go to the Edit menu and choose Insert Header. A blank line will appear in the scrolling list.
3. Type the text for the header in the Description column.
4. Press TAB to complete the header entry. The text appears in grey.
To insert a subtotal

1. In the Sales window, click in the first line below the items to be subtotalled.
2. Go to the Edit menu and choose Insert Subtotal. A line appears displaying the subtotal of the amounts that appear above the subtotal line and below the last subtotal, if there is one.

To delete a blank line, transaction line, header or subtotal

1. In the Sales window, click anywhere in the blank line, transaction line, header or subtotal you want to delete.
2. Go to the Edit menu and choose Delete Line.

Changing a sale’s type

If you have saved a quote for a customer, you can convert it to an invoice. Note that you cannot convert an invoice to a quote.

You can change a sale’s type from the Sales window or from the Sales Register window.

To change a quote to an invoice

1. Go to the Sales command centre and click Sales Register. The Sales Register window appears.
2. Click the Quotes tab and select the required quote.
3. Click Change to Invoice. The Sales window appears.
4. Make any necessary changes to these and other fields. For example, change the transaction date to today’s date.
5. Click Record. The new invoice is created. The original quote will remain in the Sales Register window unless you indicated in the Sales view of the Preferences window that you want quotes to be deleted once they are changed to invoices.
Reviewing your sales information

There are several tools that you can use to review your sales information.

<table>
<thead>
<tr>
<th>Tool</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Insights</td>
<td>Use Business Insights to analyse customer information.</td>
</tr>
<tr>
<td>To Do List</td>
<td>The To Do List displays all open sales, recurring sales sorted by overdue dates.</td>
</tr>
<tr>
<td>Sales reports</td>
<td>Sales reports help you keep track of your sales activities.</td>
</tr>
<tr>
<td>Sales history</td>
<td>History lets you view seven years of sales history for an item or a customer.</td>
</tr>
<tr>
<td>Sales Register</td>
<td>The Sales Register window gives you a complete picture of your sales activity—open and closed invoices, quotes, returns, credits etc.</td>
</tr>
<tr>
<td>Find Transactions</td>
<td>Find Transactions helps you find individual sales transactions.</td>
</tr>
<tr>
<td>Transaction Journal</td>
<td>The Transaction Journal lists journal entries of your sales and other transactions.</td>
</tr>
</tbody>
</table>

To analyse customer information using Business Insights

Business Insights presents a summary of your customer information, including which customers owe you money and how much money is overdue. You can also see how much your customers owe you for each ageing period, as well as the sales history of your customers.

To find information specific to your needs, sort the table columns by clicking a column heading. For example, you can sort the list of outstanding invoices to find the most overdue invoice or the largest overdue amount.

To analyse customers

1. Click Business Insights in any command centre. The Business Insights window appears.
2. Click the Customer Analysis tab. This tab shows you:
   - the total you are owed and details of each overdue customer payment (based on their invoiced credit terms), including the number of days overdue
   - your top ten customers by year-to-date sales value
   - the amounts owing for each ageing period
   - a summary of your customer sales and payment history.

   You can use this information to:
   - **Contact customers for overdue payments** Identify which customer payments are the most overdue or which customers owe you the most money.
   - **Renegotiate a customer’s credit terms** View the customer’s outstanding balances and payment history, such as the average number of days it takes for them to pay you.

3. If you want to use one of the graphs or tables in another document, right-click it and choose:
   - **Copy to Clipboard**. This copies the graph or table to the clipboard, ready to paste into a document.
   - **[Graphs only] Save As**. Choose where you want to save the image and click Save. This saves the graph as an image file, so you can use it later.

4. If you want to customise the look of Business Insights, click Customise. The Customise window appears, enabling you to show or hide information in Business Insights.
To view a list of all unpaid sales sorted by days overdue
1. Click To Do List in any command centre. The To Do List window appears.
2. Click the Accounts Receivable tab. A list of all unpaid sales appears. The Overdue column shows the number of days an invoice is overdue. (A negative number in the Overdue column indicates that the payment is not yet due.) The number of days an invoice is overdue is calculated by checking the original date of the invoice, comparing it to today’s date and looking at the customer’s credit terms.
3. If you want to send a collection letter to customers with overdue payments:
   a. Select those customers by clicking in the select column (☐).
   b. Click Mail Merge to create the letter directly in Microsoft Word. Otherwise, click Disk to save a mail merge file that you can use in another word processor.

To view sales reports
There are several sales reports that can help you track your sales activities. For example, you can run an Aged Receivables Summary report to view your customers’ current balances sorted by ageing periods. The Sales Item Summary report shows you which items are selling best. The Referral Source report is useful for finding out which referral source is bringing your business the most money.
1. Go to the Reports menu and choose Index to Reports. The Index to Reports window appears.
2. Click the Sales tab. A list of available sales report groups appears.
3. Click a group category to view the available reports.
For information on displaying, customising and printing your reports, see ‘Reports’ on page 125.

To view sales history
You can view sales history for an item or a customer.
1. Display the Item Information window for an item or the Card Information window for a customer or an employee.
2. Click the History tab. The History tab displays seven years of sales history for the item or card: the five years preceding the current financial year (as displayed in the Company Information window), the current financial year and the next year.

Receiving payments

When customers make payments against invoices, record them in the Receive Payments window. You can record the payments against one or more of the customer’s outstanding invoices.
You can also record payments in the Bank Register window. Recording customer payments through the Bank Register window can save you time if there are several invoices that have been paid and you do not need to record detailed information (such as discounts and finance charges) for each payment. When you use the Bank Register window to record a customer payment, the entire payment is automatically allocated to the customer’s oldest invoices first. For more information, see ‘Recording money you have spent and received’ on page 74.

If a payment you receive is not in response to an invoice you have issued, use the Receive Money window. See ‘Recording money you have spent and received’ on page 74.

NOTE: Customer payments at point of sale If customers make payments when purchasing merchandise or services and you are issuing them an invoice, you can type the payment amount in the Paid Today field.
of the invoice. See ‘Enter additional information about the sale’ on page 91.

The options for recording receipts and invoice payments are summarised in the following diagram.

To record payments against invoices

1. Go to the Sales command centre and click Receive Payments. The Receive Payments window appears.
2. Choose the account that will be used to record the customer payment.
   - Deposit to Account. Select this option if the customer has made a direct payment to your bank account.
   - Group with Undeposited Funds. Select this option if the payment will be deposited at a later time. For information about undeposited funds and preparing bank deposits, see ‘Approving a bank feed’ on page 68.
3. In the Customer field, enter the customer’s name.
4. Type the amount received.
5. If you want to record the payment method, select the method in the Payment Method field. Click Details if you want to enter further details about the payment. For example, if you are being paid by credit card, you can record the last four digits of the credit card number.
6. If you want, adjust the memo and payment date. You can change the ID number that is automatically generated. However, we recommend that you use the default number to make sure you don’t use duplicate IDs.
In the scrolling list in the bottom half of the window, indicate which sales are covered by the payment by entering amounts in the Amount Applied column.

If a customer overpays, you should still enter the amount received. The full payment should be entered in the Amount Received field and in the Amount Applied column in the scrolling list. When you record the payment, a credit invoice for the overpaid amount is created automatically. This can either be refunded to the customer or applied to a future invoice. For more information, see ‘Settling credits’ on page 102.

Click Record.
Printing payment receipts

For each receipt transaction you record, a corresponding receipt can be printed. Receipt transactions can be recorded using the following windows:
- Bank Register
- Receive Money
- Receive Payments
- Sales (New Invoice)
- Settle Returns & Debits (Receive Refund view).

Receipt transactions for which receipts cannot be printed are:
- reversed receipt transactions
- voided receipts
- bank transactions such as bank deposits or interest earned.

Payment receipts correspond directly to receipt transactions. That is, when you record a receipt transaction, the information you entered on the transaction can be printed on a payment receipt. Because of this relationship, if you change, reverse or remove a receipt transaction, the payment receipts that have been printed may no longer be valid.

To print payment receipts

1. Go to either the Sales or Banking command centre and click Print Receipts. The Review Receipts Before Printing window appears.
2. If you print receipts on pre-printed stationery, type the number of the first receipt in the Number of First Receipt in Printer field. The IDs of the recorded receipts will be renumbered to match the printed receipts.
3. Type the number of copies you want to print of each receipt in the Print field.
4. If you want to filter the list of receipts, click, click Advanced Filters. For more information, see ‘Customising how you send form batches’ on page 136.
5. Click in the select column ( ) next to each receipt you want to print.
6. Click Print.

For more information about customising your forms, see ‘Forms’ on page 133.

Credit control

You can control credit by:
- setting and enforcing customer credit limits, see ‘Credit limits’ on page 99
- placing customer accounts on hold, see ‘Credit holds’ on page 99

- adding finance charges to customer statements, see ‘Finance charges paid by customers’ on page 99.
Credit limits

A credit limit is the maximum amount of credit you allow a customer to charge to their account. You can set a default credit limit for all new customers (see ‘Set up sales’ on page 42) or set a specific credit limit for a single customer.

To set or change the credit limit for a single customer
1. Open the customer card you are setting the credit limit for.
2. Click the Selling Details tab.
3. Click Credit Limit & Hold. The Credit Limit & Hold window appears.
4. Type the customer’s credit limit in the Credit Limit field.
5. Click OK. The Card Information window appears.
6. Click OK to return to the Cards List window.

Credit holds

You can place a credit hold on a customer’s account to prevent further sales being made to the customer. For example, you may want to place a customer on credit hold when the customer’s account is overdue.

To place a customer on credit hold
1. Open the customer card you are placing on credit hold.
2. Click the Selling Details tab.
3. Click Credit Limit & Hold. The Credit Limit & Hold window appears.
4. Select the Place this customer on Credit Hold option.
5. Click OK. The Card Information window appears.
6. Click OK to return to the Cards List window.

Finance charges paid by customers

Finance charges are amounts added to an outstanding balance as a penalty for late payment. They are usually added to a customer’s statement. When the charge is paid by the customer, the payment is recorded in the Receive Payments window.

How finance charges are calculated  Each open invoice’s due date is calculated using the terms specified on the Selling Details tab of the Card Information window. The overdue balance is then increased by
1/30th of the monthly charge for late payment for every day it is overdue, where the monthly charge is calculated by multiplying the amount overdue by the % Monthly Charge for Late Payment value you specified on the customer’s card.

If the customer makes a partial payment during the overdue period, the finance charge is adjusted accordingly.

Setting up finance charges Before you can apply finance charges, you need to select an account for tracking late-payment charges. Go to the Setup menu, choose Linked Accounts and then Sales Accounts. Select the I assess charges for late payment option and select an income account to record the late payment charges.

Set the percentage you will be charging for late payments in the % Monthly Charge for Late Payment field of the Selling Details tab of each customer card.

Adding finance charges to customer statements
To show the finance charge owed by customers on their statements, you need to select an option when printing or emailing the statements.

1. Go to the Sales command centre and click Print/Email Statements. The Review Statements Before Delivery window appears.
2. Click Advanced Filters and select the Add Finance Charges to Amount Due option.

Customer credits

A customer credit is money that you owe to a customer.

To process a customer credit, you first need to record a credit transaction and then record the settlement of the credit (for example, by printing a refund cheque for your customer).

Recording credits

You can create a customer credit note in the following ways:

- Reverse an existing sale. Use this method if the customer has paid for the entire sale.
- Manually create a credit. Use this method if you are crediting the customer for part of a sale.
To reverse a sale

Before you can reverse an invoice, the transaction must be unchangeable, that is, the Transactions CAN'T be Changed; They Must Be Reversed option must be selected in the Security tab of the Preferences window.

1. Find and open the invoice. See ‘Finding a transaction’ on page 115.
2. Go to the Edit menu and choose Reverse Sale. A credit note transaction appears in the Sales window. Note that the invoice amount is a negative amount.
3. If you want, you can make some changes to the credit note (such as changing the date and memo), but you can’t change the accounts, amounts and quantities that are associated with the credit.
4. Click Record Reversal. A customer credit appears in the Sales Register window.

To manually create a credit for a non-item sale

Use this method to credit the customer for part of a non-item sale.

TIP: Create an account for tracking sales returns Before you manually create a credit of this type for the first time, you may want to create an account for tracking sales returns and allowances. Make sure this account is an income account.

1. Go to the Sales command centre and click Enter Sales. The Sales window appears.
2. Enter the customer details.
3. Select Invoice from the list in the top left corner of the window.
4. Click Layout, choose Service and click OK.
5. In the Description column, enter a description of the credit for your records.
6. In the Account column, select the account to be credited. This is the income account you use to track sales returns and allowances.

7. In the Amount field, type the amount of the credit as a negative amount.

8. Click Record. A credit appears in the Sales Register window.

To manually create a credit for an item sale

Use this method to credit the customer for part of an item sale.

1. Go to the Sales command centre and click Enter Sales. The Sales window appears.
2. Enter the customer details.
3. Select Invoice from the list in the top left corner of the window.
4. Click Layout and choose Item, then click OK.
5. In the Ship column, type the number of items being returned as a negative number.
In the Item Number field, enter the item number. The costs of the items appear as negative amounts.

3. Locate and select the credit you want to apply and click Apply to Sale. The Settle Returns & Credits window appears, listing all open invoices assigned to the customer.

4. Enter the amounts you want to apply to one or more open invoices in the Amount Applied column.

Click Record. A credit appears in the Sales Register window.

Settling credits

You can choose to settle a customer credit in the following ways:

- **Apply the credit to an open invoice.** Applying the credit to one or more of the customer’s open invoices reduces the amount the customer owes you.
- **Record a refund.** If the customer does not have any open invoices, you can record a refund payment for the amount of the customer credit.

To apply a customer credit to an open invoice

1. Go to the Sales command centre and click Sales Register. The Sales Register window appears.
2. Click the Returns & Credits tab. A list of credits appears.

If the Apply Customer Payments Automatically to Oldest Invoice First preference is set, amounts will appear next to the oldest invoices in the Amount Applied column. However, you can apply the credit amount to any one transaction or you can divide it among many transactions in the list. Note that the total amount you apply in the Amount Applied column must equal the amount that appears in the Credit Amount field.

5. If you want to apply part of a customer credit to any unpaid finance charge, enter an amount in the Finance Charge field.
6. Click Record to apply the credit.

To pay a refund cheque

1. Go to the Sales command centre and click Sales Register. The Sales Register window appears.
2. Click the Returns & Credits tab. A list of customer credits appears.
3 Locate and select the credit you want to refund and click Pay Refund. A refund cheque for the amount of the credit appears in the Settle Returns & Credits window.

4 In the Account field, enter the bank account you are making the payment from.

Accounting for bad debts

When you know that a debt will not be recovered, you need to write it off. Before you can write off a bad debt, create a ‘Bad Debt’ expense account in your accounts list or, if you account for bad debts by posting a provision to an asset account, create a ‘Provision for Bad Debts’ asset account.

To write off a bad debt
1 Go to the Sales command centre and click Enter Sales. The Sales window appears.
2 Enter the customer’s details.
3 Click Layout, choose Miscellaneous, and then click OK.

4 In the Description field, type a description of the transaction.
5 In the Acct No. field, enter the expense account for Bad Debts or the Provision for Bad Debts asset account.
6 In the Amount field, type the bad debt amount as a negative number.
7 In the GST field, enter the required GST code.
8 Click Record.
9 In the Settle Returns & Credits window, apply the credit against the original open invoice. To do this, see ‘Settling credits’ on page 102.
Lists

Your company file has lists for different types of records—customers, accounts, GST codes, recurring transactions and so on. This chapter explains how to add records to lists, and how to inactivate or delete them.

Adding a record

Lists are made up of individual records. For example, each item in your Items List is a record, as is each job in your Jobs List. You can add as many records as you want to a list.

### To add this type of record...  
<table>
<thead>
<tr>
<th></th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>page 30</td>
</tr>
<tr>
<td>Card</td>
<td></td>
</tr>
<tr>
<td>• Customer</td>
<td>page 87</td>
</tr>
<tr>
<td>• Supplier</td>
<td>page 145</td>
</tr>
<tr>
<td>• Employee</td>
<td>page 145</td>
</tr>
<tr>
<td>• Personal</td>
<td>page 145</td>
</tr>
<tr>
<td>Item</td>
<td>page 51</td>
</tr>
<tr>
<td>GST code</td>
<td>page 106</td>
</tr>
<tr>
<td>Recurring transaction</td>
<td>page 120</td>
</tr>
<tr>
<td>Job</td>
<td>page 161</td>
</tr>
</tbody>
</table>

Adding records when entering transactions

You can create new records easily from any transaction window. For example, you can add accounts, cards, comments, custom list items, jobs, referral sources, shipping methods and more to your lists when entering transactions.

To create a record in a transaction window

Let’s assume you want to add a customer card while entering a sale.

1. In the Sales command centre, click Enter Sales. The Sales window appears.
2. In the Customer field, type the customer’s name and press Tab. If there is no card for this customer, a drop-down list appears.
3 Do one of the following:
   - To create a detailed new record, click **New**. The **Card Information** window appears, where you can enter the details of the new customer.
   - To create a quick record to complete later, click **Easy-Add**. A new card is added to your cards list, using just the customer name you entered in the **Customer** field. You can go back and add details to the card later.

**NOTE:** Easy-Add is not available from some transaction windows. In windows such as **Spend Money**, the type of card you want to create is not immediately obvious, so the Easy-Add button is not available.

---

# Setting up GST codes

GST codes are used to track GST paid to or by your business. Each GST code represents a particular type of GST.

AccountRight has an extensive list of GST codes that can be used in a variety of situations—for example, when doing business with overseas customers, when tracking capital acquisitions, and so on.

**To create a GST code**

1. Go to the **Lists** menu and choose **GST Codes**. The **GST Code List** window appears.
2. Click **New**. The **GST Code Information** window appears.
3. In the **GST Code** field, type a code (up to three characters) for the new GST code and press **Tab**.
4. Complete the other fields in this window.

---

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Enter a description, type and rate.</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>If the GST code is zero-rated, select the <strong>GST Code is Reported on GST Return</strong> option. Deselect this option for exempt GST codes.</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Select the linked account for GST collected and for GST paid. These fields are only available for some GST types. Select a card, if applicable.</td>
<td></td>
</tr>
</tbody>
</table>
To assign GST codes to accounts

You can assign a GST code to any detail account in your accounts list. The GST code you assign will appear as the default GST code when you post a transaction to this account.

For example, you have assigned the standard code (S15) to your electricity expense account. When you settle your electricity bill in the Spend Money window and allocate it to this account, the standard code will appear in this window by default.

You can allocate a GST code to an account in the Account Information window. To open this window, go to the Accounts command centre, click Accounts List, double-click the required account, and click the Details tab.

To assign GST codes to items

When you set up your items, you must assign a GST code to each of them.

You need to assign a GST code to be used when you sell an item. That GST code will appear as the default in sales of that item unless you have specified that the customer’s GST code is to be used instead (see below).

GST codes are assigned to items in the Profile tab of the Item Information window. For more information, see ‘Create item records’ on page 51.

To assign GST codes to cards

You can define a default GST code for a customer. You only need to select a default GST code if the customer’s GST status takes precedence over that of the item or service being sold.

For example, if a customer is one to whom you only ever make zero-rated export sales, you should assign the zero-rated GST code (Z) to that customer’s card.

When you create a quote, order or invoice, the GST code assigned to the customer will be used as the default. This GST code will override the item’s GST code in an item sale, and the allocation account’s GST code in a non-item sale.

GST codes are assigned to customers in the Selling Details tab of their Card Information window.

Make sure you select the Use Customer’s GST Code option. (If this option is not selected, the customer’s GST code will not be used, even if one has been assigned.)
Finding a record

Records are stored and displayed in lists. For example, the Jobs List window lists the jobs you have created, the Accounts List window lists your accounts, and so on. As lists get long, it can take time to locate a record. Use the following tools to find a record quickly.

**Tabs** Some lists are divided into separate views using tabs. For instance, the accounts List is divided by account type into nine tabs, making it easier for you to find an account. For example, if you are looking for an asset account, click the Asset tab. Within the tab you can use the scroll bar to find the record.

<table>
<thead>
<tr>
<th>All Accounts</th>
<th>Asset</th>
<th>Liability</th>
<th>Equity</th>
<th>Income</th>
<th>Cost Of Sales</th>
<th>Expense</th>
<th>Other In</th>
</tr>
</thead>
</table>

**Search fields** You can filter lists using the search field. To do this, click the column heading by which you want to search (for example, by code or name), then type your search terms in the Search field (Search). The list is updated as you type to display all records that contain your search terms for the selected column.

To reset the list, delete the text you entered in the search field or click the X (Clear) icon.

**Advanced search filters** In some list windows, you can use advanced search filters to narrow down your record search. To do this, click Advanced. Enter the relevant filters and click OK. The window will display only those records that meet your search criteria.

**Inactive records are hidden by default** In some list windows there is an option to Show Inactive records. Select this option to show all records, including inactive ones.
Changing a record

You can make changes to:

- accounts
- cards
- items
- jobs
- GST codes.

Changing a record that has been used in a transaction  If you change the details of a record that does not affect a transaction’s balance (for example, changing a customer name), then all the transactions you’ve entered using that record are updated.

If you make changes to a record that do affect a transaction’s balance (such as an item’s selling price or the rate of a GST code) transactions you’ve entered previously using that record are not updated.

Inactivating or reactivating a record

If you have accounts, cards, items or jobs that you rarely use—for example, a card you created for a one-off sale—inactivating them after use will remove them from selection lists. Your list of records will be shorter and, consequently, selecting the record you need will be easier. You can still use an inactive record in transactions by manually entering the record name.

To inactivate (or reactivate) a record

1. Display the list to which the record belongs. For example, if you are making changes to an account, display the Accounts List window; if you are changing an item, display the Items List window and so on.
2. Locate the record you want to inactivate (or reactivate) and click the zoom arrow ( ) next to it. The record’s details appear.
3. If you are inactivating or reactivating a card, account or item, click the Profile tab.
4. Select (or deselect) the Inactive [...] option.
Deleting a record

You can delete a record that you no longer need. However, a record cannot be deleted if it is used in a transaction, has been selected in another record, or if it has a balance.

**NOTE:** Deleting accounts and jobs You can only delete an account or a job if it has never been used in a transaction. If the account or job has been used, you will not be able to delete it, even after deleting the transaction. As an alternative, you can choose to make the account or job inactive. See ‘Inactivating or reactivating a record’ on page 109 for more information. For accounts, you can choose to combine the account you no longer require with another account to remove it from the Accounts List. See ‘Combining records’ below for more information.

Combining records

In some situations you may want to combine two records. For example, you may have records in your cards list for two suppliers who have merged their operations. Or you may have separate accounts for two departments whose sales figures you now want to combine.

When you combine two records, you identify one as the primary record and the other as the secondary record. The primary record becomes the owner of all the transaction details (transactions, jobs, history, and so on) currently linked to the secondary record and the secondary record is deleted.

**NOTE:** Historical reports When you view historical reports from the previous financial year (for instance, the previous financial year’s balance sheet), the primary account is listed showing the combined account balance.

To delete a record

1. Go to the Lists menu and choose the list to which the record belongs. For example, if you are deleting an item, choose Items; if you are deleting a card, choose Cards, and so on.
2. Locate the record you want to delete and click the zoom arrow (🔍) next to it. The record details appear in the Information window.
3. Go to the Edit menu and choose Delete [...]. For example, if you are deleting a customer card, choose Delete Card.

Combining cards

You can combine:
- customer cards
- supplier cards
- personal cards.

You cannot combine:
- employee cards
- cards with a different type
- cards where the primary card is inactive.

When cards are combined, the non-transaction card information for the primary card—such as card name, address and buying and selling details—is retained as the default information for the combined card.
The transaction details for the secondary card are added to the primary card. Non-transaction information for the secondary card is deleted.

**To combine two cards**

1. Go to the **Card File** command centre and click **Cards List**. The **Cards List** window appears.
2. Select the primary card.
3. Click **Combine Cards**. The **Combine Cards** window appears.

The primary card appears under the **Primary - Move all transactions to list**. If you want, you can choose another primary card from the list.

4. Select the secondary card from the **Secondary - Remove all transactions from list**.

**CAUTION:** The next action cannot be undone Before continuing, check that you’ve selected the correct cards to be combined. If you combine the wrong cards, you will have to restore them from a backup and re-enter transactions posted to those cards since the backup.

5. Click **Combine Cards**. A confirmation window appears.
6. Click **OK** to confirm you want to combine the two cards.

**Combining accounts**

You can only combine accounts that are:
- accounts of the same account type (for example, asset and expense accounts cannot be combined) and
- detail accounts.

You cannot combine:
- header accounts
- accounts that are linked to other accounts
- accounts that are associated with bank feeds.

When accounts are combined, the non-transaction account information for the primary account—such as account name, description and bank details (for banking accounts)—is retained as the default information for the combined account. The transaction details and opening balance of the secondary account are added to the primary account. Non-transaction information for the secondary account is deleted.

**NOTE:** Budgets and job budgets not combined. Budgets and job budgets for the secondary account are not added to the budgets and job budgets of the primary account. You will have to revise the budgets and job budgets of the primary account after combining them.

**To combine two accounts**

1. Go to the **Accounts** command centre and click **Accounts List**. The **Accounts List** window appears.
2 Select the primary account. This is the account that the secondary account transaction history and opening balance will be transferred to.

3 Click **Combine Accounts**. The **Combine Accounts** window appears.

4 Select the secondary account from the **Secondary - Remove all transactions from list**.

**CAUTION:** The next action cannot be undone. Before continuing, check that you’ve selected the correct accounts to be combined. If you combine the wrong accounts, you will have to restore from a backup and re-enter transactions posted to the accounts since the backup.

5 Click **Combine Accounts**. A confirmation window appears.

6 Click **OK** to confirm you want to combine the two accounts.

---

**Customising item records**

Custom lists and fields enable you to record additional information about your items and cards. This information allows you to customise the way you view and sort card and item records in reports and lists.

This section describes how to create custom lists and fields for your items. For information about creating custom lists and fields for cards, see ‘Grouping your contacts’ on page 150 and ‘Customising cards’ on page 158.

**Customising items**

Your AccountRight software provides a number of item customisation features:

- **Custom fields** You can ensure that certain information is always recorded for an item, such as Warranty, Serial Number and Voltage. Use these fields for information that you don’t need to use as report filters.

  For information about creating custom fields, see ‘Creating custom item fields’ on page 114.

- **Custom lists** You can use custom lists to sort and group your inventory items. You can then run reports based on the custom lists. For example, if you are running a trailer-rental business, you might have custom lists of Colour, Type and Location. This means you could run a report to include only blue cage trailers at the Main Street station.

  For information about creating custom lists, see ‘Creating custom item lists’ on page 113.
Creating custom item lists

You can use custom lists to sort and group your items.
An example of a custom list is Colour, in which you create list entries of yellow, red, green and blue. When you create or edit your items, you can assign them one of these colours. When you run an inventory report, such as the Items List Summary report, you can choose to include only red items in the report.

You can create up to three custom lists.

To name a custom list

1. Go to the Lists menu, choose Custom Lists & Field Names, and then click Items. The Custom List and Field Names window appears.
2. Enter names for each of the three custom lists in the appropriate fields and click OK.

These list names will now appear on the Items Details tab of the Item Information window.

To create custom list entries

1. Go to the Lists menu, choose Custom Lists, and then click Items. The Custom Lists window appears.
2. Select the custom list for which you want to make entries in the Custom List field.
3. Click New. The Custom List Information window appears. Type the name of the list entry. For example, if you have a colour list, you would enter a colour, such as Purple.
4. Click OK. The Custom Lists window reappears showing the list entry.
5. Repeat from step 3 until you have created all your list entries.
6. Click Close to close the Custom Lists window.

To assign a custom list entry to an item

1. Go to the Lists menu and choose Items. The Items List window appears.
2. Click the zoom arrow ( ) to the left of the item. The Item Information window appears.
3. Click the Item Details tab.
4. Select the list entry you require from the appropriate custom list.
5. Click OK.
Custom lists and item reports

You can use your custom lists as report filters. For example, you can generate a report to include only those items with a certain list entry, such as the colour red. For more information on setting report filters, see ‘Filtering and sorting data in a report’ on page 127.

**Printing custom list entries on invoices**  You can customise your invoices to include custom lists. For more information see ‘Customising forms’ on page 137.

Creating custom item fields

Custom fields can be used to record additional information about your items. Examples of custom fields are Warranty, ID No. and Manufacturer. However, unlike custom lists, custom fields cannot be used to filter item reports.

You can create up to three custom fields.

**To name a custom field**

1. Go to the Lists menu and choose Custom Lists & Field Names, and then click Items. The Custom List and Field Names window appears.

2. In the Name of Custom Field fields, type the field names and click OK.

These field names will appear on the Item Details tab of the Item Information window for all items.

**Printing custom field entries on invoices**  You can customise your invoices to include custom fields. For more information on customising forms, see ‘Customising forms’ on page 137.
8 Transactions

You create a transaction when you record entries such as sales invoices and cheques.
You can change, delete or reverse transactions—depending on how your preferences are set up.
If you have transactions that need to be entered periodically, you can set up recurring transactions. You can use these recurring transactions to store details of transactions you record regularly and to set up reminders to record them. You can also choose to record recurring transactions automatically on their due date.

Finding a transaction

There are several ways to find a transaction. The method you use depends on the information you have at hand.

<table>
<thead>
<tr>
<th>Use the...</th>
<th>To find...</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Transactions window</td>
<td>journal entries, sales, cheques, deposits and customer payments.</td>
<td>page 116</td>
</tr>
<tr>
<td>Sales Register</td>
<td>transactions relating to sales (such as open and closed invoices), quotes, credits and returns. This method is most useful if you know the transaction date or the customer’s name.</td>
<td>page 116</td>
</tr>
<tr>
<td>Bank Register</td>
<td>Spend Money, Receive Payments and Receive Money transactions.</td>
<td>page 116</td>
</tr>
<tr>
<td>Recurring Transactions List window</td>
<td>recurring transactions. You can sort transactions by name, type, or frequency, or search for a transaction by name, amount, or next due.</td>
<td>page 117</td>
</tr>
</tbody>
</table>
To find a transaction using the Find Transactions window

1. From any command centre, click **Find Transactions**.
2. In the **Find Transactions** window, click the appropriate tab—for example, the **Card** tab to search by card.
3. Filter your search using the **Search By** and date range fields.
4. If you want to narrow your search further:
   a. Click **Advanced**. The **Advanced Filters** window appears.
   b. Type or select the additional search filters, and click **OK**.

The transactions that match your search criteria appear in the **Find Transactions** window. You can view a transaction in detail by clicking the zoom arrow ( ) next to it.

To find a transaction using the Sales Register window

1. Go to the **Sales** command centre and click **Sales Register**. The **Sales Register** window appears.
2. Click the tab of the sales category you would like to view—for example, **Open Invoices**.
3. [Optional] Filter your search using the **Search by** and date range fields.
4. In the **Dated From** and **To** fields, enter the date range during which the transaction was recorded. The transactions that match your search criteria appear in the **Bank Register** window.
5. If you want to view a transaction in detail, click the zoom arrow ( ) next to the transaction.

To find a transaction using the Bank Register window

You can use the **Bank Register** window to find Spend Money, Receive Payments and Receive Money transactions.

1. Go to the **Banking** command centre and click **Bank Register**. The **Bank Register** window appears.
2. Type or select the bank, credit card or petty cash account you used for the transaction in the **Account** field.
3. In the **Dated From** and **To** fields, enter the date range during which the transaction was recorded. The transactions that match your search criteria appear in the **Bank Register** window.
4. If you want to view a transaction in detail, click the zoom arrow ( ) next to the transaction.

To find a transaction using the Transaction Journal window

1. Click **Transaction Journal** from any command centre. The **Transaction Journal** window appears.
Changing or deleting a transaction

If you are part way through entering a transaction, you can erase it and start again by choosing Erase from the Edit menu.

Sometimes, however, you may need to make changes to or delete a transaction you have already recorded. A transaction can only be changed or deleted:

- if it is changeable. A changeable transaction is identified by a blue zoom arrow ( ⬅️ ) next to it.

To check if your transactions are changeable, make sure the Transactions CAN’T be Changed; They Must be Reversed option is deselected in the Security view of the Preferences window. Note that when you create your company file, this preference is not selected.

If you want to maintain a strict audit trail, you should consider making your transactions unchangeable by setting this preference.

To find a recurring transaction

1. Go to the Lists menu and choose Recurring Transactions. The Recurring Transactions List window appears.

2. Locate the recurring transaction. You can:
   - sort the transactions by name, type or frequency
   - search for a transaction by name, amount or due date.

For more information on changing the details of a recurring transaction, see ‘Recurring transactions’ on page 120.

2  Click the appropriate tab—for example, the Sales tab to find a sales invoice, the Disbursements tab to find a payment and so on.

3  In the Dated From and To fields, enter the date range within which the transaction was recorded. All transactions between (and occurring on) these dates will be listed.

4  If you want to search for a range of journal ID numbers, enter the range in the ID From and To fields. All transactions with IDs between (and matching) these numbers will be listed.

5  To open the transaction in its original window, click the zoom arrow ( ⬅️ ) to the left of the journal entry.
An unchangeable transaction is identified by a grey zoom arrow (🔍) next to it.

■ if it is not dated within a locked period.

Lock periods prevent you from inadvertently making an entry in a period in which you don’t want new entries. For example, after you have completed end-of-month reports for January, you might lock the period so that the balances for that month cannot be changed. If you want to change a transaction in a locked period, you need to unlock the period first.

Changing a transaction

Before changing a transaction, note the following:

Some transactions cannot be changed You cannot change a refund cheque or a bank deposit once it has been recorded. You can only delete or reverse these transactions. For more information, see ‘Reversing a transaction’ on page 119.

Some fields cannot be edited If you are changing a Receive Payments transaction, only the Account, Date, Memo and transaction ID fields can be edited. You cannot change the transaction amount.

To change a transaction

1 Find and display the transaction in its original transaction window. For more information, see ‘Finding a transaction’ on page 115.
2 Make the necessary changes to the transaction and then click OK.

Deleting a transaction

When you delete a transaction, it is permanently removed from your records. Note the following when deleting a transaction:

Sales You can only delete a sale that does not have a payment applied to it. If you have recorded a payment for a sale, you must first delete the payment and then delete the transaction. Any discounts that have been given must also be deleted before the transaction can be deleted.

If you applied a credit note towards a sale, you must delete the credit before you can delete the sale.

Grouped receipts that have been deposited If you want to delete an individual receipt that was recorded as part of a bank deposit of receipts grouped in the undeposited funds account, you must first delete the bank deposit. When you delete a bank deposit, all of the cash receipts included in the bank deposit are returned to the Prepare Bank Deposit window. You can then delete the required receipt from this window.

Reconciled transactions If you delete a reconciled transaction, your bank reconciliation will be out of balance. If you want to reverse a reconciled transaction, you need to undo the bank reconciliation first, then reverse the entry and re-reconcile the account. See ‘Reconciling your bank accounts’, on page 82.

GST reporting If you delete a transaction from a prior GST reporting period, your GST reported for that period may be affected.

To delete a transaction

1 Find and display the transaction in its original transaction window. For more information, see ‘Finding a transaction’ on page 115.
2 Go to the Edit menu and choose Delete […]. For example, if you want to delete a sale, choose Delete Sale. The transaction will be removed permanently from your records.
Reversing a transaction

If your accountant wants you to maintain a strict record of all your accounting entries, you should reverse a transaction rather than change or delete it.

A reversal transaction is a new transaction that replicates the original transaction, but with debit amounts shown as credit amounts and vice versa. After posting a reversal transaction, you have two transactions (the original and the reversal), but the account balances appear as if the original transaction was never posted.

A reversal transaction is automatically posted to the same account for the same amount as the original transaction. You cannot change the amount or account of a reversal transaction.

Before you can reverse a transaction  You can only reverse a transaction if it is unchangeable. An unchangeable transaction is identified by a grey zoom arrow (enting after it. To make your transactions unchangeable, select the Transactions CAN’T be Changed; They Must be Reversed option on the Security tab view of the Preferences window. You can change this option at any time.

Reversing a transaction can affect closed periods  When you reverse a transaction, be aware of the transaction date you enter:

- If you use the current date when you reverse a transaction from a prior month, the month-end financials for the prior month will not reflect the reversal transaction.
- If you use the original date for the reversal transaction, your prior month’s financials should be reprinted because they will have changed.
- If the original transaction date falls in a prior GST period, recording the transaction on the original date may affect the GST reportable in that period.

Customer payments  If an early payment discount was applied to a sale, you also need to reverse the credit created for the discount. For information about how to find a transaction, see ‘Finding a transaction’ on page 115.

To reverse a transaction

1  Find the transaction you want to reverse. See ‘Finding a transaction’ on page 115 for instructions.

2  Go to the Edit menu and choose Reverse […] For example, if you want to reverse a sale, choose Reverse Sale. A new transaction containing corresponding negative amounts to that of the original transaction appears.

3  If you want, alter the date and memo. Note that you can’t change the accounts and amounts

TIP: Recap transaction  Before you record this transaction, you can use the recap transaction feature to view the journal entries that will be created when the transaction is recorded. To recap, choose Recap Transaction from the Edit menu.

4  Click Record Reversal to record the reversal transaction. The transaction is reversed and all account balances are returned to their previous levels.
Recurring transactions

If you have a transaction that you record regularly—for example, a rent cheque—you can set them up as recurring transactions and save them for future use.

When you save a recurring transaction, you can specify how often you want the transaction to be recorded, and for how long you want to schedule it. For example, you can schedule your car payments monthly, for the next 22 months.

If the transaction details are the same each time—such as a rent payment, you can set up a recurring transaction to record automatically. Or you can open the transaction as required, alter the details (for example, if you make regular sales to a customer and vary the items), and then record the transaction.

You can make the following transactions recurring: sales, Spend Money, Receive Money, and general journal entries.

Setting up recurring transactions

You can create a recurring transaction in a transaction window, or copy an existing recurring transaction to create a new one. Later on, you can change details of a recurring transaction, or delete one if it is no longer used.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>see</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a recurring transaction</td>
<td>below</td>
</tr>
<tr>
<td>Create a recurring transaction from an existing entry</td>
<td>page 122</td>
</tr>
<tr>
<td>Edit a recurring transaction</td>
<td>page 122</td>
</tr>
<tr>
<td>Delete a recurring transaction</td>
<td>page 123</td>
</tr>
<tr>
<td>Record a recurring transaction from a transaction window</td>
<td>page 123</td>
</tr>
<tr>
<td>Record multiple recurring transactions</td>
<td>page 123</td>
</tr>
</tbody>
</table>

To create a recurring transaction

When you create a recurring transaction, you can select how often you want the transaction to be recorded, and for how long you want to schedule it. For example, you can schedule your car payments monthly, for the next 22 months.

1. Enter the transaction details in a transaction window—such as the Sales window—if you make regular sales to a customer.
2. Click Save as Recurring (instead of clicking Record). The Recurring Schedule Information window appears.
3. In the Recurring Transaction Name field, type a name to identify the transaction.
Schedule the transaction

4 From the Frequency list select the transaction frequency.

**TIP:** Recurring transaction reports If you specify the frequency and a reminder date for the transaction, you can use the Recurring Transactions reports to keep track of the transactions you need to enter.

5 In the Starting on field, type or select the date the transaction is first due.

**NOTE:** Pre-dated recurring transactions You can save a recurring transaction with a start date prior to the system date, provided the date entered is within the current financial year and is not in a locked period.

6 Indicate how long you want the recurring transaction to continue.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>schedule the transaction for an unlimited period</td>
<td>Select Continue indefinitely.</td>
</tr>
<tr>
<td>schedule the transaction until a set date</td>
<td>Select Continue until this date and type the date in the adjacent field.</td>
</tr>
<tr>
<td>schedule the transaction for a set number of times</td>
<td>Select Perform this # of times and type the number of times in the adjacent field.</td>
</tr>
</tbody>
</table>

Specify an alert option

7 In the Alerts section of the window, you can set a reminder to record the transaction, or set for an automatic recording of the transaction and receiving a notification when the transaction is recorded.

**NOTE:** Pre-dated recurring transactions cannot be recorded automatically If you entered a pre-dated recurring transaction and you set a reminder date, the transaction will display as overdue on the To Do List. Pre-dated recurring transactions cannot be set to be recorded automatically.

8 In the Transaction section, select how you want the transaction ID number to be created:

- If you want the transaction ID number to be one greater than the previous transaction ID, click Use the next sequential number as the [...] No.
- If you want to use a specific transaction ID, click Use the following as the [...] No, then type the transaction ID in the adjacent field.

9 If you want to save your changes to the recurring transaction each time it is recorded, select the Save my changes when I record this recurring transaction option.

10 Click OK. The transaction window appears.

11 Click Record to record the transaction showing or click Cancel to close the transaction window. The new recurring transaction will now appear in the Recurring Transactions List window. See ‘To find a recurring transaction’ on page 117.
To create a recurring transaction from an existing entry

You can create a recurring transaction by copying an existing recurring transaction entry, then customising the details for the new one.

1. Go to the Lists menu and choose Recurring Transactions. The Recurring Transactions List window appears.

2. Select the recurring transaction you want to copy and click Create Copy. The Create Copy window appears.

3. In the Card field, click the search button ( ). The Select from List window appears listing only card types relevant to the type of recurring transaction you are copying. For example, a sales transaction can only be applied to your customer cards.

4. Select the cards you want to create a copy for:
   - if you want to select all the cards, click the icon above the select column ( )
   - if you only want to select some cards, click in the select column next to each card required.

5. Click OK when you’ve finished selecting from the list. The Create Copy window reappears.

6. Click Save.

<table>
<thead>
<tr>
<th>If you selected...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>One card</td>
<td>The transaction window for the new recurring transaction appears. You can edit the transaction details if required. Click Save. The Recurring Transactions List window appears.</td>
</tr>
<tr>
<td>More than one card</td>
<td>The Recurring Transactions List window lists all your recurring transactions. Each new transaction has a unique name—the original name suffixed by the name of the relevant card.</td>
</tr>
</tbody>
</table>

7. If you need to change the schedule details or the name of a new recurring transaction:
   a. Select the recurring transaction.
   b. Click Edit Schedule. The Recurring Schedule Information window appears.
   c. Make your changes and click OK.

8. Click Close.

To edit a recurring transaction

After you’ve created a recurring transaction, you can edit the details (such as the cheque details of a Spend Money transaction) or edit the schedule.

1. Go to the Lists menu and choose Recurring Transactions. The Recurring Transactions List window appears.

2. If you want to change the recurring transaction details:
   a. Select the recurring transaction and click Edit. The transaction window appears for the selected type of recurring transaction.
   b. Make the necessary changes.
   c. Click Save.
If you want to change the schedule of the recurring transaction:

a. Select the recurring transaction and click Edit Schedule. The Recurring Schedule Information window appears.
b. Change the scheduling details of the transaction as required.
c. Click OK.

To delete a recurring transaction

Deleting a recurring transaction only removes it from your list of recurring transactions. Transactions recorded previously, using this recurring transaction as a template, are not affected.

1. Go to the Lists menu and choose Recurring Transactions. The Recurring Transactions List window appears.
2. Select the recurring transaction you want to delete and click Delete. An information message appears explaining that this action will not delete any recorded transactions based on this transaction template.
3. Click OK to delete the recurring transaction.

Recording recurring transactions

For recurring transactions that are not set up to record automatically, you need to decide when to record them. You can:

- record a single recurring transaction from a transaction window—see below
- record several transactions at the same time—see below.

You can also record a recurring transaction:

- in the Reminders window (if you use the reminders option)—see ‘Reminders’ on page 124.
- in the Recurring Transactions List window by going to the Lists menu and choosing Recurring Transactions.

To record a recurring transaction from a transaction window

1. Open the transaction window for the recurring transaction you want to use. For example, open the Sales window if you are recording a recurring sales transaction.
2. Click Use Recurring. The Select a Recurring Transaction window appears listing only recurring transactions for this type of transaction.

3. Choose the recurring transaction from the list and then click Select. The transaction appears.
4. If necessary, change the date, amount, account and other details.
5. Click Record.

To record multiple recurring transactions

1. From any command centre, click To Do List. The To Do List window appears.

3. Choose the recurring transaction from the list and then click Select. The transaction appears.
4. If necessary, change the date, amount, account and other details.
5. Click Record.
2 Click the appropriate tab—**Recurring Sales**, or **Recurring Transactions** (for all other recurring transactions).

![Image of Recurring Transactions tab]

In the list of recurring transactions that appears, you can click the zoom arrow (🔍) to the left of a transaction to view it in detail.

3 Click in the select column (☐) next to any recurring transactions you want to record.

4 Click **Record**. A window appears requiring you to enter a date for the selected transactions. This is the date that the transactions will be recorded in your journals.

5 Enter a date and click **OK**.

**Reminders**

You can choose to be reminded on, or before, the scheduled date of a recurring transaction—see ‘**Specify an alert option**’ on page 121. If you use this option, the **Reminders** window appears when you open your company file, when a recurring transaction is due (or overdue).

![Image of Reminders window]

The options available in this window depend on the status of the selected recurring transaction (if more than one is showing). For example, if the selected transaction has a due date of today or is overdue, the **Remind Tomorrow** and **Remind When Due** buttons are not available.

The reminder options are outlined below.

<table>
<thead>
<tr>
<th>Click...</th>
<th>If...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Skip This Period</strong></td>
<td>You don’t want to record the transaction this period. The reminder is removed from the list.</td>
</tr>
<tr>
<td><strong>Remind Tomorrow</strong></td>
<td>You don’t want to record the transaction today, but want to be reminded tomorrow.</td>
</tr>
<tr>
<td><strong>Remind When Due</strong></td>
<td>You don’t want to record the transaction today, but want to be reminded when the transaction is next due.</td>
</tr>
<tr>
<td><strong>Record</strong></td>
<td>You want to record the transaction now.</td>
</tr>
</tbody>
</table>
There are many reports that can help you monitor your business. If the default set of reports do not meet your needs, you can design custom reports with the information and appearance you want, then save these custom reports to re-use when required.

Producing reports

When you prepare reports, you can easily modify the format, content and appearance of a report, and export it to a different format. You can also create customised reports that suit the specific needs of your business and save them for future use.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>view a report</td>
<td>below</td>
</tr>
<tr>
<td>print, send or save a report</td>
<td>page 126</td>
</tr>
<tr>
<td>save a report in another file format</td>
<td>page 126</td>
</tr>
</tbody>
</table>

Displaying a report

1. Go to the Reports menu and choose Index to Reports. The Index to Reports window appears.
2. Click the tab corresponding to the type of report you want to display. A list of report headings appears.
3. Click the required report group and then click the report you want to display.
4. Enter or select the date range or period for which you want to view the report. Note that this option is not available for some reports.

5. Click Display. The Report window appears.

   **TIP:** Click Advanced to select more filters If you want to select more report filters before generating the report, click Advanced in the Index to Reports window.

6. If you want to filter or modify the report, click the appropriate tab of the window. Each tab shows customisation options.

   A  Click the Filters tab to sort and filter the information that appears on the report. After selecting your filters, click Run Report to apply the changes. See ‘Filtering and sorting data in a report’ on page 127.

   B  Click the Insert/Modify tab to add or remove report fields, insert a picture or include additional text. See ‘Customising reports’ on page 127.
For detailed information about modifying reports, see ‘Customising reports’ on page 127.

Go to ‘Printing, saving and sending a report’ below.

Printing, saving and sending a report

1 With the report displayed, click the Print Preview tab and select options for how the report will appear when printed.

A Select the margins, page orientation and page size.

B To scale the size of the report, enter a percentage value in the Scale field. To fit the report to the page width, click Shrink One Page.

C Select how the report appears on screen while you are previewing it.

2 Choose how you want to print, save or send the report.

A Click the File menu to see printing, saving and sending options.

B Click Export to export the report to a different format (such as Excel), or click Send to send the report via email. For detailed information about these options, see ‘Saving reports in other formats’ below.

C Click Save As to save the report as a custom report. For more information, see ‘Saving custom reports’ on page 132.

D Click Print to print the report.

Printing and sending shortcuts In the toolbar at the top of the main Report window, click the Print icon ( ) to print the report. Click the save icon ( ) to save the report as a custom report.

Saving reports in other formats

You can save reports in various file formats so that they can be viewed and edited in other programs.

1 Display the report you want to save. For more information, see ‘Displaying a report’ on page 125.

2 Go to the File menu and click Export. A list of file format options appears in the right side of the window.

3 Click a file format option:

<table>
<thead>
<tr>
<th>File format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF (Portable Document Format)</td>
<td>If you save a report as a PDF file, the person who receives the report must have a PDF viewer, such as Adobe Reader, to view the report.</td>
</tr>
<tr>
<td>Microsoft Excel document (required)</td>
<td>If you save the report as an Excel document, the person who receives the document must have a program that can open Microsoft Excel spreadsheets, to view the document.</td>
</tr>
<tr>
<td>TSV (tab-separated values) .txt file</td>
<td>When you save a report using tab-separated values, fields in the report are separated by tab characters. The file is then saved as a .txt file, which can be opened by most word processor and spreadsheet programs.</td>
</tr>
</tbody>
</table>
Customising reports

You can easily change the look and content of reports. For example, you can filter the type of information that appears, add additional columns and change the appearance.

You can customise a report for once-off use and print it immediately, or if you want to retain a report’s modifications, you can save it as a custom report.

When you save a custom report, it appears in the My Custom Reports tab of the Index to Reports window. See ‘Saving custom reports’ on page 132.

There are a number of customisation tasks you can perform.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filtering and sorting data in a report</td>
<td>below</td>
</tr>
<tr>
<td>Adding text and graphics to a report</td>
<td>page 129</td>
</tr>
<tr>
<td>Changing the report background</td>
<td>page 130</td>
</tr>
<tr>
<td>Saving custom reports</td>
<td>page 132</td>
</tr>
</tbody>
</table>

Filtering and sorting data in a report

You can customise the information that appears in your reports by specifying the range of data that you want to include, and by applying report filters. For example, if you want to print a Customer Payments (Closed Invoices) report for a single customer for the months May to July, you can use filters to select just that customer and just those months.

Once you filter the data, you can then select and sort the content of the report. For example, if you want the report to show the original purchase order number used by the customer, you can choose to show this data as well.

To set report filters

1. Open the report you want to view. See ‘Displaying a report’ on page 125.
2. Click the Filters tab. The options that appear depend on the report being customised.

Depending on the report format you chose:

- the Export report as window appears. Specify the file name and location, and then click Save.
- the report is displayed in the selected program (such as Excel). Save the report in the program as you normally would.

<table>
<thead>
<tr>
<th>File format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV (comma-separated values) .txt file</td>
<td>When you save a report using comma-separated values, fields in the report are separated by commas. The file is then saved as a .txt file, which can be opened by most word processors and spreadsheet programs.</td>
</tr>
<tr>
<td>XPS (XML Paper Specification)</td>
<td>You can view XPS files in Windows 7 or using Internet Explorer 7 or 8.</td>
</tr>
</tbody>
</table>
Note that date filters are unavailable for some reports. 

3 In the **Refinements** section, select values for the various filters. The example below shows the options available for the **Item List [Summary]** report.

![Image showing various filter options]

A Click **Run Report** to apply filter changes.

B Click **Sort** to sort the order of information in the report. For more information, see ‘To sort report data’ on page 129.

C Select values for filters to limit the data that will be included in the report. Depending on the report you are producing, you may be able to filter by card type, custom lists, tax codes, amounts, etc.

D Click **Additional Filters** to set filtering options that are not visible in the tab. See step 4 below.

E Click **Reset Filters** to return all filters to their default values.

4 If you want to apply more filtering options, click **Additional Filters**. The **Additional Filters** window appears.

Note that the options available in this window depend on the report you are viewing.

![Additional Filters window]

5 For each filter you want to apply to the report:
   a Click the tab for the type of record you want to filter the report by.
   b Select the values for any filters you want to apply.
   c Click **OK**. The **Reports** window reappears. Click **Run Report** to apply the new filter settings.

**To add report data**

1 Click the **Insert/Modify** tab.

2 Click **Show/Hide**. The **Show/Hide Columns** window appears.

![Show/Hide Columns window]
3 If you want to:
   - add a column to your report, select it in the Available columns list and click Show.
   - remove a column from your report, select it in the Columns in your report list and click Hide.
4 Click OK. Your selections are displayed on the report.

To change the column order
If you want to change the column order, do one of the following:
   - Click on a column heading, hold the mouse button down and drag the column to a new position.
   - Click Order in the Insert/Modify tab and in the window that appears, select the column heading you want to reorder and then click the up and down arrows to change the column order.

To sort report data
1 Click the Filters tab, then click Sort. The Sort window appears.

To add a data field
Data fields contain pre-specified data, such as your company name or your address.
1 In the Report window, click the Insert/Modify tab.
2 Click Fields. The Insert/Remove Fields window appears.
3 Select the fields you want to appear in your report, then click OK.

To add a text box
Text boxes are fields that contain text you enter yourself.
1 In the Report window, click the Insert/Modify tab.
2 Click Text Box.
3 Click and drag the mouse cursor in the area of the report you want the text box to appear.
4 Double-click in the text box and type the text you want to appear on your report.
5 If you need to reposition or resize the element, see ‘To move, resize or rotate an element’ on page 131.
To format text in text boxes and data fields
1 In the Report window, click the Insert/Modify tab.
2 Click to select the field containing the text you want to format.
3 Use the options in the Field Properties section to select the required font, size, alignment, style and colour for the text in the field.

To add a shape or line
1 In the Report window, click the Insert/Modify tab.
2 Click the Shapes/Lines button and select the type of shape or line you want to add to your report.
3 Click and drag the mouse cursor over the area of the report where you want the selected shape to appear.
4 If you need to reposition or resize the element, see ‘To move, resize or rotate an element’ on page 131.

To add a picture or logo
1 In the Report window, click the Insert/Modify tab.
2 Click Picture.
3 Locate and select the picture file (bmp, jpg, gif, png or tif) and click Open. The picture appears in the report.
4 If you need to reposition or resize the element, see ‘To move, resize or rotate an element’ on page 131.

Changing the report background
You can change the colour of a report background and insert watermarks.
1 Display the report.
2 In the Reports window, click the Insert/Modify tab.
3 If you want to change the page colour, click Page Colour and select the required background colour.
4 If you want to add a watermark, click Watermark and choose one of the predefined watermarks, or select Custom Watermark.
If you are adding a custom watermark, choose a picture or enter the watermark text and select the required formatting options.

Click OK.

Common commands for editing report elements

You can modify elements you have added to a report, such as shapes, text boxes and images, using the options in the Insert/Modify tab. The following procedures describe some of the options.

To format an element

1. Select the element you want to format.
2. Use the options in the Field Properties section to select the required background colour and border colour for the element.

To move, resize or rotate an element

1. Click to select the element you want to edit.
2. Move the element by clicking and dragging it to a new position on your report.

You can also set the element’s position manually by entering coordinates in the Placement fields in the Insert/Modify tab.

3. Change the element’s size by clicking and dragging the anchor points on the corners of the element.

4. Rotate the shape by clicking the top anchor point and dragging the cursor. The element is rotated around one of its corners.

To arrange elements

1. Click the element once to select it.
2 Click **Arrange** and then choose an option.

To align elements
1 Select the elements you want to align. To do this, hold down the Ctrl key on your keyboard and click each element.
2 Click **Align** and then choose an alignment option.

To cut, copy or paste elements
1 Select the element and do one of the following to copy or cut:
   - Use the clipboard buttons in the *Insert/Modify* tab to cut, copy and paste.
   - Right mouse-click and choose **Cut** or **Copy**.
2 Click on the area of the report where you want to paste the element, then either:
   - Use the clipboard buttons in the *Insert/Modify* tab to paste.
   - Right mouse-click and choose **Paste**.

To delete an element
- Select the element and do one of the following:
  - press DELETE on your keyboard.
  - right mouse-click and choose **Delete**.

To undo changes
- To undo the last change you made to the current report, click the undo button ( 

Saving custom reports
If you plan to use a report’s filtering options and format again, you can customise the report once, save the changes and then re-use the report whenever you want. Once saved, you can access your custom report from the **My Custom Reports** tab in the *Index to Reports* window.
1 With the report displayed, click the save icon ( ) at the top of the window. The *Save report as* window appears.
2 Enter a name and a brief description of the custom report.
3 Click **Save**.

Note that the report you have just saved is now listed in the **My Custom Reports** tab of the *Index to Reports* window. You can run the report again by selecting it from the **My Custom Reports** tab.

Deleting a custom report If you want to remove a custom report, select the report in the **My Custom Reports** tab of the *Index to Reports* window and click the delete icon ( ).
10 Forms

You can print all the standard business forms you send to customers and other contacts: quotations, invoices, shipping labels, statements, cheques, remittance advices, receipts, and mailing labels. You can customise all of these forms to suit the needs of your business.

Forms can be printed or emailed individually as you complete a transaction (for example, an invoice for a cash sale), or sent later, in batches.

Finding forms

Forms are accessed from the command centre of the associated transaction. For example, sales forms can be accessed from the Sales command centre.

To find forms

1. Go to the appropriate command centre, for example, Sales for invoice forms.
2. Find the type of form you want and click the relevant command centre function. See the following table:

<table>
<thead>
<tr>
<th>Command Centre</th>
<th>Type of Form</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banking</td>
<td>Cheques</td>
<td>Print Cheques</td>
</tr>
<tr>
<td></td>
<td>Receipts</td>
<td>Print Receipts</td>
</tr>
<tr>
<td></td>
<td>Remittance Advices</td>
<td>Print/Email Remittance Advices</td>
</tr>
<tr>
<td>Sales</td>
<td>Invoice forms</td>
<td>Print/Email Invoices</td>
</tr>
<tr>
<td></td>
<td>Shipping labels</td>
<td>Print/Email Invoices</td>
</tr>
<tr>
<td>Card File</td>
<td>Mailing labels</td>
<td>Print Mailing Labels</td>
</tr>
<tr>
<td></td>
<td>Personalised letters</td>
<td>Create Personalised Letters</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command Centre</th>
<th>Type of Form</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Statements</td>
<td>Print/Email Statements</td>
</tr>
<tr>
<td></td>
<td>Receipts</td>
<td>Print Receipts</td>
</tr>
<tr>
<td></td>
<td>Mailing labels</td>
<td>Print Mailing Labels</td>
</tr>
<tr>
<td></td>
<td>Personalised letters</td>
<td>Create Personalised Letters</td>
</tr>
</tbody>
</table>
Sending forms

You can send forms when you record a transaction, or later, in a batch.

Sending forms when you record a transaction

You can print, email or save forms as you enter a transaction.

To print a form

1. In the transaction window (for example, the Sales window), click **Print**. A list of print options appears.

2. Choose a print option:
   - Default form—If you have specified a default form in the customer or supplier card, this form appears as an option. Otherwise, the **Pre-Printed [...]** option appears.
   - **Select Another Form**—Click to choose a different form or a customised form from a list.
   - **Preview**—Preview the form in a new window.

   Note that the transaction will be recorded before the form is printed.

To email or save a form

1. In the transaction window (for example, the **Sales** window), click **Send To**. A list of sending options appears.

2. Choose a sending option:
   - **Email**—Send the form as a PDF attachment by email.
   - **Disk**—Save the form to your computer or removable media as a PDF.

   Note that the transaction will be recorded before the form is sent.

**TIP**: Automatically print, email or save

You can set up your preferences so that you can automatically print, email or save sales when you record them. To do this, select the required option in the **Sales** tab of the **Preferences** window.

Sending forms in a batch

Instead of printing each form in the transaction window when you record it, you can select to print or email the forms later, in a batch.

To do this, select **To be Emailed**, **To be Printed** or **To be Printed and Emailed** in the [...] **Delivery Status** field in a transaction window.
For example:

- **Sales window**

- **Spend Money window**

After you have completed a number of transactions, say, the invoices for the day, you can print or email a transaction batch. You also can choose which forms to print by applying selection criteria. For example, you can choose to print customer statements only if the balance of the customer’s account is not zero.

**To send forms in a batch**

1. Click the command centre function for the forms you want to send. For example, if you want to send sales invoices, go to the **Sales** command centre and click **Print/Email Invoices**.
2. Depending on the type of form you are sending, you have the option to print or email. Click the relevant tab for how you want to send the forms:
   - **To Be Printed**

3. If the field is available for the form you are sending, make a selection in the [ ] Type field. For example, if you want to send item invoices, select **Item**.
4. If you want to view the details of a transaction, click the zoom arrow ( ) next to it.
5. If you want to change the form stationery or filter the list of forms, click **Advanced Filters**. For more information, see ‘Customising how you send form batches’, on page 136.
6. Click in the select column ( ) next to a transaction you want to send. If you want to send all the transactions, click the icon in the heading of the select column.
7. If you are printing forms:
   a. Type the number of copies you want to print in the **Print [...] Copies** field.
   b. (Sales) If you also want to print mailing labels, type the number of copies in the **Labels** fields.
   c. Click **Print**. The forms will be sent to your printer.
8. If you are emailing forms:
   a. If you want to change a recipient’s email address, select their name and click the down arrow next to the **Email Address** field and select another address from the card. Alternatively, type the address in the **Email Address** field.
b Enter a subject title and message or accept the default title and message.

NOTE: You can update the default email title and message for all emailed forms. To do this, click Email Defaults. The Email Defaults window appears. Click the tab corresponding to the form you are preparing. Make the required changes in the window and click OK.

c Click Send Email. The forms will be emailed as PDF attachments.

Customising how you send form batches

You can filter the list of transaction forms you are sending and change the stationery you use before you send forms. You can do this in the Advanced Filters window.

1 In the To Be Printed or To Be Emailed tab of the Review [...] Before Delivery window, click Advanced Filters. The Advanced Filters window appears.

Select the transactions

2 Select the criteria by which you want to filter the list of transactions. You can specify a transaction type, and select all cards or a specific card.

3 If you want to filter the transactions using other criteria, select from the options in the middle section of the window. For example, enter a date range or reference number range.

Select the stationery

4 In the Selected Form for [...] field, select the stationery you want to use when you print or email your forms.

Several stationery choices are available, depending on the type of form you are sending.

<table>
<thead>
<tr>
<th>Stationery</th>
<th>Select this for...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-printed</td>
<td>Select the preprinted stationery to print on paper that already contains lines, columns and headings. The preprinted stationery is designed to match most commonly used forms provided by third-party forms suppliers. Note that this type of stationery is not suitable for emailing forms.</td>
</tr>
<tr>
<td>Plain paper</td>
<td>Select plain-paper stationery if you want to print on blank paper. Lines, columns and headings are automatically printed with the form’s information.</td>
</tr>
<tr>
<td>Customised</td>
<td>Select a customised stationery form if you want to print or email a form you have already customised. See ‘Customising forms’ on page 137.</td>
</tr>
</tbody>
</table>

TIP: Test the printing alignment. If you are using continuous-feed paper or pre-printed stationery and you want to test the alignment of the information that will be printed using sample data, click Print Alignment Form.
When you have finished making your selections in the Advanced Filters window, click OK. The Review [...] Before Delivery window reappears, displaying records according to your filter criteria.

Click Print or Email to send the forms.

Customising forms

You can customise the look and content of most forms in AccountRight. You can also change the form size, add text labels, draw lines and boxes, insert graphics, move fields, and more. Then you can save your customised stationery so that you can select it when you send a form.

The following describes the tasks involved in customising a form:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying a form</td>
<td>below</td>
</tr>
<tr>
<td>Setting form properties</td>
<td>page 138</td>
</tr>
<tr>
<td>Adding and editing form elements</td>
<td>page 138</td>
</tr>
<tr>
<td>Saving customised forms</td>
<td>page 143</td>
</tr>
<tr>
<td>Exporting and importing customised forms</td>
<td>page 144</td>
</tr>
</tbody>
</table>

Displaying a form

1. Go to the Setup menu and choose Customise Forms. The Customise Forms window appears.
2. Click the tab corresponding to the type of form you want to customise.
3. Select a form group from the list to display a list of forms associated with that group. For example, select the Item group in the Invoices tab.
4. Click the form, then click Customise. The selected Form window appears.

NOTE: Cheques have two parts A cheque form has two parts: the cheque itself and the stub. You customise the cheque and the stub separately. For more information, see ‘Customising cheques’ on page 141.
Setting form properties

You can set properties that apply to the whole form, such as background colour and page size.

To set page margins, orientation and page size

1. Open the form you want to customise.
2. Click the Print Preview tab.
3. Set the page margins, orientation and page size.

To edit the page background

Use the Page Background options in the Customise tab to change the background of a form.

1. Open the form you want to customise.

Adding and editing form elements

There are a number of different elements you can add to your forms, including images, data fields, lines and shapes.

To make working with form elements easier, you can use the form gridlines to help you align elements on your form.

To use form gridlines

1. Open the form you want to add or edit elements in.
2 In the **Customise** tab, click **Grid Options**. The **Grid Options** window appears.

![Grid Options Window](image)

3 Select the spacing you want between gridlines.

4 If you want to see the gridlines as you edit the form, click the **Display grid on screen** option.

5 If you want form elements to always align to the gridlines, select the **Snap to grid** option.

6 Click **OK**.

For detailed information about working with elements, see:
- ‘Adding data and text fields to forms’ below
- ‘Adding tables to forms’ on page 140
- ‘Adding shapes and images to forms’ on page 140
- ‘Common commands for editing form elements’ on page 142.

### Adding data and text fields to forms

You can add data fields to a form, and then change their properties (such as font and colour) using the **Customisation** tab in the **Form** window.

![Form Elements Icons](image)

To add a data field to a form

1 Open the form you want to add data fields to.

2 In the **Customise** tab, click **Fields**. The **Insert Fields** window appears.

3 Select the fields you require by clicking in the column next to them.

4 Select where you want the field to appear, for example, on every page, or just at the start or end of the form.

5 When you have finished making your selections, click **OK**. The selected data fields appear on the form.

6 Move the field to the required position by clicking and dragging it, or entering placement coordinates in the **Customise** tab.

To edit a data field

1 Select the data field in the **Form** window.

2 Edit the properties of the data field using the options in the **Customise** tab.

3 Move or resize the field as required. See ‘To move, resize or rotate elements’ on page 142.

To add a text field to a form

1 Open the form you want to add text to.

2 In the **Customise** tab, click **Text Box**.

3 Click and drag the mouse cursor over the area of the form where you want the text field to appear.

4 Double-click in the text field and type the text you want to appear.
To edit a text field
1 Select the text field in the Form window.
2 Edit the properties of the field using the options in the Customise tab.
3 Edit the text by typing in the active text field.
4 Move or resize the field as required. See ‘To move, resize or rotate elements’ on page 142.

Adding tables to forms
Tables contain transaction information such as line items or GST summary information. Different table options are available for each form type.

To add a table to a form
1 Open the form you want to add a table to.
2 In the Customise tab, click Insert Table and choose the type of table you want to use from the list. The table appears on the form.

To move a table
Select it, then click on the highlighted edge and drag it to a new position. Alternatively, you can enter placement coordinates in the Customise tab.

To add or remove table columns
1 Select the table and in the Customise tab, click Table Layout.
2 Choose Show/Hide Columns. The Show/Hide Columns window appears.
3 If you want to:
   a add a column to your form, select it in the Available columns list and click Show.
   b remove a column from your form, select it in the Columns in your table list and click Hide.
4 Click OK. The columns appear in your table.

To change column order in a table
1 Click and hold a column heading and drag it to a new position.

To edit table borders and shading
1 Double-click the column or column header.
2 Click the Customise tab.
3 To change the format or alignment of the text, edit the text format options.
4 To add a background colour to a column, click the shape fill icon ( ) and choose fill colour options.
5 To change the table borders, click the table or column and change the border options.
6 To show alternate rows as shaded in the table, click Table Layout, then choose Show Row Shading.

Adding shapes and images to forms
You can also add graphic elements to a form: rectangles to visually group elements, lines to separate elements, icons, logos, photos, location maps and other graphic elements. You do this in the Customise tab.

To add an image
1 Open the form you want to customise.
2 In the Customise tab, click Picture. The Open window appears.
3 Locate and select the picture file (bmp, jpg, gif, png or tif) and click Open. The picture appears in the form.
4 Move, resize or rotate the image as required. For more information, see ‘To move, resize or rotate elements’ on page 142.
To add a shape or line
1. Open the form you want to add a line to.
2. In the **Customise** tab, click **Shapes/Line** and choose the required shape or line.
3. Click and hold the mouse cursor at the location on the form where you want the shape or line to appear, then drag the cursor to draw it.

To edit a shape or line
1. Select the shape or line.
2. Move, resize or rotate the element as required. For more information, see ‘To move, resize or rotate elements’ on page 142.
3. Edit the properties of the shape using the options in the **Customise** tab.

<table>
<thead>
<tr>
<th>To...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>change the colour of a line or shape border</td>
<td>Click the shape border icon ( وغير国家标准) and choose from a theme colour or standard colour.</td>
</tr>
<tr>
<td>change the thickness of a line or shape border</td>
<td>Click the shape border icon ( وغير国家标准), choose <strong>Border Width</strong>, and then choose a width.</td>
</tr>
<tr>
<td>change the fill colour of a shape</td>
<td>Click the shape fill icon ( وغير国家标准) and choose from a theme colour or standard colour.</td>
</tr>
</tbody>
</table>

**Customising cheques**

Cheques are made up of two forms—the cheque and the stub. The stub usually displays a summary of the information that appears on the cheque.

You can customise both the cheque and each type of cheque stub in one window, by selecting the stub layout. Stub layouts include:

- **Regular**—This layout is assigned to cheques recorded in the **Spend Money** window.
- **Refund**—This layout is assigned to cheques recorded in the **Settle Returns & Credits** window.

**TIP:** Print two cheque stubs. If your business prefers to produce two stubs for each cheque, you should select the Laser Cheque layout in the **Selected Form for Cheque** field in the **Advanced Filters** window when you print your cheque.

To customise cheques
1. Display the cheque form you want to customise. For more information, see ‘Displaying a form’ on page 137.
2. Click the **Customise** tab.
3. In the **Layout** field, choose the layout type you want to customise.

For example, if you want to customise the payment section of the cheque, choose **Cheque**. Otherwise, choose another layout (Regular, or Refund) as described above.

4. Make your changes to each layout as required. For more information, see ‘Adding and editing form elements’ on page 138.
5. When you are finished, save the form.

**TIP:** Test your customised cheques. You should print an alignment cheque to make sure your new form prints correctly. Go to the Banking command centre and click **Print Cheques**. Click **Advanced Filters**, select your customised cheque in the **Selected Form for Cheque** field and then click **Print Alignment Form**.
Common commands for editing form elements

You can modify elements you have added to a form, such as shapes, text boxes and images, using the options in the **Customise** tab. The following procedures describe some of the options.

**To move, resize or rotate elements**

1. Click to select the element you want to edit.
2. Move the element by clicking and dragging it to a new position on your report.
3. Change the element’s size by clicking and dragging the anchor points on the corners of the element.
4. Rotate the shape by clicking the top anchor point and dragging the cursor. The element is rotated around one of its corners.

You can also set the element’s position manually by entering coordinates in the **Placement** fields in the **Customise** tab.

To cut, copy or paste elements

1. Select the element and do one of the following to copy or cut:
   - Use the clipboard buttons in the **Customise** tab to cut, copy and paste.
   - Right mouse-click and choose **Cut** or **Copy**.
2. Click on the area of the form where you want to paste the element, then either:
   - Use the clipboard buttons in the **Customise** tab to paste.
   - Right mouse-click and choose **Paste**.

To delete elements

- Select the element and do one of the following:
  - press **DELETE** on your keyboard.
  - right mouse-click and choose **Delete**.
To arrange elements

1. Click the element once to select it.
2. Click Arrange and then choose an option.

To align elements

1. Select the elements you want to align. To do this, hold down the Ctrl key on your keyboard and click each element.

2. Click Align and then choose an alignment option.

To undo changes

✓ To undo the last change you made to the current form, click the undo button (undo).

Saving customised forms

TIP: Preview the form before saving Click the PrintPreview tab to view the form as it will appear printed.

1. When you have finished customising your form, go to the File menu and click Save As. The Save Form As window appears:
   a. If you created a new customised form, enter a name and a description for the form.
   b. If you modified an existing custom form, do not change the default information in the window.

2. Click Save. The Form window reappears.

   The form will appear under the group of forms that the form was based on. For example, if you created a new form based on an existing item sales invoice, your form will appear under the Items group of the Invoices tab.

3. To close the form, go to the File menu and choose Exit.
Exporting and importing customised forms

You can incorporate customised forms created in a company file into other company files. The process used to share customised forms in this way is called exporting and importing customised forms.

The types of customised forms you can export and import are cheques, invoices, statements, receipts, remittance advices and mailing labels.

To export customised forms

1. Go to the Setup menu and choose Export Customised Forms. The Export Customised Forms assistant appears.
2. Click Browse and select the folder you want to export customised forms to.
3. Select the form types you want to export.
4. Click Next. The Select forms to export step of the Export Customised Forms assistant appears.
5. Select the type of customised forms you want to export. To do this, click on the first form type you want to export in the Available Items column and then click Add. The form will appear in the Selected Items column. If you want to export all available form types, click Add All.
6. Click Export. The export process begins.
7. When the export process finishes, the Conclusion step of the assistant appears showing the results of the export process, such as the number of forms exported and the number not exported.

You can open the folder that you have exported your customised forms to by clicking a link to that folder. You can also view more information about the export results by clicking the link to the export log file.
8. Click Finish to close the Export Customised Forms assistant.

To import customised forms

1. Go to the Setup menu and choose Import Customised Forms. The Import Customised Forms assistant appears.
2. Click Browse to locate and select the folder containing the customised forms you want to import.
3. Select an option to handle duplicate customised forms. If you:
   - want to replace any existing customised forms, select replace the existing form with the imported form.
   - don’t want to replace any existing customised forms, select reject the form being imported.
4. Click Next. If you didn’t make a backup of your company file prior to starting the import process, click Back up to make one now.
5. Click Import. The import process starts.
6. When the import process finishes, the Conclusion step of the assistant appears showing the results of the import process, such as the number of forms imported and the number not imported. You can view more information about the import results by clicking the link to the import log file.
7. Click Finish to close the Import Customised Forms assistant. You can select customised forms that were successfully imported from the relevant tab of the Customise Forms window, from transaction windows and from the relevant Advanced Filters window.
Contact management

The Card File is a repository of contact records, known as cards, that you can create for your customers, suppliers, employees and personal contacts. A card lets you store contact information and enables you to track and analyse the transaction history for each individual and business.

Creating a card

You need to create a card for an individual or business if you want to perform any of the following tasks:

- record sales and track the amounts owed to you
- print mailing labels
- print personalised letters
- record contact details.

When you set up your company file, you may have created cards for your customers. In addition to these cards, you can create supplier cards, employee cards and personal cards for your friends and relatives.

<table>
<thead>
<tr>
<th>If you want to create a card for...</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>a customer</td>
<td>page 87</td>
</tr>
<tr>
<td>a supplier</td>
<td>below</td>
</tr>
<tr>
<td>an employee</td>
<td>below</td>
</tr>
<tr>
<td>a friend or relative</td>
<td>below</td>
</tr>
</tbody>
</table>

To add a supplier, employee or personal card

1. Go to the Card File command centre and click Cards List. The Cards List window appears.
2. Click New. The Card Information window appears.
3. Select the required card type from the Card Type list.
4 Type a name for the card and press Tab.
5 If you want to, complete the other details in the Profile tab.
6 Click the Card Details tab. In this tab, you can:
   - add a picture—see ‘Card pictures’ on page 159.
   - enter a card ID—these are useful for grouping your cards. See ‘Card identification codes’ on page 158.

7 When you have finished entering the card details, click OK to save the card and close the Card Information window.

Keeping in touch with your contacts

There are a number of features you can use to help you stay in touch with your customers, suppliers, employees and personal contacts. You can create personalised letters from templates, send emails, enter contact log entries and create mailing labels.

Personalised letters

You can create personalised letters (also known as mail-merge letters) for any of your contacts. A personalised letter is a document template that contains standard text as well as fields that can be automatically filled with data stored in your company file.

Personalised letters are useful when you need to send the same letter to several contacts. For example, you may want to send several slow-paying customers a payment reminder letter. Instead of entering each contact’s information on the letters yourself, you can set up a letter template that contains the text you want to appear, and insert data fields that automatically fill in the contact’s name, address and the amount owing.

Printing personalised letters using Microsoft Word and OfficeLink

OfficeLink is a feature that automates the process of merging contact information stored in your company file with a Microsoft Word template (a .dot file).

The following table summarises the templates provided with your software.

<table>
<thead>
<tr>
<th>Use this template...</th>
<th>When you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apology.dot</td>
<td>apologise for a problem your company has caused for a customer, and to assure the customer that the problem will be addressed.</td>
</tr>
<tr>
<td>Backordr.dot</td>
<td>let your customers know that items they’ve ordered are on backorder and will be shipped as soon as possible.</td>
</tr>
<tr>
<td>Blank.dot</td>
<td>write your own letter.</td>
</tr>
<tr>
<td>BOUNCED.dot</td>
<td>notify customers whose payments have bounced.</td>
</tr>
<tr>
<td>Coll_1st.dot</td>
<td>remind customers whose accounts have become overdue to make a payment.</td>
</tr>
<tr>
<td>Coll_2nd.dot</td>
<td>express greater urgency than Coll_1st.dot and request that your customer contact you immediately.</td>
</tr>
<tr>
<td>Coll_3rd.dot</td>
<td>encourage customers who have overdue payments to make a payment before their credit history is damaged.</td>
</tr>
<tr>
<td>Coll_fin.dot</td>
<td>advise customers that you will turn their account over to a collection agency if payment isn’t made within a specified number of days.</td>
</tr>
<tr>
<td>Credit Application.dot</td>
<td>enable your customers to formally apply for credit.</td>
</tr>
<tr>
<td>FaxCover.dot</td>
<td>create a fax cover page. This page includes room for a memo.</td>
</tr>
<tr>
<td>Use this template...</td>
<td>When you want to...</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Resolved.dot</td>
<td>reply to customers who have questioned an amount on their monthly statement. This letter indicates that you are looking into the matter and that you will credit the customer's account for the amount in question while the matter is investigated.</td>
</tr>
<tr>
<td>ThankYou.dot</td>
<td>thank new customers for their business.</td>
</tr>
</tbody>
</table>

You can edit these templates and create new ones using the mail-merge features of Microsoft Word. For information about working with mail-merge templates, see Microsoft Word Help.

**To print a personalised letter using Microsoft Word**

1. Go to the Card File command centre and click Create Personalised Letters. The Review Cards Before Exporting window appears.
2. If you want to, filter the contact list, for example, to only show contacts located within specific postcodes. To do this, click Advanced Filters and enter your filtering criteria.
3. Click in the select column next to each contact to whom you would like to send a personalised letter.
4. Click Mail Merge. The Select from List window appears.
5. Select the template you would like to use and then click Use Template.
   Your letter appears in Microsoft Word, and depending on the template you have selected, you will be prompted to enter additional information, such as your name and title.
6. Edit the letters as required and then print them using Microsoft Word.

**TIP:** If you want to send letters to customers with unpaid invoices. Display the Accounts Receivable tab of the To Do List window and click the Select column for each customer to whom you want to send a letter. Click Mail Merge to select a collection letter template, which includes information such as the customer's outstanding balance.

**To print a personalised letter using other word processors**

To use a mail-merge letter template created in a word processor other than Microsoft Word, you export the contact data out of your company file and then merge that data with the letter.

1. Go to the Card File command centre and click Create Personalised Letters. The Review Cards Before Exporting window appears.
2. If you want to, filter the contact list, for example, to only show contacts located within specific postcodes. To do this, click Advanced Filters and enter your filtering criteria.
3. Select the contacts to whom you would like to send a personalised letter.
4. Click Disk. A window with a list of file formats appears.
5. Choose either the Tab-Delimited Text File or Comma-Separated Text File option.
6. Click Save. The Save As window appears.
7. If necessary, change the text file’s name and location and then click Save.
   The text file containing your contacts’ details is saved at the location you specified.
8. Use your word processing software to merge the data contained within the text file with a letter template that you have created.
Mailing labels

If you print and send cheques, quotes, invoices, statements or personalised letters you may also want to print mailing labels that you can stick on the envelopes.

The Print Mailing Labels function in the Card File command centre prints your contact’s name and address on sheets of adhesive mailing labels. You customise the way mailing labels are printed, including their size, the number of labels per sheet and the margins. For information about customising mailing label forms, see ‘Customising forms’ on page 137.

To print mailing labels

1. Go to the Card File command centre and click Print Mailing Labels. The Review Labels Before Printing window appears.

   TIP: Print invoices and labels simultaneously When you print a batch of invoices using the Print/Email Invoices function in the Sales command centre, you can choose to print a label for each invoice.

2. Click Advanced Filters. The Advanced Filters window appears.

3. From the Selected Form for Mailing Label list, select the form template that best matches the size and layout of your labels and label sheets.

4. Make any other selections in the Advanced Filters window as required (for example, you may want to filter your contacts list to only those living within a specific postcode) and then click OK.

5. Click in the select column next to each contact for whom you would like to print a mailing label.

6. Click Print.

The contact log

The contact log enables you to keep a detailed log of all the phone calls you and your contacts make to each other, and any other type of correspondence.

For example, let’s say that you call a customer regarding an overdue invoice. You could create a log entry that records the date of the phone call, a summary of the outcome, and the date you will want to recontact them by if their invoice is still outstanding.

When a customer or supplier calls, you can use the contact log to retrieve a complete history of your business relationship with that contact.

To create a contact log entry

1. Go to the Card File command centre and click Contact Log. The View Contact Log window appears.

2. Enter the contact you are creating the log entry for in the Name list.

3. Click New. The Contact Log Entry window appears.

4. Complete the Contact Log Entry window as described in the following table.
To automatically create contact log entries

You can choose to automatically create log entries each time you record a sale or banking transaction. The log entry contains basic information about the transaction, such as the invoice number, cheque number and the amount.

1. Go to the Setup menu and choose Preferences. The Preferences window appears.
2. Click the Banking tab.
3. If you want to create an automatic contact log entry for each payment you record, select the Make Contact Log Entry for Every Cheque option.
4. If you want to create an automatic contact log entry for each receipt you record, select the Make Contact Log Entry for Every Deposit option.
5. Click the Sales tab.
6. If you want to create an automatic contact log entry for each sale you record (including quotes and orders), select the Make Contact Log Entry for Every Sale option.
7. Click OK to close the Preferences window.

To edit a contact log entry

1. Go to the Card File command centre and click Contact Log. The View Contact Log window appears.
2. In the Name field, enter the contact for whom you want to view the contact log.
3. Select the entry and click Edit, or click the zoom arrow next to it.
4. Make your changes and click Record.

Other ways to keep in touch

To send an email message to a contact

1. Go to the Card File command centre and click Cards List. The Cards List window appears.

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>The name of the contact. To view the contact’s card, click the zoom arrow.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contact</strong></td>
<td>Type the name of the person that is associated with this entry. For example, you can record the name of the person you spoke to on the phone. If you have specified a contact person in the contact’s card, you can click the down-arrow to choose that person.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Type the date you spoke to or wrote to the contact. If you are simply entering an appointment or reminder, you can enter today’s date.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>Enter any information you want to save about the conversation or follow-up.</td>
</tr>
<tr>
<td><strong>Elapsed Time</strong></td>
<td>If you want to record the time you spend speaking to the contact, or working on a particular task related to the entry, type the time in hours and minutes. For example, if you spend 15 minutes, enter 1.5. If you spend 1 hour and 15 minutes, enter 1:15.</td>
</tr>
<tr>
<td><strong>Recontact Date</strong></td>
<td>If you want to be reminded to follow up the contact, type or select the date you want to be reminded to recontact them. The reminder will appear in the Contact Alert tab of the To Do List on this date. For more information, see ‘Reviewing your contact information’ on page 160.</td>
</tr>
<tr>
<td><strong>Log</strong></td>
<td>View all contact log entries for the selected contact.</td>
</tr>
<tr>
<td><strong>New</strong></td>
<td>Record the current log entry and create a new entry for this or another contact.</td>
</tr>
</tbody>
</table>
2 Click the zoom arrow next to the name of the contact you want to email. The Card Information window appears.
3 In the Location field, select the address to which you want to send the email. For example, you may have a different email address stored for this contact under Address 2.
4 Click Email. The Email window appears.
   The Email Address field displays the name and email address from the card. You can change these if you wish.
5 Enter a subject and message, and then click Send. The email is sent via your email program’s outbox. Send the file from your email program as you normally do.

To access a contact’s website
1 Make sure your computer is connected to the Internet.
2 Open the card for the contact whose website you want to view.
3 In the Profile tab, click Website.
4 Your contact’s website will appear in your web browser.

View a contact on a map

To view a contact’s location on a map
1 Make sure your computer is connected to the Internet.
2 Open the card contact whose location you want to view.
3 Right mouse-click and choose Contact Card, then:
   - View in Google Maps™. Your web browser window will appear, showing the location of your contact on a street map.
   - View Directions. Your web browser window will appear, displaying a street map with directions from your primary business location to the contact’s address.

Grouping your contacts

You can group and sort your contacts according to common attributes by assigning identifiers to their cards and the appropriate attributes from custom lists you have defined.

Grouping contacts using these features makes it easier for you to:

- filter reports to show only information specific to a group of contacts
- identify which of your contacts have a particular attribute
- filter lists so that it’s easier for you to send a batch of personalised letters, customer statements and other forms to a group of contacts.

Identifiers

Identifiers are one-letter labels you can assign to cards.

When you create reports or view card lists, you can limit the information to a particular group of cards by specifying the identifiers that you’ve assigned to those cards.

For example, say you want to be able to identify all clients who are not-for-profit organisations. You could assign them identifier N and when printing sales reports you can choose to filter the report to show only customers who have that identifier.

You can also assign multiple identifiers to a card. For example, say you assign O to your overseas customers and W to your wholesale customers. If you have overseas wholesale customers you can assign
them the O and W identifiers. You can then filter a report to only show your overseas wholesale customers by specifying the OW identifiers in the Filters tab of the Report window.

To define identifiers
1. Go to the Lists menu and choose Identifiers. The Identifiers window appears. It provides a field for each letter of the alphabet.
2. Enter a description for as many identifiers as you want and click OK.

To assign identifiers to a card
1. Go to the Card File command centre and click Cards List. The Cards List window appears.
2. Click the zoom arrow next to the card you want to edit. The Card Information window appears.
3. Click the Card Details tab.
4. Click Identifiers. The Select Identifiers window appears.
5. Click next to the identifiers you want to assign to the card.
6. Click OK.

Custom lists
You can set up lists of predefined attributes and assign the appropriate attributes to your cards.
By assigning attributes from a custom list to your cards, you are able to group your contacts to a greater degree than is possible with identifiers.

For example, you could assign all your wholesale customers the W identifier. If you also set up a custom list containing each of your sales territories, and allocate those customers to the appropriate territory, you can then filter reports to only show information about wholesale customers who are within a particular sales territory.

To name a custom list
1. Go to the Lists menu, choose Custom Lists & Field Names, and then choose the card type for which you want to create a custom list, for example, Customers. The Custom List and Field Names window appears.

2. Enter names for the lists you want to create for the card type you selected. For example, enter ‘Sales territory’.
3. Click OK. The names you have entered will now appear in the Card Details tab of the Card Information window.
To create a custom list entry

1. Go to the Lists menu, choose Custom Lists and then choose the card type for which you want to create a custom list entry, for example, Customers. The Custom Lists window appears.

2. Select the custom list for which you want to create an entry. For example Sales territory.

3. Click New. The Custom List Information window appears.

4. Type the custom list entry’s name (for example, enter ‘City centre’, ‘Inner east’, etc.) and then click OK.

   The entry appears in the Custom Lists window.

To assign a custom list entry to a card

1. Go to the Card File command centre and click Cards List. The Cards List window appears.

2. Click the zoom arrow next to the card you want to edit. The Card Information window appears.

3. Click the Card Details tab.

4. Enter the list entry you want to assign to the card next to each custom list field. For example, select Inner east from the Sales territory field.

Synchronising cards with Microsoft Outlook contacts

You can synchronise your AccountRight cards and your Microsoft Outlook contacts. If your business uses Microsoft Outlook for email and to manage contact information, this will make it easier for you to keep both your AccountRight cards and your Outlook contacts up to date.

Your AccountRight cards are your customer, supplier, employee and personal cards stored in your AccountRight card file. Your Outlook contacts are your contacts stored in your Microsoft Outlook address book.

When you synchronise, the following details are imported or exported: company name or contact name, address details, email and web addresses and telephone, fax and mobile numbers.

When you synchronise your AccountRight cards and your Outlook contacts, you can:

- make the details in your Outlook contacts match the details in your AccountRight cards (by exporting your AccountRight cards to your Outlook contacts) or
- make the details in your AccountRight cards match the details in your Outlook contacts (by importing your Outlook contacts to your AccountRight cards).
If you are exporting your AccountRight cards to your Outlook contacts, you can also include your Card File custom fields in the export. When you do this, you specify how your custom fields match the Categories, Anniversary, Birthday or Spouse's name fields in your Outlook contacts. For information on setting up Card File custom fields see ‘Custom card fields’ on page 158.

**Synchronisation update rules**  
As part of the synchronisation process, you choose whether or not you want to update the details for existing contacts. To do this, you select from one of the following update rules:

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update existing contacts</td>
<td>New contacts are added and existing contacts are updated. You will not be prompted to confirm updates.</td>
</tr>
<tr>
<td>Do not update existing contacts</td>
<td>New contacts are added but existing contacts are not updated. You are not prompted to confirm any updates.</td>
</tr>
</tbody>
</table>
| Ask me to confirm updates  | New contacts are added and you are prompted to confirm updates. If you select this rule, you specify how you want to deal with the discrepancies between the details in your AccountRight cards and the details in your Outlook contacts. You can:  
- review and update the details for each contact  
- select to update all contacts (if you select this option, you will not be prompted to confirm any further updates) or  
- skip an update for a contact and leave the details for the contact unchanged. |

**NOTE:** Microsoft Vista requires administrator access privileges  
Before you can synchronise cards and Outlook contacts on Windows Vista, you need to log on as an administrator.

**Exporting your AccountRight cards to your Outlook contacts**

When you export your AccountRight cards to your Outlook contacts, your contacts are saved by default to group contact folders. For example, Customer contacts are saved to a folder called **MYOB Customers**.

If you want to synchronise your Outlook contacts and your Personal Digital Assistant (PDA) or mobile device, your contacts must be saved to the Microsoft Outlook default contacts folder. When you export your AccountRight cards to your Outlook contacts, you can select an option to save your contacts to the default contacts folder (see step 7 on page 154).

**CAUTION:** Back up your Outlook contacts  
Exporting your AccountRight cards to your Outlook contacts will change the details recorded in your Outlook contacts. Back up your Outlook contacts before synchronising. See your Microsoft Outlook documentation for instructions.

**To export your AccountRight cards to your Outlook contacts**

1. Go to the Card File command centre and click Cards List. The Cards List window appears.
2 Click **Synchronise Cards**. The **Synchronise Cards** window appears.

![Synchronise Cards window](image1.png)

3 Click **Next**. The **Import and Export Options** window appears.

![Import and Export Options window](image2.png)

4 Select the card types that you want to synchronise.

**NOTE:** You can synchronise cards from any of the Cards List views (Customer, Supplier, Employee and Personal). The default card type selected varies according to the tab you are on when you click **Synchronise Cards**.

5 If you want to include inactive cards in your synchronisation, select the **Export inactive cards** option. For information about inactive cards, see ‘Inactivating or reactivating a record’ on page 109.

6 Select a synchronisation rule from the **Update Rules** list. For more information, see ‘Synchronisation update rules’ on page 153.

7 If you want to save your AccountRight cards to your Outlook contacts default folder (you need to do this to synchronise your Outlook contacts and your PDA or mobile device), or if you want to export your AccountRight custom fields to your Outlook contacts, click **Settings**. The **Settings** window appears.

![Settings window](image3.png)

- If you want to synchronise your Outlook contacts and your PDA or mobile device, select the **Synchronise cards using the default Outlook contacts folder** option.

- If you want to export your AccountRight custom fields to your Outlook contacts, select a matching Outlook contact field for **Custom Field 1**, **Custom Field 2** and **Custom Field 3**.

- Click **OK**. The **Import and Export Options** window reappears.

8 Click **Export**. The export process starts. Depending on the version of Microsoft Outlook you use, and the synchronisation update rules you have chosen, the following messages and windows may appear:

<table>
<thead>
<tr>
<th>If this window appears...</th>
<th>...do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft warning message</strong></td>
<td>Select a period for your AccountRight software to access your Outlook contacts:</td>
</tr>
<tr>
<td>1</td>
<td>Select the <strong>Allow access for</strong> option.</td>
</tr>
<tr>
<td>2</td>
<td>Select a period from 1 minute to 10 minutes.</td>
</tr>
<tr>
<td>3</td>
<td>Click <strong>Yes</strong>.</td>
</tr>
</tbody>
</table>
When the export process is complete, the **Synchronisation results** window appears.

9  When the export process is complete, the **Synchronisation results** window appears.

10 Review the results.

<table>
<thead>
<tr>
<th>If this window appears...</th>
<th>...do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm Update</td>
<td>Select how you want to deal with each update.</td>
</tr>
<tr>
<td>Confirm Add</td>
<td>Select whether you want to add the card to your Outlook contacts or skip it.</td>
</tr>
</tbody>
</table>

11 If you want to view the log file that details the exported records, click the link in **Synchronisation results** window.

**Importing your Outlook contacts to AccountRight**

You can import your Outlook contacts to your AccountRight cards from either the default contacts folder, or from group contact folders created for each AccountRight card type.

However, before you import your Outlook contacts, you need to identify each contact as either a customer, supplier, employee or personal contact.

**NOTE**: **Blank fields in your Outlook contacts are not included in the import**  
If a field in your Outlook contact is blank but the corresponding field in your AccountRight card is complete, this field will be skipped during the import process. This ensures that blank fields don’t overwrite contact details recorded in your AccountRight cards.

**Importing from the default contacts folder**  
If you want to import your contacts to AccountRight cards from the default Outlook contacts...
folder, enter the card type for each contact in the **Categories** field of the **General** tab.

**Importing from group contacts folders**  
You need to save your contacts to group contact folders labelled MYOB Customer, MYOB Supplier, MYOB Employee and MYOB Personal. For instructions on how to set up group contact folders in your Outlook contacts, refer to your Microsoft Outlook documentation.

**Before importing your Outlook contacts**  
Check that the details recorded in your Outlook contacts are up to date and entered in the correct field.

**To import your Outlook contacts to your AccountRight cards**

1. Go to the **Card File** command centre and click **Cards List**. The **Cards List** window appears.
2. Click **Synchronise Cards**. The **Synchronise Cards** window appears.

**CAUTION:**  
**Back up your company file**  
Importing your Outlook contacts to your cards will change the details recorded in your company file. To avoid losing contact details stored in your company file, back up your company file before synchronising. For more information on backing up your company file, see ‘**Backing up and restoring company files**’ on page 186.

3. Click **Next**. The **Import and Export Options** window appears.
4 Select the card types that you want to synchronise.

**NOTE:** You can synchronise cards from any of the Cards List tabs (Customer, Supplier, Employee and Personal). The default card type selected will vary according to the tab you are on when you click Synchronise Cards.

5 Select a synchronisation rule from the Update Rules list. For more information, see ‘Synchronisation update rules’ on page 153.

6 If you want to import your Outlook contacts from the default Outlook contacts folder, click Settings. The Settings window appears.
   
   If you are importing your contacts from group contact folders, go to step 7 below.

   Select the option Synchronise cards using the default Outlook contacts folder and then click OK.

7 Click Import. The import process starts. Depending on the version of Microsoft Outlook you use, and the synchronisation update rules you have chosen, the following messages and windows may appear:

<table>
<thead>
<tr>
<th>If this message appears...</th>
<th>...do this</th>
</tr>
</thead>
</table>
| Microsoft warning message  | Select a period for your AccountRight software to access your Outlook contacts:  
   1. Select the Allow access for option.  
   2. Select a period from 1 minute to 10 minutes.  
   3. Click Yes. |

| Warning: Blank Outlook Contact Fields | This window appears if a field in your Outlook contact is blank and the corresponding field in the card contains data. The message is to notify you that the card fields will not be updated. Click Skip to continue the import process. |

8 Review the results.

<table>
<thead>
<tr>
<th>Summary field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>x cards added</td>
<td>The number of cards added or updated in AccountRight.</td>
</tr>
<tr>
<td>x cards updated</td>
<td>The number of cards updated but the details in your AccountRight cards may be incomplete.</td>
</tr>
<tr>
<td>x cards skipped, x cards rejected</td>
<td>The number of contacts you chose to skip (if you selected update rule Ask me to confirm updates) and the number of contacts that were not imported because they contained blank Outlook contact fields.</td>
</tr>
</tbody>
</table>

9 If you want to view the log detailing the imported records, click the link in the Synchronisation results window.
Customising cards

Custom card fields

If you need to record certain information about your contacts, but can’t find a suitable card field for it, you may want to set up a custom field.

For example, you could set up a field to record your customers’ birthdays or a field to record the dates of your employees’ most recent performance review.

You can set up three custom fields for each card type and label them according to your needs. You can then enter any information you like in those fields.

If you need to, you can customise a report to show Custom Field information.

To set up custom card fields

1. Go to the Lists menu, choose Custom List and Field Names and then choose the card type for which you want to set up a custom field, for example, Customers. The Custom List and Field Names window appears.
2. Type the names of the custom fields you want to set up for the card type you have selected in the Name of Custom Field fields. For example, you could enter ‘Birthday’ to record your contacts’ birthdays.
3. Click OK. The custom field names you entered will now appear in the Card Details tab of the Card Information window.

To enter custom field information in a card

1. Go to the Card File command centre and choose Cards List. The Cards List window appears.
2. Click the zoom arrow next to the card you want to edit. The Card Information window appears.
3. Click the Card Details tab and type the information you want to record in the appropriate custom field. For example, type 01/10/1970 in the Birthday field.

Card identification codes

If you have assigned identification codes (IDs) such as customer numbers or account numbers to your contacts, you can enter those IDs in their cards.

You can also set a preference that will let you select customers by their ID instead of their last name or company name when entering a transaction. Customer search lists will also be sorted by their ID when this preference is set. For more information, see ‘To select contacts using Card IDs’ on page 159.

NOTE: The Card ID preference affects all card types If you choose this preference, you have to select all card types by their IDs.
To enter an identification code
1  Go to the Card File command centre and click Cards List. The Cards List window appears.
2  Click the zoom arrow next to the card you want to edit. The Card Information window appears.
3  Enter a unique code of up to 15 alphanumeric characters in the Card ID field.
4  Click OK to save your changes.

To select contacts using Card IDs
1  Go to the Setup menu and choose Preferences. The Preferences window appears.
2  Click the Windows tab.
3  Choose the Select Cards by Card ID, Not Card Name option.
   You can now select cards by their IDs and your card lists will be sorted by ID instead of by last name or company name.

Card pictures

You can display a picture of your contact by importing a picture file to their card. The picture appears in the Card Details tab of the Card Information window.

NOTE: Supported picture formats  Pictures need to be saved in one of the following formats: bmp, jpg, tif, gif, or png.
Reviewing your contact information

There are several tools you can use to review your contact information.

<table>
<thead>
<tr>
<th>Tool</th>
<th>See</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Do List</td>
<td>The Contact Alert tab in the To Do List displays contact log entries with recontact dates on or before the current date.</td>
<td>below</td>
</tr>
<tr>
<td>Card reports</td>
<td>Card reports give you lists of contact information in several formats.</td>
<td>below</td>
</tr>
<tr>
<td>Find Transactions</td>
<td>Find Transactions helps you quickly find all transactions for a contact.</td>
<td>page 115</td>
</tr>
</tbody>
</table>

To view contact alerts

1. Click To Do List in any command centre. The To Do List window appears.
2. Click the Contact Alert tab. A list of all individuals and businesses you need to contact appears.

**NOTE:** Reminders that fall on a closed day If the recontact date falls on a day that you have indicated as being closed in the Business Calendar (accessible from the Setup menu), the reminder will appear on the business day prior to the recontact date.

The Overdue column shows how many days have elapsed since the recontact date you specified on the contact log entry.

To clear a reminder from the list, click in the select column next to the contact log entry and then click Remove.

To print card reports

1. Go to the Reports menu and choose Index to Reports. The Index to Reports window appears.
2. Click the Card tab and click a report group. The list of card reports appears.
3. Display or print the report that is appropriate to your needs.

Following is a list of the default information displayed in each report. If required, you can customise the reports to display more or less detail (for information on how to customise a report, see 'Customising reports' on page 127).

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card List</td>
<td>A list of your contacts with their phone numbers, current balances and identifiers.</td>
</tr>
<tr>
<td>Summary</td>
<td>A list of the recent transactions that were allocated to your contacts.</td>
</tr>
<tr>
<td>Card List Detail</td>
<td>A list of some of the information contained in your contacts’ cards, including Address 1 and Address 2.</td>
</tr>
<tr>
<td>Address List</td>
<td>The contact name, address and phone number entered for Address 1 in each card.</td>
</tr>
<tr>
<td>Card Transactions</td>
<td>A list of the transactions that have been allocated to your contacts for a selected period.</td>
</tr>
<tr>
<td>Contact Log</td>
<td>A list of the contact log entry details. The total of the elapsed time recorded in the log entries is displayed for each contact.</td>
</tr>
<tr>
<td>Identifiers</td>
<td>A list of the identifier codes and their descriptions.</td>
</tr>
<tr>
<td>GIS Card File</td>
<td>A list of contact information that you can import into a geographic information system (GIS) to analyse the location of your contacts.</td>
</tr>
<tr>
<td>To Do List – Overdue Contacts</td>
<td>A list of contact log entries with recontact dates that are dated on or before the day you specify in the report filter.</td>
</tr>
</tbody>
</table>
12 Financial control

You can control your finances by setting budgets, auditing your records and by reviewing and analysing your financial activities.

Tracking financial information

You can track financial information at two levels:

- **Accounts** level—view the profitability and financial details of your business as a whole.
- **Jobs** level—view the profitability and financial details of the individual jobs or tasks carried out for customers and clients.

Accounts

The accounts list could be set up to provide a basic overview of your business’s overall performance. For example, a car dealership might set up their accounts to distinguish new and used car sales, from service and parts income. The following income accounts could be used:

<table>
<thead>
<tr>
<th>4-0000 Income</th>
<th>[Header]</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-1000 Car Sales</td>
<td>[Header]</td>
</tr>
<tr>
<td>4-1010 New Car Sales</td>
<td>[Detail]</td>
</tr>
<tr>
<td>4-1020 Pre-owned Car Sales</td>
<td>[Detail]</td>
</tr>
<tr>
<td>4-2000 Service and Parts Income</td>
<td>[Header]</td>
</tr>
<tr>
<td>4-2010 Service Income</td>
<td>[Detail]</td>
</tr>
</tbody>
</table>

| 4-2020 Parts Income | [Detail] |
| 4-2030 Accessories Income | [Detail] |

When entering a transaction, the transaction amount is allocated to an appropriate account. A standard profit and loss statement can then be printed for the business to show income and expenses generated by the business.

**Setting up accounts** You can set up your accounts using the Easy Setup Assistant or in the Accounts command centre (see ‘Setting up accounts’ on page 32).

Jobs

Jobs can be set up to track income and expenses related to service jobs. This is particularly useful when multiple jobs are performed for a single customer. When you enter a transaction, the appropriate job number can be assigned to each individual amount. This enables you to associate several jobs with the various amounts in a single transaction.

For example, if a sale includes parts for three different jobs, you can specify these jobs on the invoice. A profit and loss statement can then be prepared for each job.
Specific job-tracking tasks include:
- linking jobs to specific customers
- assigning jobs to individual line items on transactions
- analysing the profit and loss of a job.

To create a job
1. Go to the Lists menu and choose Jobs. The Jobs List window appears.
2. Click New. The Job Information window appears.
3. Type a code for the job in the Job Number field and press Tab.
4. Enter additional information about the job, such as a job name and description.

5. If you want to link the job to a customer, enter a customer in the Linked Customer field. This allows you to select the job when you create invoices for this customer.
   You can view details of all jobs linked to a customer in the Jobs view of the customer’s card.
6. Click OK. The Jobs List window reappears.
7. Review the jobs you have created. If you need to change the details of a job, select the job and click Edit.

To enter opening balances for jobs
If you started using your AccountRight software while a particular job was in progress, you can create the job and then enter any account activity generated by the job so far in the Job Opening Balances window.
1. Go to the Setup menu, choose Balances and then Job Opening Balances. The Job Opening Balances window appears.
In the **Job Number** field, enter the job for which you want to enter an opening balance.

In the **Opening Balances** column, type the opening balances for each account.

Repeat from step 2 for each job with an opening balance.

Click OK when you have finished.

---

**To analyse the profit and loss of a job**

You can use the Jobs Profit & Loss report to view the profit and loss of selected jobs.

1. Go to the **Reports** menu and select **Index to Reports**. The **Index to Reports** window appears. Click the **Accounts** tab.
2. In the list of reports that appears in the left column, locate the **Jobs** subheading, then select **Job Profit & Loss Statement** in the list below it.
3. Click **Display**. The **Report** window appears.
4. In the **Filters** tab, select the jobs to include in the report.
5. If you want to view the combined profit and loss for the selected jobs, select the **Consolidated** option.
6. Select the range of dates for which you want to produce the report.
7. Click **Refresh Report**. The filtering options you have selected are applied to the report.
8. If you want to print the report, click the **Print icon ( )** in the toolbar at the top of the **Report** window.

---

**Budgets**

When you prepare a budget, you are predicting the financial state of your business. For example, you could prepare a budget that predicts how much you intend to spend and earn over the next financial year. Having a budget means that, as the year progresses, you can track projected data against actual data and take corrective action if things are not going according to plan.

You can also use budgets to plan for future goals. For example, you may want to undertake a new business venture in the coming year. By creating a budget, you can work out the amount of money you will need for the venture, where this money will come from and the impact that the venture will have on other aspects of your business.

**What do I need to budget?** You can enter budgets for individual detail accounts. The accounts that require a budget will vary according to your business. Most people prepare budgets for **Profit and Loss** accounts such as Income, Cost of Sales and Expenses accounts, and **Balance Sheet** accounts for specific assets and liabilities. To decide on the accounts that will require a budget, consider what changes you anticipate in your business and the financial impacts these changes will have. For example, you may be considering taking out a new loan (which will affect your Bank Loans account).

**What period can I budget for?** You can create a budget for the current financial year and the next financial year.
**Reviewing your budget**  You can review your budgets periodically to track your financial progress and see if it is going to plan. A slight variation from the budget is normal. Large variations, on the other hand, may need investigation. For example, if you have a large increase in accounts receivable, it may indicate that your customers are taking a longer time than expected to pay your account.

You can compare your budgeted amount with actual account balances by viewing the Budget Analysis reports for Balance Sheet and Profit and Loss accounts. For information on displaying, customising and printing reports, see Chapter 9, ‘Reports,’ starting on page 125.

### Entering budget amounts

You can use the Prepare Budgets window to enter budget amounts for each month of the current or next financial year. See ‘To enter the budget for an account’ below.

If you want to quickly enter budget amounts for a group of months, you can use the Budget Shortcuts window. See ‘To enter a budget using the Budget Shortcuts window’ on page 165.

As the year progresses, you can choose to either adjust budget figures or leave them unchanged.

**Entering positive and negative amounts**  By default, the amount you enter will be assumed to be a positive amount. You can enter negative budget amounts—for example, to indicate an end of month balance change in balance sheet type accounts—by inserting a hyphen before the amount (for example, -250). When you enter a negative amount, you are indicating that the balance of the account is going to reduce.

**Using existing data**  If you have already prepared a budget in a spreadsheet or in other software, you may be able to import that information into your company file. For more information on how to import account budgets, see ‘Importing data’ on page 195.

You can also use the previous financial year’s data as a basis for your budget.

### To enter the budget for an account

1. Go to the **Accounts** command centre and click **Accounts List**. The **Accounts List** window appears.
2. Click **Budgets**. The **Prepare Budgets** window appears.
   The window lists the Profit and Loss accounts by default.
3. From the **Financial Year** list, choose whether you want to enter a budget for this financial year or the next one.
4. From the **Account Type** list, choose the type of account you want to enter a budget for—Profit and Loss or **Balance Sheet**.
5. For each month, click in the appropriate cell and enter the amount.
   If you want to enter a negative amount, insert a hyphen before the figure (for example, -250).

   As you enter data, the **FY Total** column will display the total budget for each account.
5 From the **Budget for** list, select a time period.

![Budget Shortcuts window](image)

The fields change according to the period you select.

<table>
<thead>
<tr>
<th>Select...</th>
<th>If you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Month</td>
<td>Enter the same amount for every month of the year or a set increase or decrease every month (starting from a base amount).</td>
</tr>
<tr>
<td>Period starting from selected Month</td>
<td>Enter a total amount for a group of consecutive months.</td>
</tr>
<tr>
<td>Each Quarter</td>
<td>Enter the total amount for each quarter.</td>
</tr>
<tr>
<td>Each half of the Financial Year</td>
<td>Enter the total amount for each half of the year.</td>
</tr>
<tr>
<td>Financial Year yyyy</td>
<td>Enter the total amount for the entire financial year, (where yyyy is your financial year).</td>
</tr>
</tbody>
</table>

6 Enter the budget amounts in the appropriate fields. Amounts that cover more than one month (such as quarterly, half-yearly and yearly amounts, and amounts for a group of months) will be divided equally among all the months in the group.

If you selected the **Each Month** option, you can also set a base budget amount for the first month, and the amount or percentage by which this will vary every month onwards.
When you have finished entering the information, click OK. The Prepare Budgets window appears with the new amounts.

If the account already has budget figures, a message appears asking if you want to replace the existing budget. Click Yes to replace the budget, or No if you want to keep the existing amounts (if you click No, click Cancel to return to the Prepare Budgets window).

If you have not entered any amounts for the budget, a message appears asking if you want to enter zero amounts. Click Yes if you want to do this, or No if you want to change the amounts.

---

### Reviewing financial information

There are tools that you can use to review your financial information.

<table>
<thead>
<tr>
<th>Tool</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Insights</td>
<td><strong>Business Insights</strong> enables you to analyse information about your accounts and your profitability. See below</td>
</tr>
<tr>
<td>Financial reports</td>
<td>Financial reports help you review your financial information. See page 167</td>
</tr>
</tbody>
</table>

#### Business Insights

Business Insights enables you to analyse key financial information using a range of interactive tables and graphs. You can use it to analyse your accounts, profit and loss and the money that customers owe you. You can open Business Insights from any command centre.

The Business Insights window presents different types of financial information in a series of tabs. From these tabs, you can open other windows, such as the Accounts List, Prepare Budgets, Card List or Sales Register windows.

You can sort the information in tables by clicking in the relevant table column heading. For example, you can sort the list of your accounts by account name or type.

You can also save a graph or table as an image so you can use it in another document. To do this, right-click it and choose:

- **Copy to Clipboard.** This copies the graph or table to the clipboard, ready to paste into a document.
- **[Graphs only] Save As.** Choose where you want to save the image and click Save. This saves the graph as an image file, so you can use it later.

If you want to customise the look of Business Insights, click Customise. The Customise window appears, enabling you to show or hide information in Business Insights.

#### About the Business Insights tabs

- **Profitability Details** This tab displays graphs comparing income and expenses, the cumulative profit and loss and the budgets and actuals of your top ten expenses.

You can use this information to:

- **Compare income against expenses** You can compare the profit and loss of your previous financial year against your current one, and project your profit and loss for the next financial year.

- **Identify excessive spending and budget blowouts** Compare the actual balances of cost of sales accounts against their budgets.

- **Customer Analysis** For more information about analysing sales, see ‘Reviewing your sales information’ on page 94.
**Account Details**  This tab displays the balances of your bank and credit card accounts and shows your total assets and total liabilities.

You can use this information to:
- **Identify excessive debt**  Compare assets against liabilities.
- **Organise your funds**  Check the liquidity of your assets; prioritise your liability repayments.
- **Check account balances**  Before making a large payment, ensure that the account it is drawn from has sufficient funds.

**To view financial reports**

1. Go to the Reports menu at the top of the screen and choose Index to Reports. The Index to Reports window appears.
2. Click the Accounts tab.

There are several account reports that can help you track your financial information. These reports are listed below.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profit &amp; Loss Statement</strong></td>
<td>Shows your profit and loss figures.</td>
</tr>
<tr>
<td><strong>Balance Sheet</strong></td>
<td>Reviews your financial position as of the end of a period.</td>
</tr>
<tr>
<td><strong>Trial Balance</strong></td>
<td>Identifies amounts incorrectly entered. When reviewing this report, check for:</td>
</tr>
<tr>
<td></td>
<td>• entries that seem unusually high or low for the account that has been affected</td>
</tr>
<tr>
<td></td>
<td>• debit amounts for accounts that normally have credit entries and vice versa</td>
</tr>
<tr>
<td></td>
<td>• unusually high or low ending balances</td>
</tr>
<tr>
<td></td>
<td>• an unusually high or low number of entries for a specific account.</td>
</tr>
</tbody>
</table>

**Balance Sheet**  Lists account balances as at the end of a selected period, along with the budgeted amounts for them. If you’ve determined that changes need to be made to the amounts you’ve budgeted for the coming months, you can adjust your budget.

**Profit & Loss Budget Analysis**  Lists account balances for a selected period, along with the budgeted amounts for them. If you’ve determined that changes need to be made to the amounts you’ve budgeted for the coming months, you can adjust your budget.

For information on displaying, customising and printing reports, see Chapter 9, ‘Reports,’ starting on page 125.

**Company Data Auditor**

The Company Data Auditor allows you to check the accuracy of the records in your company file. You can use this tool to perform maintenance tasks and reconcile bank or credit card accounts.

The Company Data Auditor also checks your transactions for exceptions such as invoices that do not reconcile with your receivables account, and future-dated transactions. For more information on how to use the Company Data Auditor, see ‘Run the Company Data Auditor’ on page 170.
End-of-period procedures

It is important to ensure that your accounting records are accurate. Reconciling the accounts regularly will assure you and your accountant that your books are complete, accurate and balanced.

Month-end procedures  You should reconcile your company file information with any source documents and resources available to you. For example, each month your bank account can be reconciled with your bank statement and your customers’ balances can be verified. Typical end-of-month procedures include reviewing your trial balance, reviewing your budgets and cash flow and sending out customer statements.

Year-end procedures  End-of-year procedures need to be carried out to prepare your company file for the coming year. These include any adjustments you need to make to your company file so that it agrees with your accountant’s final records before you start a new year. By closing the year in your company file, you are effectively bringing the company file up to date.

Month-end procedures

The following is a list of tasks we suggest you complete at the end of each month. Depending on the nature of your business, some of these tasks may not apply to you.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run the Company Data Auditor page 170</td>
</tr>
<tr>
<td>2</td>
<td>Reconcile bank accounts page 172</td>
</tr>
<tr>
<td>3</td>
<td>Review reports page 172</td>
</tr>
<tr>
<td>4</td>
<td>Send customer statements page 173</td>
</tr>
<tr>
<td>5</td>
<td>Record depreciation page 174</td>
</tr>
<tr>
<td>6</td>
<td>Prepare your GST return page 175</td>
</tr>
<tr>
<td>7</td>
<td>Lock periods page 176</td>
</tr>
</tbody>
</table>
Task 1: Run the Company Data Auditor

The Company Data Auditor is a series of windows that guide you through the process of checking and ensuring the accuracy of the records in your company file. You can use the auditor to:

- display basic information about the company file, such as the file name, release number, location, lock periods, last backup date, etc.
- perform maintenance tasks, such as back up your company file and set lock periods
- display bank and credit card account details, including the current balance and the date when they were last reconciled
- reconcile your bank and credit card accounts.

1 Go to the Accounts command centre and click Company Data Auditor. The Company File Overview window appears.

This window shows you:
- the company file name
- the AccountRight release version
- the location of the company file
- the date on which the company file was last backed up
- the end month and year of the current financial year
- the locked period date, if one has been specified.

If necessary, you can perform the following maintenance tasks from this window:

<table>
<thead>
<tr>
<th>To...</th>
<th>Do this...</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back up your company file</td>
<td>Click Back Up and complete the backup procedure.</td>
<td>page 186</td>
</tr>
<tr>
<td>Set a locked period for your company file</td>
<td>Click Lock Period and select the date defining the locked period (that is, a period before which data cannot be entered).</td>
<td>page 176</td>
</tr>
</tbody>
</table>

2 When you have completed the required maintenance tasks, click Next. The Account Reconciliation Review window appears.

This window shows you:
- your bank and credit card accounts
- the balance of each account
- the date on which each account was last reconciled.

3 If you want to reconcile an account, select the account and click Reconcile Accounts. For information on how to reconcile your accounts, see ‘Reconciling your bank accounts’ on page 82.
4 Click Next. The Data Exception Review window appears.

5 Enter the start date and end date of the period you want to review.

6 Click Run Review to start the transaction review of the following:

<table>
<thead>
<tr>
<th>Review task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconcile invoices with the linked receivables account</td>
<td>The total of all customer balances is compared to the current balance of the linked receivables account. If there is an out-of-balance amount, click Display to view the Receivables Reconciliation Exceptions report and analyse the details of the report.</td>
</tr>
<tr>
<td>Scan for future-dated transactions</td>
<td>The company file is checked for any transactions dated later than the current date. If there are such transactions, click Display to view the Future Dated Transactions report and analyse the details of the report.</td>
</tr>
<tr>
<td>Scan for prepaid transactions</td>
<td>The company file is checked for any prepaid transactions. These transactions include all customer payments (excluding deposit payments) that have a payment date prior to the date of the invoice. If there are such transactions, click Display to view the Prepaid Transactions report and analyse the details of the report.</td>
</tr>
</tbody>
</table>

7 When you have finished viewing and, if necessary, printing the transaction review reports, click Next. The GST Exception Review window appears.

8 Enter the start date and end date of the period you want to review.

9 Click Run Review to do the following:

<table>
<thead>
<tr>
<th>Review task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check for GST amount variances [Sales]</td>
<td>The company file is checked for variations between the GST amount posted and the GST amount calculated for the GST codes assigned to sales transactions. If a variance is found, click Display to view the GST Amount Variance report and analyse the details of the report.</td>
</tr>
<tr>
<td>Check for GST exceptions [Invoice Transactions]</td>
<td>The company file is checked for sale and purchases transactions without a GST code assigned or where the entered GST code is different to the default GST code. If such a transaction is found, click Display to view the GST Code Exceptions—Invoice Transactions report and analyse the details of the report.</td>
</tr>
</tbody>
</table>
Click **Finish**. A message appears asking if you would like to print a summary report of the audit findings. Click **Yes** to print the report or click **No** to close the Company Data Auditor without printing the report.

### Task 2: Reconcile bank accounts

To ensure the accuracy of your business records, you should keep your record of each bank account balance matched up with your bank’s records. For details on reconciling, see ‘Reconciling your bank accounts’ on page 82.

### Task 3: Review reports

There are several reports that we recommend you review at the end of each month. You can use these reports to identify and correct any discrepancies in your records, as well as spot any trends in your business.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts List [Summary]</td>
<td>Lists all accounts and their balances. Make sure you set the report filters to print account balances.</td>
</tr>
<tr>
<td>Receivables Reconciliation Summary</td>
<td>Lists all your outstanding receivables.</td>
</tr>
<tr>
<td>Analyse Sales—Customer</td>
<td>Lists your company’s sales activity and trends on a month-by-month basis.</td>
</tr>
<tr>
<td>Items List Summary</td>
<td>Shows a list of your items, including current selling price.</td>
</tr>
<tr>
<td>Profit &amp; Loss Statement</td>
<td>Displays your profit and loss figures.</td>
</tr>
<tr>
<td>Balance Sheet</td>
<td>Displays your financial position as of the end of a month.</td>
</tr>
<tr>
<td>Trial Balance</td>
<td>Use this report to identify incorrectly entered amounts. When reviewing this report, check for:</td>
</tr>
<tr>
<td>Balance Sheet [Multi-Period Budget]</td>
<td>Lists account balances as at the end of a selected month, along with the budgeted amounts for them. If changes need to be made to the amounts you’ve budgeted for the coming months, adjust your budget.</td>
</tr>
<tr>
<td>Profit &amp; Loss [Multi-Period Budget]</td>
<td>Lists profit and loss account balances for a selected period, along with the budgeted amounts for them. If changes need to be made to the amounts you’ve budgeted for the coming months, adjust your budget.</td>
</tr>
</tbody>
</table>

#### Review task

<table>
<thead>
<tr>
<th>Review task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check for GST exceptions [Cash Transactions]</td>
<td>The company file is checked for Spend Money and Receive Money transactions without a GST code assigned or where the entered GST code is different to the default GST code. If such a transaction is found, click Display to view the GST Code Exceptions—Cash Transactions report and analyse the details of the report.</td>
</tr>
<tr>
<td>Reconcile GST code details with linked accounts</td>
<td>The company file is checked for variances between the balance of the linked GST accounts and the amount of GST that has been collected and paid on transactions. If variances are found, click Display to view the GST Code Reconciliation Exceptions report and analyse the details of the report.</td>
</tr>
</tbody>
</table>

10
Task 4: Send customer statements

Most businesses send statements to customers who have outstanding balances at the end of a month. You can print or email the statements.

To print a customer statement

1. Go to the Sales command centre and click Print/Email Statements. The Review Statements Before Delivery window appears.
2. Click the To Be Printed tab.
3. In the Statement Type field, select the type of statement you want to print.
   - Invoice statements list all invoices aged as at a specified date.
   - Activity statements list all sales invoices and payments with a customer deposit within a specified date range. Activity statements include a running account balance.
4. Specify the statement period.
   - If you selected Invoice as the statement type, enter an ageing date to display invoices outstanding as at that date. If you want to include only invoices recorded up to the statement date, select the Only include invoices up to Statement Date option.
   - If you selected Activity as the statement type, enter the statement date range in the From and To fields.
5. Type the number of statements you want to print per customer in the Print field.
6. If you want to filter the statement information or change the type of form the statement will be printed on, click Advanced Filters and make your selections. For more information, see ‘Customising how you send form batches’ on page 136.
7. Click in the select column (✓) next to the customers you are printing statements for.
8. Click Print.

To email a customer statement

1. Go to the Sales command centre and click Print/Email Statements. The Review Statements Before Delivery window appears.
2. Click the To Be Emailed tab.
3. In the Statement Type field, select the type of statement you want to email.
   - Invoice statements list all invoices aged as at a specified date.
   - Activity statements list all sales invoices and payments a customer deposit for a specified date range. Activity statements include a running account balance.
4. Specify the statement period.
   - If you selected Invoice as the statement type, enter an ageing date to display invoices outstanding as at that date. If you want to include only invoices recorded up to the statement date, select the Only include invoices up to Statement Date option.
   - If you selected Activity as the statement type, enter the statement period in the From and To fields.
5. If you want to filter the customer list or select a different statement form, click Advanced Filters and make your selections. For more information, see ‘Customising how you send form batches’ on page 136.
6. Click in the select column (✓) next to the customers to whom you want to email statements.
If you want to change a customer’s email address, select the customer’s name and then select another address from the Email Address list or type a different address in the Email Address field at the top of the window.

A message appears asking if you would like to update the employee's card. Click Yes if you want to update it or No if this is a temporary change.

Type the subject and message of the email or accept the default subject and message. If you want to change the default message, click Email Defaults and make the changes as appropriate.

Click Send Email.

Task 5: Record depreciation

Your company’s vehicles and equipment lose value each year. Part of the cost of vehicles and equipment can be allocated as an expense to your company each year you benefit from their use. The allocation of the cost of a piece of equipment over its useful life is called depreciation.

There are several methods of recording depreciation. Consult your accountant to see which method is best for you.

NOTE: If you depreciate your assets at the end of the financial year, make this step a part of your end-of-year routine. Consult your accountant for information on when to depreciate your assets.

Depreciation isn’t calculated automatically, but you can record your depreciation figures with a journal entry.

To record depreciation

Before you can record depreciation for an asset, you need to create an asset account and an expense account for each type of asset you depreciate. You only need to create these accounts once.

1. Create a new asset account for each type of asset you depreciate.
   Add the words ‘Accum. Depr.’ (for Accumulated Depreciation) at the beginning of each new account name. Give the new account a number that allows it to come after its corresponding asset account in the accounts list. For more information on creating a new account, see ‘Setting up accounts’ on page 32.

In the following example, we have a header account, Motor Vehicles numbered 1-2300, and a detail account Motor Vehicles At Cost numbered 1-2310. We have created a new asset account called Accum. Depr. Motor Vehicles numbered 1-2320. Notice that the header account shows the current book value of the vehicle.

2. Create a new expense account. You may want to call it Depreciation.

3. Once you’ve determined your depreciation amounts, make journal entries to credit the new accumulated depreciation asset account (for example, the Accum. Depr. Motor Vehicles account) and debit the new depreciation expense account. The accumulated depreciation asset accounts will always have a negative balance to show a reduction in the value of the depreciable assets.
Task 6: Prepare your GST return

Many businesses are required to submit their GST returns monthly, two-monthly or six-monthly. Regardless of your reporting frequency, you can use the Prepare GST Return function to fill out your GST return.

There are several tasks you should complete in preparation to lodge your first GST return. These are detailed below.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Review your GST codes setup.  
The GST return report relies on the setup of your GST codes to complete the report fields. You need to make sure that your GST codes are set up correctly before generating this report.  
For example, make sure that you have selected the GST Code is Reported on GST Return option for zero-rated GST codes and deselected the option for exempt GST codes in the GST Code Information window for these codes. See ‘Setting up GST codes’ on page 106 for more information on creating GST codes. |
| 2    | Enter your GST return information.  
You enter your GST return information in the Prepare GST Return window (click Prepare GST Return in the Accounts command centre).  
Some of the information you can set up includes your accounting basis, reporting frequency and the accounts that you use to track GST adjustments (for boxes 9 and 13 on the return). |

**TIP**: Other GST reports  
There are several GST detail reports available in the Index to Reports window. You may also want to review these reports before preparing your GST return. For more information about reports, see ‘Producing reports’ on page 125.

After you have completed the steps listed above, you can prepare your GST return.

**To prepare your GST return**

1. Go to the Accounts command centre and click Prepare GST Return.  
The Reporting Period window appears.
2. Select the last month of your reporting period.

3. If you have recorded end-of-year adjustments and you want to include them in your return, select the Include Year-End Adjustment transactions in report option.

4. Select the GST reporting period and select the GST accounting basis which your business uses to report GST. This is the accounting period and basis chosen by your business when you registered for GST. If you are unsure which basis your business uses, find out from your accountant or the Inland Revenue Department.

5. Select the accounts you use to record GST Output and GST Input adjustment activity.

6. Click Preview GST Return. The Print Preview window appears, displaying your GST return information.

7. If the information on the report is correct:  
   a. Click Print to print a copy of the report.  
   b. Copy the values from the report to the GST return form provided by Inland Revenue.

8. If you need to edit your GST return information, click Close to return to the Prepare GST Return window.
Task 7: Lock periods

After you have completed your month-end tasks, you should lock that period using the Lock Periods feature. This will prevent anyone from inadvertently making an entry in a period in which you don’t want new entries. To do this:

1. Go to the Setup menu and choose Preferences. The Preferences window appears.
2. Click the Security tab.
3. Select the Lock Periods: Disallow Entries Prior to option, and select the relevant date.

This selection places a temporary lock on the date you select and the period before it. If you need to make an entry in a locked period at a later time—for example, you locked 31st of May, and now want to make an entry in April—you can unlock that date in the Preferences window.

Closing a financial year

This section describes the tasks you should perform at the end of your financial year. However, you don’t need to close your financial year at any particular time. You can continue to use your company file after the last month of your current financial year.

Complete the tasks listed below to close your financial year and start a new one.

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Complete month-end tasks</td>
</tr>
<tr>
<td>2</td>
<td>Provide information to your accountant</td>
</tr>
<tr>
<td>3</td>
<td>Enter end-of-year adjustments</td>
</tr>
<tr>
<td>4</td>
<td>Back up your company file</td>
</tr>
<tr>
<td>5</td>
<td>Close the financial year</td>
</tr>
</tbody>
</table>

Task 2: Provide information to your accountant

Once you have completed your year-end tasks, you can send your accounting data to your accountant. If your accountant uses MYOB Accountants Office, you can export your accounts list, journal entries and sales directly to your accountant as a text file. This file can be sent by email or saved to disk.

We also recommend you print the following reports:
- Profit & Loss [With Year to Date]
- Balance Sheet
- Trial Balance
- Receivables Reconciliation [Summary]
- GST reports
- Account Transactions (only if your accountant wants to review each and every transaction you’ve entered in the company file during a particular period).

In addition to these, print any other report your accountant may request.

Task 1: Complete month-end tasks

Make sure you complete each of the month-end tasks. See ‘Month-end procedures’ on page 169.
You can also export your accounting data to other accounting packages using the export function.

To export information to MYOB Accountants Office

1. Go to the Accounts command centre and click Send to MYOB Accountants Office. The Reporting Period window appears.

![Reporting Period Window]

2. Select the month or range of months you want to export. To select a range of months, click and hold the mouse button on the first required month and then drag the cursor over the names of the remaining months.

   **CAUTION:** Choose the reporting months carefully. It is important not to include dates you have included in a previous export because this would result in double-counting your transactions. As a precaution, we recommend that you tell your accountant the periods you have selected.

3. Select the type of information to be provided from the Information required list.

4. Select the method you want to use to send the information.

   **Email**—If you want to email the file:
   a. Enter your accountant’s card in the Linked Card for Accountant field and then click Email. The Email window appears.

The export file is automatically attached to the email. The file is called `companyname.MYE`. A .zip file of the reports is also attached.

   a. If you want, you can change the email address and edit the subject line.

   b. Click **Send**.

   **Disk**—If you want to save the file to disk:
   a. Click Disk. The Save As window appears.

   b. Enter a name and location for saving the export file. The default file name is `companyname.MYE`. You can change the file name if you want but you must retain the ‘MYE’ extension. A .zip file of the reports is also saved.

   b. Click **Save**.

**Task 3: Enter end-of-year adjustments**

Your accountant is likely to provide you with a number of adjustments that will need to be entered in your company file as journal transactions. If the adjustments have been provided on paper, you can manually enter them in the Record Journal Entry window.

If you send information to your accountant using the Send to Accountant feature (see Task 2: Provide information to your accountant), you can import the adjusting journal entries your accountant sends you. Make sure your accountant has sent you the journal adjustment file as a text file with a .txt extension. For more information about importing journal entries, see ‘Importing data’ on page 195.

**To record adjustments manually**

1. Go to the Accounts command centre and click Record Journal Entry. The Record Journal Entry window appears.

   The general journal number and transaction date appear by default. You can change these if necessary.
2 Select the **Year-End Adjustment** option to identify the transaction as an adjustment journal entry. When you prepare reports for the period, you can exclude these adjustments from appearing.

3 [Optional] In the **Memo** field, enter a comment to describe the transaction, for example, ‘EOY adjustment from accountant’.

4 Each row of information entered in the scrolling list is a line item. The line item details are identified in the journal adjustments provided by your accountant.

   For each line item:

   a Type the account number (or name), or select it from the account list.

   b In the **Debit** and **Credit** fields, enter the debit or credit amount for the line item.

   c [Optional] In the **Job** field, enter the job number for the line item.

   d [Optional] In the **Memo** field, enter a description of the line item.

   e If necessary, change the default code in the **GST** column by typing the required GST code or selecting it from the list.

   **NOTE**: **Journal entry must be balanced** The journal entry cannot be recorded until the **Out of Balance** field is zero.

5 Click **Record** to record the journal entry.

### Task 4: Back up your company file

Make a backup of your company file after you have finished entering adjustments and store it in a safe location. See ‘Backing up and restoring company files’ on page 186.

---

### Task 5: Close the financial year

Before closing a financial year, make sure you have:

- completed tasks 1 to 4 of the ‘Closing a financial year’ procedure.
- entered all transactions and adjustments as instructed by your accountant
- checked with your accountant to ensure no further entries are required in the company file for the current year.

If you have done all of the above, you are now ready to close the financial year. Note that you can’t enter new or edit existing transactions in a financial year once you have closed it.

When you close a financial year:

- The monthly totals for all accounts are changed to **last year** categories. If **last year** amounts already existed, those amounts will be replaced.

- The balance of your current-year earnings account is transferred to your retained earnings account.

- The balances of your income, cost of sales, expense, other income and other expense accounts are returned to zero.

#### To close a financial year

1 Go to the **File** menu and choose **Close a Financial Year**. The Close a Financial Year Assistant opens.

2 Follow the on-screen instructions.

   If you need help in any of the windows, click **Help** and then choose **Help for This Window**.
14 Managing user accounts and company files

This chapter explains how you can perform maintenance tasks on your company file and how you can control access to your company file using user accounts.

Manage users

Controlling who can access your company files and what degree of access they have is vital to keeping your data secure.

As employees leave or change their roles within your business, their access to your data will also need to be changed or removed.

This section explains how to:
- Change company file details
- Remove user access
- Change a user’s online access
- Check a user’s online status

Change company file details

You can manage each user’s sign-on details and change their role (the parts of the company file they can use), from within each company file. You might do this if a user has forgotten their password and needs you to reset it, or if a person has new responsibilities within your business.

To change a user’s role

1. Go to the Setup menu and choose Users. The User Access window appears.
2. In the user list, select the user whose role you want to change.
3. In the Roles section of the window, select or deselect the role you want this user to have. Note that users can have more than one role.
   For more details about each role, press F1 to open the help topic.
4. Click Save.
5. If you are prompted to change this user’s access to the online file, select the appropriate option. For more information, see ‘Change a user’s online access’ on page 180.
6. Click Close.

To reset a user’s company file password

1. Go to the Setup menu and choose Users. The User Access window appears.
In the user list, select the user whose password you want to change.

Enter the new password in the Password and Confirm Password fields.

Click Save.

Contact the user and tell them their new password. They can change this password the first time they sign on.

Remove user access

After an employee leaves your company, or if you have given someone short-term access to your online company file, you need to remove their access.

You can remove their company file access, which will prevent them from signing on to the file. But you may also want to remove online access to a file (or files).

To remove a user’s access

1. Go to the Setup menu and choose Users. The User Access window appears.
2. In the user list, select the user whose access you want to remove.
3. Click the Inactivate User option.
4. Click Save.
5. If you are prompted to change this user’s online access, select the appropriate option. For more information, see ‘Change a user’s online access’ below.

Note that inactivating a user prevents them from signing on to a company file. So even if they still have active online access, they will not be able to sign on to edit this company file.

6. If you chose to change their online access to the file at step 5:
   a. When prompted, log in to my.MYOB.
   b. In the Manage online access page, find the user in either the Online file access or Online administrator access list.
   c. Click Remove Access. The user is removed from the list.

An email will be sent to this user, advising them their access has been removed.

Change a user’s online access

There are two levels of online access:

- Online file user—this user can access the company files they are invited to use.
- Online administrator—this user can access all company files under a software serial number, and can invite file users to work with these company files. They can also work offline with files (check out) and manage the AccountRight Live subscription associated with the files.

As people within your business change roles, the type of access they have to AccountRight Live and the tasks you need them to perform in relation to your company files might also need to change.

To make a file user an online administrator

1. Go to the Setup menu and choose Users. The User Access window appears.
2. Click the Online Access button.
3. If prompted to log in to my.MYOB, log in. The Manage online access page opens in your browser.
4. Click Invite new online administrator. The invitation window appears.

   Note that you do not need to remove their file user access to invite them as an administrator.

5. Enter their email address, first name and last name.
6. Click Invite. The Manage online access page reappears with a confirmation message at the top.

   An email will be sent to this user, inviting them to become an online administrator. To monitor if or when they accept the invitation, see ‘Check a user’s online status’, on page 181.
To make an online administrator a file user

1. Go to the Setup menu and choose Users. The User Access window appears.
2. Click the Online Access button.
3. If prompted to log in to my.MYOB, log in. The Manage online access page opens in your browser.
4. Find the user in the Online administrator access list and click Remove access. The user is removed from the list.
5. Click Invite new online file user. The invitation window appears.
6. Enter their email address, first name and last name.
7. Click Invite. The Manage online access page reappears with a confirmation message at the top.
   Two emails will be sent to this user. One advises that their administrator access is cancelled, the other invites them to become a file user.
   To monitor if or when they accept the invitation, see ‘Check a user’s online status’ below.

To cancel an invitation

If you invite a person to be an online file user or administrator by mistake, you can cancel the invitation before it is accepted.

1. Go to the Setup menu and choose Users. The User Access window appears.
2. Click the Online Access button.
3. If prompted to log in to my.MYOB, log in. The Manage online access page opens in your browser.
4. Find the user in the relevant list.
5. Click Cancel Invitation. This user is removed from the list.

Check a user’s online status

When you invite a user to work with your company file online, a record of the invitation and user is created in my.MYOB so you can monitor who has access to your files.

A user’s status could be one of the following:

<table>
<thead>
<tr>
<th>This status</th>
<th>Means...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>the user has access.</td>
</tr>
<tr>
<td>Invited</td>
<td>the user has been invited, but has not responded to the invitation yet.</td>
</tr>
<tr>
<td>Access Removed</td>
<td>you removed this user’s access.</td>
</tr>
<tr>
<td>Invitation Cancelled</td>
<td>the invitation sent to this user was cancelled before they could respond.</td>
</tr>
<tr>
<td>Invitation Declined</td>
<td>the user declined the invitation.</td>
</tr>
<tr>
<td>Invitation Expired</td>
<td>the invitation was not accepted within a specified time.</td>
</tr>
</tbody>
</table>

To check the status of an invitation

1. Go to the Setup menu and choose Users. The User Access window appears.
2. Click the Online Access button.
3. If prompted to log in to my.MYOB, log in. The Manage online access page opens in your browser.
4. Use the filter options in the Status column in each list to show users according to status.
5. Click an available action in the Action column to change the user’s status, or to resend or cancel an invitation.

View transactions by user

If you want to check what changes have been made to your company file by a certain user, you can run the Journal Security Audit report. You can filter this report by User ID, for specified date ranges. For more information, see ‘Checking for unauthorised transactions’ on page 189.

MANAGE USERS
Manage bank feeds

Bank feeds is an AccountRight Live service that lets you compare your bank account and credit card transactions with those recorded in AccountRight. For information about setting up bank feeds, see 'Set up bank feeds', on page 49.

This section explains the bank feeds management tasks you may need to perform, including:

- checking the status of your bank feed application
- taking action if there is a problem with your application
- applying for another bank feed
- cancelling a bank feed
- giving other users access to bank feeds.

To perform these tasks, you need:

- internet access
- your my.MYOB login details.

To check your bank feed status

1. Start AccountRight.
2. Go to the Setup menu > Manage Bank Accounts. The Manage Bank Accounts window appears.
3. Click Add or remove a bank account. An internet browser window opens and the my.MYOB Log In page appears.
4. Log in with your my.MYOB login details. The My Products page appears, showing your bank feeds information. This includes your account details, the status of your bank feeds and any actions you may take for the selected account.

The following table lists the statuses of bank feeds and the actions you may need to take:

<table>
<thead>
<tr>
<th>For this status...</th>
<th>...do this:</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>BankLink awaiting form</td>
<td>If you haven’t already done so, print, complete and sign the authority form and post it to BankLink. Note that it can take up to two weeks for BankLink to set up a bank feed connection to your bank.</td>
<td>‘To reprint an authority form’ on page 184</td>
</tr>
<tr>
<td>Processing</td>
<td>Check your bank feed application status again later.</td>
<td>‘To check your bank feed status’, above.</td>
</tr>
<tr>
<td>BankLink processing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Awaiting bank</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For this status... | ...do this: | See
--- | --- | ---
• Account not supported | 1 Delete the bank feed account in AccountRight. | ‘To delete a cancelled bank feed account’ on page 184
• Account closed | 2 Apply for bank feeds for a different account. For a list of supported banks and accounts, see [myob.co.nz/arlive/banks](https://myob.co.nz/arlive/banks). | ‘To apply for a new bank feed’ below
• Cancelled | | |
• Invalid account name | | |
• Invalid account number | | |

**Note:** If your bank feed application was rejected because of invalid account details, you cannot simply repost a corrected authority form to BankLink; you must reapply for a new bank feed with the correct account details.

| Bank requires signature | Visit your bank and supply them with a signature matching the signature on the authority form. |
| New signature required | If the person who signed the authority form was:  
  • not the account signatory, reprint the authority form and post it to BankLink with the correct signature  
  • the account signatory, visit your bank and supply them with a signature for this person. | ‘To reprint an authority form’ on page 184

| Signature required | Reprint and sign the authority form and post to BankLink. | ‘To reprint an authority form’ on page 184

For this status... | ...do this: | See
--- | --- | ---
Rejected by bank | Email MYOB at bankfeeds@myob.com for more information. |
Bank feed ready | • If you haven’t already done so, associate an account in AccountRight with your bank feed.  
• Start working with bank feeds. | ‘To associate an account for a bank feed’ on page 50  
• ‘How bank feeds can work for you’ on page 66

### To apply for a new bank feed

1. Start AccountRight.
2. Go to the Setup menu > Manage Bank Accounts. The Manage Bank Accounts window appears.
3. Click Add or remove a bank account. An internet browser window opens and the my.MYOB Log In page appears.
4. Log in with your my.MYOB login details. The My Products page appears, showing your bank feeds information.
5. Click Add more bank accounts or Add more credit cards and follow the onscreen instructions.
6. On the Print the BankLink authority form page:
   a. Click Print Form. The BankLink authority form and cover sheet appear. A copy of the authority form is also sent to you by email.  
   b. Print the form.  
   c. Read the cover sheet and check your account details.  
   d. Sign the form and mail it to BankLink. You need to do this because BankLink requires an original signature to be authorised to set up bank feeds.
7. Click Done. The My Products page reappears. The Bank Feeds section is updated with the details of the bank feed you have just applied for.
To reprint an authority form

1 Start AccountRight.
2 Go to the Setup menu > Manage Bank Accounts. The Manage Bank Accounts window appears.
3 Click Add or remove a bank account. An internet browser window opens and the my.MYOB Log In page appears.
4 Log in with your my.MYOB login details. The My Products page appears, showing your bank feeds information.
5 Select an account and click Print authority form. The BankLink authority form and cover sheet appear.
6 Print the form.

To delete a cancelled bank feed account

1 Start AccountRight.
2 Go to the Setup menu > Manage Bank Accounts. The Manage Bank Accounts window appears.
3 Select the account you want to delete. Note that you cannot delete accounts that have received bank transactions.
4 Click the delete icon ( ). The account is deleted.

Controlling access to bank feeds

To give other users the ability to update bank feeds, you need to make them an online administrator of your company file. This enables them to:
- update bank feed transactions in AccountRight
- view the bank feeds management page in my.MYOB.

Note that online administrators are not able to apply for or cancel bank feeds. You need to be an AccountRight Live administrator (such as the software owner or the subscription owner) in order to perform these tasks.

To give a user the ability to update bank feeds

1 Start AccountRight.
2 Go to the Setup menu > Manage Bank Accounts. The Manage Bank Accounts window appears.
3 Click Add or remove a bank account. An internet browser window opens and the my.MYOB Log In page appears.
4 Log in with your my.MYOB login details. The My Products page appears, showing your bank feeds information.
5 Go to the My Products menu and choose Manage AccountRight Live. The Manage online access page appears.
6 Click Invite new online administrator. The invitation window appears.
7 Enter their email address, first name and last name.
8 Click Invite. The Manage online access page reappears with a confirmation message at the top.
9 An email will be sent to this user, inviting them to become an online administrator. To check whether they have accepted the invitation, see ‘To check the status of an invitation’ below.

To check the status of an invitation

1 Start AccountRight.
2 Go to the Setup menu > Manage Bank Accounts. The Manage Bank Accounts window appears.
3 Click Add or remove a bank account. An internet browser window opens and the my.MYOB Log In page appears. Your bank feed information appears.
4 Go to the My Products menu and choose Manage AccountRight Live. The Manage online access page appears.
5 Use the filter options in the Status column in each list to show users according to status. For information on what each status means, see the table in ‘Check a user’s online status’, on page 181.
6 Click an available action in the Action column to change the user’s status, or to resend or cancel an invitation.
Controlling who can view bank feeds in AccountRight  You can control which users can view bank feeds in AccountRight by assigning them roles. Only users with the Accounting/Bookkeeper or Banking roles can view bank feeds. For information on how to assign roles, see ‘To add a new user’, on page 36.

Manage libraries

A library is a location on a computer, where your AccountRight company file needs to be stored. If you do not store your company file online, it must be saved to one of the following library locations:

- **My library**—This library is located on your computer, and is automatically created when you install AccountRight.
  - Windows XP—C:\Documents and Settings\All Users\Shared Documents\MYOB\My AccountRight files
  - Windows Vista, Windows 7 and 8—C:\Users\Public\Public Documents\MYOB\My AccountRight files

Save your company file here if you do not want to share the file online, or save it to your computer network. Note that you can move your company file later, if you want to.

- **Network Library**—This library is located on another computer in your network, in the same folder location as above. You might choose to store your company file in a network library, so others in the network can access it. For information about accessing a network library, see ‘To add a network library’ below.

**NOTE:** Online company files  Online company files are stored in the online library. But you can synchronise a copy of your online file to your computer. For more information, see ‘Working online’, on page 53.

To add a network library

A network library is just a local library located on another computer in the network. To open a file stored in a network library, or to save a file to a network library, the library must be added to your network library list.

Before you do this, you need to know the computer’s network address. This could be the computer name you see in Windows when browsing your network (e.g. John’s Computer), or the computer’s IP address (e.g. 192.168.0.5).

**NOTE:** Find the computer name  You can find a computer’s name by viewing the System Properties window (right-click the My Computer icon on the desktop or Start menu, and choose Properties), or by opening the System control panel.

1. In the Library Browser window, click Network Libraries.
2. Click Add a network library. The Add a network library window appears.
3. Enter a name for the computer the library is on. For example, type John’s library.
4. Enter the IP address of the computer, or the name of the computer where the library is. For example, type 192.168.0.5 or John’s computer.
5. If you can’t use the default port number for this connection, click Advanced and enter the port number you want to use.
6. Click OK. The library now appears in the list.
7. Continue to open or save the file as required.

To add a company file to a library

1. Start AccountRight and click Open a company file. The Library Browser window appears.
2 Click a library option on the left, then click **Add a company file to this library**.

3 Navigate to the library folder or subfolder where you want to save the file. The file will be copied to the library and folder that you select.

**To add library subfolders**

A library folder is automatically created on the computer when you install AccountRight. However, if you have many files (for example, because you are a bookkeeper), you can add subfolders to the library using Windows Explorer to help manage your files.

---

**Backing up and restoring company files**

*Backing up* is like taking a snapshot of the state of your company file at a particular point in time.

*Restoring* enables you to open a backed up copy of your company file to view it locally, or to replace your online working copy (for example, if the online company file contains unauthorised transactions).

**Backups and online company files** If you subscribe to AccountRight Live and store your company file online, a copy of the online file is synchronised to your computer automatically, every 20 minutes. This means that if the internet drops out, or someone checks out the file while you’re still working, there’s a readable copy on your computer that is no more than 20 minutes old.

*This is not the same as a backup, however.* A backup is a snapshot of your company file at a particular point in time. So even if you work online, you may still want to make backups periodically, weekly, for example, or at the end of a financial period.

---

**Backing up**

When you back up your company file, a copy of the file in its current state is created as a compressed archive file with a .zip extension, so it takes up less space. You can store backups on external storage mediums, such as online storage, a CD, different hard disk or other media.

**Backing up tips**

Note the following before you back up your company file:

- **Appropriate storage media.** Different storage media offer different advantages. For example, CDs or USB-based devices are more portable, but offsite storage might be more secure.
- **Store backups in a different location to your company file.** Don’t store backups on the same hard disk as your current company file. A single disaster could wipe out all your records.
Don’t overwrite previous backups. If your current file is corrupt and you don’t realise it, and then you overwrite your previous backup file, you’ll no longer have a useable backup.

Store backups off site. Store backups in a secure place, for example, online with a cloud storage solution such as Dropbox. Except for daily rotational backups, we recommend you do not re-use media.

To make a backup of your company file
1. Close any open windows, other than the Command Centre.
2. Go to the File menu and choose Back Up. The Back Up Company File window appears.

A default filename is assigned.

<table>
<thead>
<tr>
<th>Default filename</th>
<th>Further details</th>
</tr>
</thead>
<tbody>
<tr>
<td>MYOBmmddyyyy.zip</td>
<td>mmddyyyy is the month, day and year from your computer’s clock</td>
</tr>
<tr>
<td></td>
<td>.zip is the file extension and cannot be changed.</td>
</tr>
</tbody>
</table>

[Optional] You can change the name of the backup file.

4. Click Browse and select where you want to save the backup file.
5. If you want to protect the backup from unauthorised use, enter and confirm a password. This password will need to be entered when restoring the backup file.
6. Click Back Up. The backup process begins.
7. If you are storing the backup file on a removable storage device, label all your backups with enough information to tell you when they were done and where you were up to in data entry—for example, ‘Friday, 13.05.13’ or ‘Backup as of 13.05.13’.

Restoring

There are two reasons for restoring a backup. You may want to:
- restore a backup locally in order to view historical information
- replace your online company file with a backup file. Note that you need to be authorised to replace your online file with a backup.

To restore a backup to view historical information
1. If the backup file is on a removable disk, insert the disk into the disk drive.
2. Close any open windows, other than the Command Centre.
3. Go to the File menu and choose Restore.
   The company file that was open is closed and the Restore Backup File window appears.

4. Click Browse and select the backup file you want to restore.
5 If the backup is password-protected, enter the password in the window that appears, and click OK.

6 If you want to change the AccountRight library or library folder that the file will be restored to, click Change Library and select the location for the restored company file.

7 Rename the restored file’s name if required. You cannot overwrite an existing file in the library.

8 Click Restore to complete the restore.

To replace your working company file with a backup

When you restore a company file online, your online working company file is replaced by the backup file. Any changes you've made to the company file online since the backup file was created, will be overwritten. This process cannot be undone.

Checking for unauthorised transactions  Before replacing a company file, you can check what changes have been made to it by running the Journal Security Audit report. This report shows what changes have been made in a selected period. See ‘Checking for unauthorised transactions’, on page 189.

NOTE: Administrator access to the online company file is required to do this task.

1 Open the company file.
2 If the backup file is on a removable disk, insert the disk into the disk drive.
3 Close any open windows, other than the Command Centre.
4 Go to the File menu and choose Restore.

5 The company file that was open is closed and the Restore Backup File window appears.

6 Click Browse and select the backup file you want to restore.

7 If the backup is password-protected, enter the password in the window that appears, and click OK.

8 Select the option to restore the company file online with AccountRight Live.

9 Rename the restored file’s name if required.

CAUTION: The next step cannot be undone  Any changes made to the company file since the backup was created will be overwritten.

8 Click Restore to complete the restore.
Company file security

AccountRight offers you a range of ways to control access to your data and monitor changes to your company file. You can specify what areas of the company file users can access and monitor user activity.

Note that controlling the access of other users to a company file requires AccountRight administrator access, which is also a key security feature. See ‘Set up user access’, on page 35.

These features are listed in the following table:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>control access to specific areas of your company file</td>
<td>‘Change company file details’ on page 179</td>
</tr>
<tr>
<td>control access to your online company file</td>
<td>‘Manage users’ on page 179</td>
</tr>
<tr>
<td>prevent others making changes to the company file while you are using it</td>
<td>‘Work offline (checking out)’ on page 58</td>
</tr>
<tr>
<td>prevent changes being made to the company file in a selected period</td>
<td>‘Lock periods’ on page 176</td>
</tr>
<tr>
<td>track user activity for a selected period, or check for unauthorised transactions</td>
<td>‘Checking for unauthorised transactions’ below</td>
</tr>
<tr>
<td>secure your company file backups</td>
<td>‘Backing up’ on page 186</td>
</tr>
</tbody>
</table>

Checking for unauthorised transactions

If you are concerned that unauthorised transactions have been entered into your company file, or if you want to check what changes have been made to your company file, you can run the Journal Security Audit report to see what transactions have been made by users for a selected period.

**NOTE:** Prevent others changing the file  If you want to prevent others making changes to the company file while you are running this report, you can work offline (check out). See ‘Work offline (checking out)’, on page 58.

1. Go to the Reports menu and choose Accounts. The Reports window appears.
2. Choose Security and Audit and then Journal Security Audit.
3. Choose filtering options. For example, you can show changes made in a specific date range, or by specific users.

You can filter the information on the report and customise how it appears. For more information, see ‘Customising reports’, on page 127.
Confirming activated company files

This topic is not applicable if your company file is stored online with AccountRight Live.

After a company file is activated, once or twice a year you must confirm its activation for the life of the file. The confirmation verifies to MYOB that you are running a legal installation of AccountRight. When confirmation is due and you attempt to open an activated company file, the Confirmation Assistant window appears.

You have a period of grace in which to confirm the company file, indicated in this window.

NOTE: Frequent requests to confirm Under normal circumstances, confirmation occurs once or twice a year. If, after confirming a company file, you are prompted within a short time to confirm it again, see ‘Troubleshooting activated company files’ on page 191.

If you don’t want to confirm immediately, select the Confirm Later option and click Next to open the file. After the period of grace expires, the company file can be opened only in read-only mode, in which you can still view transactions, print reports or export data, but you will not be able to enter any transactions.

NOTE: Confirming a read-only file If you open a company file that is overdue for confirmation in read-only mode, but then change your mind, go to the Help menu and choose Confirm Company File. The Confirmation Assistant window appears.

These procedures show you how to confirm an activated company file and set up automatic confirmation:

- ‘To confirm a company file online (recommended)’ below.
- ‘To confirm a company file by telephone’ below.
- ‘To set up automatic company file confirmation’ on page 191.

To confirm a company file online (recommended)

1. Ensure you are connected to the Internet.
2. In the Confirmation Assistant window, click I use this company file to record or edit my business transactions.
3. Select the Confirm Online confirmation option.
4. Click Next. Your serial number and company file code are sent to the MYOB confirmation server, which returns a confirmation code and extends the file activation.
   The Conclusion step of the assistant appears.
5. Click Close. The company file has been confirmed and you can continue to enter transactions.

To confirm a company file by telephone

Use this method only if you cannot connect to the internet.

1. In the Confirmation Assistant window, click I use this company file to record or edit my business transactions.
2. Select the Confirm by Phone confirmation option.
3. Click Next. The Confirm by Phone step of the assistant appears.
4. Call the telephone number displayed in this step of the assistant. You will need to provide the details shown in this window.
5. A licence file will be emailed to you. When you receive the email, detach the licence file.
6. In the Confirm by Phone step of the Confirmation Assistant, click Browse and then select the licence file you received.
7. Click Confirm. The Conclusion step of the assistant appears.

NOTE: Confirmation code used only once After you confirm your company file, the confirmation code cannot be used to confirm this or
any other company file again. You must get a new confirmation code each time you are prompted to confirm.

From now on, your company file is confirmed automatically and a notification of successful confirmation is displayed each time.

Troubleshooting activated company files

The activation and confirmation of company files is sensitive to changes of the date in your computer’s system clock. In some circumstances, changes in the system date may require you to confirm the company file again.

Note that if you confirm a company file several times within a short period of time, you may be prevented from using the file until you contact MYOB Customer Service.

NOTE: Confirmation help For more information about the confirmation process, and additional troubleshooting tips, click Help in the Confirmation Assistant window.

Managing software updates

AccountRight software updates are regularly provided to help you better manage your business and to ensure that your business complies with current government legislation.

NOTE: Software updates and AccountRight Live If you subscribe to AccountRight Live, you are automatically entitled to regular software updates. For more information, visit the MYOB website.

You receive AccountRight software updates via Software Manager. Software Manager is a web-based tool that notifies you when your software has been updated, and enables you to install the update from the web.

Before you can receive updates, you need to register for software updates. See ‘To register for software updates’ below.

To register for software updates

You need your 12-digit AccountRight serial number to register for updates.

TIP: Locating your AccountRight serial number A 12-digit serial number was provided to you when you purchased your software. You can also find your serial number in the Company Information window of your company file (go to the Setup menu and choose Company Information).

1 Make sure you are connected to the internet.
Go to the Start menu, open the MYOB AccountRight program folder (within the MYOB folder) and choose Register for Updates. The Register for Software Updates window appears.

Enter your 12-digit AccountRight serial number.

Click Register for Updates.

Repeat this procedure on each computer that you run AccountRight on.

Once you have registered for software updates, Software Manager enables you to:

- automatically receive update alerts so that you can install updates as soon as they’re available. See ‘To install a software update from an alert’ below.
- manually check for software updates and install them later. See ‘To manually check for a software update and install it’ below.

To install a software update from an alert

- Start AccountRight. If a software update alert appears, click Install Now to install the update.

To manually check for a software update and install it

Go to the Start menu, open the MYOB AccountRight program folder (in the MYOB folder) and choose Check for updates. The Software Manager window appears.

If an update is available, select the update and click:

- Install to install the update immediately.
- Download Only to save the update file to your computer to be installed later.

TIP: You can re-use the update file Copy the update file to a portable media device (such as a USB stick) so you can transfer it to each computer that you use AccountRight on. Note that you do not need to retain the downloaded update file after you have installed the update on each computer.

Repeat this procedure on each computer that you run AccountRight on.
15 Importing and exporting data

You can take data entered in your company file and use it in other software or in other company files. This process is called exporting data.

You can also take data entered in other software programs and incorporate it into your company file, or incorporate information from one company file into another company file. This process is called importing data.

The following table lists the record types that you can import and export.

<table>
<thead>
<tr>
<th>This record type</th>
<th>Can be…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Budgets</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Cards</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Contact Logs</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Custom Lists</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Disbursements</td>
<td>imported</td>
</tr>
<tr>
<td>General Journal entries, including GST information and GST reporting</td>
<td>imported and exported</td>
</tr>
<tr>
<td>GST Code List</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Items</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Jobs</td>
<td>imported and exported</td>
</tr>
<tr>
<td>MYOB Accounts Lists</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Receipts</td>
<td>imported</td>
</tr>
<tr>
<td>Receive Money transactions</td>
<td>exported</td>
</tr>
<tr>
<td>Sales</td>
<td>imported and exported</td>
</tr>
<tr>
<td>Spend Money transactions</td>
<td>exported</td>
</tr>
<tr>
<td>Transaction Journal entries (no GST information and GST reporting)</td>
<td>imported and exported</td>
</tr>
</tbody>
</table>
Exporting data

Your company file data can be exported to a tab-delimited or comma-separated text file:

- **Tab-separated files** contain fields that are separated by tab characters. For example, if a tab character appears between *Brewster and 300 Roundhill Drive* in a file of customer information, the file counts *Brewster* and *300 Roundhill Drive* as two separate fields in a record. Tab-separated files are a common export format in spreadsheet programs.

- **Comma-separated files** contain records that are separated by commas. For example, if a comma appears between *Brewster and 300 Roundhill Drive* in a file of customer information, the file counts *Brewster* and *300 Roundhill Drive* as two separate fields in a record. Comma-separated files are often used by popular database programs.

If you’re exporting data for use in another company file, you can choose either comma-separated or tab-separated formats. Note that comma-separated is automatically selected during import and export processes.

**Exporting customised forms** You can export customised forms from one company file to another. For more information, see ‘Exporting and importing customised forms’, on page 144.

**Exporting to Accountants Office** If your accountant uses MYOB Accountants Office, you can export financial information (including your accounts list, journal entries and sales) directly to MYOB Accountants Office as a tab-separated text file. This file can be sent by email or saved to disk. For more information, see ‘Provide information to your accountant’ on page 176.

---

**TIP:** *Share your data online* If you store your company file online, you can share your data with any user you have set up to access your online company file. For example, your accountant can access your company file and view journal entries without you having to export them. For more information about setting up access to your online company file, see ‘Set up user access’ on page 35.

To export data

1. Go to the **File** menu and choose **Import/Export Assistant**. The **Import and Export Assistant** window appears.
2. Select **Export data** and click **Next**.
3. Select the type of data you want to export from the **Export list**. If additional options appear in this window, you can complete them to filter the data that will be exported. Click **Next**.
4. Select whether the data in the exported file should be separated using tabs or commas, and whether the first row in the file should display the field headers. Click **Next**.
5. Choose the fields you want to export and the order in which you want to export them. To do this, click on the first field you want to
export in the **Available Fields** column and then click **Add**. The field name will appear in the **Fields to export** column.

**NOTE:** Required fields for importing and exporting data  When you import or export data, certain data fields must have valid matching fields in the target software. If a field has an asterisk (*) next to it, you must select a matching field to it. If two fields have a caret (^) next to them, you must select a matching field to one or both fields.

6 Repeat the previous step for each field you want to export. If you want to remove a field’s name from the **Fields to export** column, click its name and then click **Remove**. If you want to export all fields, click **Add All**.

7 If you want to change the order in which the fields are exported, select the field you want to move and then click the up or down buttons.

8 When you have selected the fields, click **Export**.

9 In the **Save As** window that appears, enter a name and location for the export file and click **Save**. The data is exported and saved as a text file.

10 When the data has finished exporting, click **Close**.

---

**Importing data**

You can import data into your company file from a tab-delimited or comma-separated text file. Before you start the import process, you will need to export the data you want from the program you’ve used to create the data.

**Importing customised forms**  You can import customised forms from one company file to another. For more information, see ‘Exporting and importing customised forms’, on page 144.

**If you are importing an accounts list**  If your accountant uses MYOB Accountants Office, you can import an accounts list from it. For more information, see ‘Importing an accounts list from MYOB Accountants Office’ on page 196.

**To import data**

**NOTE:** Before you import data you should make a backup of your company file. See ‘Backing up and restoring company files’ on page 186.

1  Go to the **File** menu, and choose **Import/Export Assistant**. The **Import and Export Assistant** window appears.
Select **Import data** and click **Next**.

Select the type of data you want to import from the **Import** list.

Click **Browse** to locate and select the file you want to import, and then click **Next**.

Select the import file format, the type of the first record, and the method of handling duplicate records. Click **Help** and then choose **Help for This Window**.

Click **Next** and match the import fields with fields in the **Available fields** column. To do this:

a. Click the name of a field in the **Import fields** column.

b. Click the matching field in the **Available fields** column.

The import field you selected appears in the **Matched Import fields** column.

**NOTE:** Some fields must be imported. Fields that have an asterisk (*) next to them must have matching import file fields assigned to them.

If all the fields in the import file match those in the **Available fields** column, including their order, click **Match All**. If the fields in your import file are not in the same order, click **Auto Match** to match the fields that have the same names.

Click **Next**. If you didn’t make a backup prior to starting the import process, click **Backup** to make one now.

Click **Import** to import the data.

If you get a warning or an error message indicating that the import was not successful, refer to the import log file, which you can access from the **Conclusion** step of the assistant.

When the data has finished importing, click **Close**.

---

**Importing an accounts list from MYOB Accountants Office**

When you create a company file, you can choose to import an accounts list from a file provided by your accountant (see ‘Create a company file’ on page 26). If the file was created by MYOB Accountants Office—with a .txt extension—follow this procedure to import the accounts list. (Ask your accountant for a new file if it does not have a .txt extension.)

Once you have imported an accounts list from MYOB Accountants Office, you can import journal transactions from your accountant. For more information, see ‘Enter end-of-year adjustments’ on page 177.

**To import the accounts list provided by your accountant**

1. Go to the **File** menu, choose **AccountantLink**, then **Receive from Accountant**, and choose **List of Accounts**. A message appears, informing you that the account levels might be reset.

2. Click **Yes** if you want to continue the import. The **Open** window appears.

3. Select the file containing the accounts list sent by your accountant. The default name of the file is **MYOB_SET.txt**. However, your accountant may have renamed the file.

4. Click **Open** to open the file and begin the import process.

The accounts are imported and a message is displayed, giving you the results of the import. If you get a warning or an error message indicating that the import was not successful, refer to the import log file for a list of errors or warnings.
Glossary

account  Something to which transactions are assigned. Accounts in AccountRight are in one of eight classifications:
- Asset
- Liability
- Equity
- Income
- Cost of sales
- Expense
- Other income
- Other expense

Accounts can be set up as header or detail. Transactions are assigned directly to detail accounts. Header accounts are used to summarise and group multiple detail accounts. Each AccountRight account must have a unique number.

account classification  One of the eight accounts groups in the Accounts List: Assets, Liabilities, Equity, Income, Cost of Sales, Expense, Other Income, Other Expense.

account number  The account number identifies an account. Each AccountRight account must have a unique number.

accounting period  A part of your financial year. AccountRight treats each calendar month as a separate accounting period.

accounts list  Commonly referred to as a chart of accounts, this is a list of all your asset, liability, equity, income, cost of sales and expense, other income and other expense accounts.

accounts receivable  What your customers owe you. The sum of all accounts receivable is recorded as an asset account. Any time you record a sale in the Sales command centre, the unpaid balance of the sale is added to your accounts receivable balance. Every time you enter a customer payment (using the Sales command centre), the amount is subtracted from your accounts receivable balance.

accrual method (basis)  This is a method of accounting which records sales at the time they’re delivered, not at the time they’re paid for. This is the opposite of the cash method of accounting.

accrued expenses  These are expenses for goods or services received but not yet paid.

Administrator  A role you can assign to a user, that gives them access to the entire company file. The Administrator ID is created automatically upon creation of the company file. A user with an administrator role can create other user accounts.

ageing: receivables  The number of days between invoicing a customer and an ageing date (usually today).

allocation accounts  In AccountRight, when writing a cheque or recording a payment, the allocation accounts are the expense, income, etc. accounts that balance the transaction.
assets  Assets are things you own. Your bank account is an asset. So is your computer. If someone owes you money, the total owed to you is an asset. Current assets are assets that can be turned into cash within a relatively short period of time (less than a year). Things that take longer to turn into cash, like your factory building, are called fixed assets. Assets normally have a debit balance.

associated account  An account that is used to match your bank feed transactions to transactions in AccountRight.

associated account  An account that is used to match your bank feed transactions to transactions in AccountRight.

B

bad debt  Money owed to you that is unlikely to be paid. Many businesses create a contra-asset account to approximate the value of their bad debt. That way, they have a clearer picture of the actual value of their assets.

balance  The sum of all the money added to and subtracted from an account.

balance sheet  The balance sheet is a financial snapshot of a company’s position at a particular time. A balance sheet lists the company’s asset, liability and equity accounts. It is called a balance sheet because the total value of the asset accounts minus the total value of the liability accounts always equals the total of the equity accounts.

bank feed  The list of transactions recorded by your financial institution for your bank or credit card account, which can be brought directly into AccountRight. To set up a bank feed, you first need to specify your account details, and then authorise BankLink (who manage bank feeds) to set up a connection to your bank.

BankLink  AccountRight banks feeds are securely managed through the BankLink service. BankLink supplies the technology used to bring bank feeds into your AccountRight software.

bill  The record of a supplier’s invoice.

budgets  Expected monthly net activity for an account. Budgets are useful for planning for the future and for analysing actual performance against planned performance.

Business Insights  Use the Business Insights window to analyse key financial information using a range of interactive tables and graphs. You can use it to analyse your accounts, profit and loss, the money that you owe suppliers and the money that customers owe you.

C

cash drawer  Where the money is kept between leaving the customers’ hands and being deposited in the bank. Many businesses set up their cash drawer as a bank account.

cash method (basis)  The opposite of the accrual method of accounting. The cash method records the sale of goods and services at the time they’re paid for, not when they’re delivered.

checking out  See working offline (checking out).

cleared  A withdrawal or deposit is cleared when your bank adjusts your account balance for it.

closed period  An accounting period in which all entries are completed. AccountRight does not require that you actively close a period. However, in Preferences you can prevent accidental posting to a closed (locked) period.

closed sales  Sales that have been paid in full.

company file users  Those who have access to the AccountRight company file. When you set them up, you specify their User ID and password, which they need to use to sign on to the company file each time they open it. You also assign them a user role, which determines which areas of AccountRight they can access, and what tasks they can perform. You can only set up company files users if you are a company file Administrator. See also user role and online user.
company information  Found in AccountRight’s Setup menu, your company information contains your company’s name, address, GST information and information about your company’s financial year.

contra account  This is an account that normally carries the opposite balance of the accounts of the same type. Assets, for example, normally have a debit balance; a common contra-asset account is the accrued depreciation of an asset. By using a contra account, you can show a company car that’s worth $12,000, by listing the asset at its $15,000 purchase price followed by the -$3,000 balance of the accrued depreciation account.

conversion month  The conversion month is the earliest month in the financial year for which transactions are to be recorded. For example, suppose you purchase your AccountRight software in October but want to record transactions dated from 1 September. In this case, your conversion month is September. The conversion month determines the opening balances you will enter when you set up your company file.

cost of sales  Sometimes called cost of goods sold, this account type works just like an expense account. The only difference is where it appears on the profit & loss statement. Cost of Sales accounts appear after your income accounts but before your expense accounts. Cost of Sales is subtracted from your income to produce gross profit. Your expenses are subtracted from your gross profit to produce net profit. You are not required to use Cost of Sales accounts.

credit amount  Appears on the right side of the ledger (a debit amount occupies the left side). A credit amount increases the balance of accounts with a credit balance and decreases the balance of accounts with a debit balance. Accounts that normally carry a credit balance are liability, equity and income accounts.

credit invoice  A credit invoice is a sale with a negative balance due. Usually caused by a return or adjustment, a credit invoice is settled by writing a refund cheque or applying the amount to another open invoice.

credit terms  Terms are the agreed upon rules governing the number of days between delivery and payment discounts for early payment and penalties. You can set default terms for all customers.

current assets  Assets that can be turned into cash within a relatively short time (less than a year) are called current assets. Some of your current assets are your bank accounts, accounts receivable and petty cash. Current assets usually do not lose their value over time. Current assets normally have a debit balance.

current liabilities  Liabilities that become payable within the next year are called current liabilities. When recording a liability that is to be paid over a long period, many accountants split it into two liabilities. The part that is to be paid off within the next year is entered as a current liability; the remaining part is entered as a long-term liability.

current year earnings  Current year earnings is an equity account. Its balance equals your income minus cost of sales and expenses. Current year earnings are zero at the beginning of a financial year. Current year earnings are kept as a running total as the financial year progresses. When you start a new financial year, current year earnings are reset to zero when its balance is moved into the account called Retained Earnings.

customer  Someone to whom you sell goods or services. In AccountRight, you must enter a customer card before you record a sale.

D

debit  Appears on the left side of the ledger (the credit amount occupies the right side); a debit amount increases the balance of accounts with a debit balance and decreases the balance of accounts with a credit balance. Accounts that normally carry a debit balance are assets and expense accounts.

debtors  A debtor is someone who owes you money. See also accounts receivable.

deposits from customers  Advances received for goods or services not yet delivered. Customer deposits are kept in a liability account.
**depreciation**  The expense allocation of the cost of an asset over a period of time. Most accountants create a contra-asset account to track the depreciation of an asset. See also contra account. A typical depreciation transaction credits the contra asset account and debits a depreciation expense account. Depreciation is most often recorded as a general journal entry.

**detail accounts**  An AccountRight account to which transactions can be assigned.

**discount early payment**  The amount taken off the balance due in return for payment within an agreed number of days.

**discount days**  Discount days are the number of days from a sale within which full payment of the balance due entitles the payee to a discount.

**double-entry accounting**  A method of bookkeeping in which every entry is balanced by another entry. Correct double-entry accounting always provides a balanced set of books; that is, the total value of your asset accounts minus the total of your liability accounts will equal the total of your equity accounts.

---

**E**

**earnings**  Income minus cost of sales and expenses. See also current year earnings.

**electronic payment**  A payment that directly debits or credits your bank. For example, you can choose to pay a supplier electronically by setting up electronic payment details in the supplier card.

**equity**  This is a company’s net worth. The equity of a company equals its assets minus its liabilities. Equity is an account type in AccountRight. Equity accounts usually carry a credit balance. Some common equity accounts are current year earnings, retained earnings and shareholder’s equity.

---

**F**

**finance charge**  The amount added to an outstanding balance as a penalty for late payment.

**financial statements**  The balance sheet and income (profit & loss) statement. The balance sheet is your company’s financial picture at a particular time. The income statement shows your company’s financial performance over a period of time.

**financial year**  The 12-month period you use to define your accounting year. Your AccountRight software does not require that it match the calendar year.

**fixed assets**  Fixed assets are assets that have a relatively long life. Your buildings, cars and computers are fixed assets. Fixed assets are usually depreciated; that is, they lose some of their value as you use them.

---

**G**

**general journal**  A journal used to record miscellaneous transactions not entered in other journals, for example, year-end adjustments and depreciation expense.

**general ledger**  This is where all your account information—sales, cash in, cash out—come together. You draw your financial statements (balance sheet and income statement) from the general ledger.

**gross profit**  Gross profit is your income minus cost of sales.
header account  A header account in AccountRight is used to group similar detail accounts. You cannot post a transaction to a header account.

historical balance  The balance of an account prior to converting your records to AccountRight. You are not required to enter historical balances in AccountRight. Enter them only if you wish to compare a current month’s activity to the activity for the same month last year.

identifiers  A one-letter code used to sort and select cards in the card file. You can assign up to 26 identifiers to a card.

income  Revenue from the sale of goods or services. Income is an account type in AccountRight. Income accounts usually carry a credit balance.

income statement  Also called a profit & loss statement, the income statement shows your company's performance over a period of time. An income statement begins with income. It then subtracts cost of sales to produce a gross profit. Expenses are subtracted from gross profit to produce operating profit. ‘Other income’ accounts are added to operating profit and ‘other expense’ accounts are subtracted from operating profit to produce net profit.

invoice  The written record of a sale.

invoice rules  Rules that you set up to automatically handle bank feed transactions. Based on the rule conditions that you specify, AccountRight will match the bank feed transaction to the an existing open invoice. Rules are useful for transactions that occur regularly. See also transaction rules.

item  A unit in your items list. An item can be physical inventory, like a widget or a pair of shoes, or it can be non-physical, like an hour of your time.

job  A job is work for which you wish to track income and expenses. In AccountRight, a job can be a profit centre, a product line, a project or any other subset of your business that requires a separate income statement.

journal  A journal is a tool for organising your accounting entries. All entries are grouped into one of four journals: general, disbursements, receipts and sales.

Journal Security Audit  A report which lists the changes made to transaction dates, accounts and amounts, and also lists all transaction reversals and deletions made within a specified date range.

liability  Liabilities are things you owe. Your working capital loan is a liability. Liabilities that are due within the next year are called current liabilities. When a liability is not due for more than a year, it is called a long-term liability. Liabilities normally have a credit balance.

library  The location on your computer or a network computer where AccountRight company files are stored. If you do not store your company file online, it must be saved to either My Library (a folder automatically created when you install AccountRight) or the Network Library (a library located on another computer in your network).

linked account  Linked accounts are what AccountRight uses to post your sales and banking transactions to the proper account. When, for example, you link your receivables account, you are telling AccountRight which account to post the balance due from a sale to.

long-term liability  Something you owe that does not have to be paid for at least a year.
M

miscellaneous sales Used in AccountRight to record non-item sales that do not require a printed invoice.

N

net income Net income (net profit or loss) is the total of all income accounts minus the sum of your expense and cost of sales accounts.

net profit The total of all income accounts minus the sum of your expense and cost of sales accounts. Also called net income.

Number of Days after EOM A setting to indicate that the payment due date and early payment discount date are based on a set number of days after the end of the month.

O

online company file If you are subscribed to AccountRight Live, you can store your company file online, so that you, your accountant and other authorised users can access the file online, using any computer that has AccountRight installed.

online user Those who have access to online company files. They may be set up as an online file user or an online administrator. To be able to work on the files, online users also need to be set up as company file users; their user role will determine what tasks they can perform. See also company file users and user role.

open sale A sale with an outstanding balance due.

opening balance The balance of an account as at the start of the first day of your conversion month.

other expenses An account type used to record expenses that are not directly related to your company’s operations, such as loan interest, fines, etc. ‘Other expense’ accounts usually have a debit balance.

other income An account type used to record income that is not directly related to your company’s operations, such as interest income. ‘Other income’ accounts usually have a credit balance.

out of balance When the total credit amount does not equal the total debit amount in a transaction, it is out of balance. AccountRight does not allow you to record an out-of-balance transaction.

P

profit & loss statement See income statement.

profit centre A subset of your business for which you want to track income and expenses. In AccountRight profit centres are called ‘jobs’.

promised date The date a pending sale is due to be delivered.

R

recap transaction A function that lets you look at a journal entry before it is recorded. Recap transaction is particularly useful for those transactions, like invoices, for which the journal entry is not immediately obvious.

receivables What someone else owes you for items or services delivered. See accounts receivable.

reconciling The process of checking that your records agree with your bank’s records.
recurring transaction An accounting entry that is made periodically, such as monthly rent, etc.

restoring The process of reopening a backup company file.

retained earnings Money from previous years’ earnings that has been left in the company. At the end of a financial year any money earned (or lost) during the financial year is transferred to retained earnings. Retained earnings are recorded in an equity account.

revenue Income from the sale of goods or services. Revenue is recorded in an income account in AccountRight. Income accounts usually carry a credit balance.

role A set of windows and functions that a user can access in the company file. The Administrator role is assigned to users who require full access to the company file.

S

settle a credit invoice When someone returns something, and you record an invoice that has a negative balance due, it is called a credit invoice. Paying off this negative amount is called settling a credit invoice.

Session Security Audit A report that helps you keep track of each user’s activity, such as the date and time that a user signs on to the company file and sign off.

supplier Someone from whom you buy goods or services.

synchronisation The process by which changes that you or other users make in your online company file are downloaded to a copy of the file stored on your computer (referred to as the ‘offline’ copy of your file). Your offline company file will be synchronised automatically every 20 minutes, while the company file is open. You can also manually synchronise your file.

T

terms Terms are the agreed upon rules governing the number of days between delivery and payment, discounts for early payment and penalties for late payment.

transaction An entry in AccountRight that affects the balance of accounts.

transaction rules Rules that you set up to automatically handle bank feed transactions. Based on the rule conditions that you specify, AccountRight will create a new transaction corresponding to the bank feed transaction, and then match the two. Rules are useful for transactions that occur regularly. See also invoice rules.

trial balance This is a report showing all the activity for an account or accounts within a selected date range. It shows the balance of the account at the beginning of the date range, the activity within the date range, and the balance at the end of the date range. A trial balance is useful for checking your entries prior to doing your period-end processing.

undeposited funds account The linked account into which individual cash-receipts transactions are recorded when not credited directly to cheque or credit card accounts. Amounts from individual transactions in the undeposited funds account are grouped together. When deposited, they are recorded as a single bank deposit transaction on the bank or credit card statement.

user accounts User accounts are the basis for the software’s security system, and can be used to keep track of the actions of each person who performs tasks that affect the company file. A user ID and password is entered when signing on to the company file.

user role A role is a predefined profile that determines what windows a user can access and what tasks they can perform in a company file. For example, a user assigned the ‘sales’ role can access features in the Sales, Time Billing and Card File command centres, and other sales related areas, such as lists. A user can be assigned more than one role. See also company file users and online user.
W

**working offline (checking out)**  If you are set up as an online administrator, you can choose to work offline with your online company file. Working offline means that you will be checking out the file to your computer—this locks the online file from being modified by others, although they can still view the file. Once you are done with your work, you can check in the changes.

Z

**zoom arrow**  An icon that allows a user to review, or ‘zoom to’ more detailed information about a specific topic, such as a transaction.
Index

A

Account Information window 32
Account Opening Balances window 34
account types 31
accountant
receiving adjustments from 177
accountant (AccountantLink)
receiving adjustments from 177
sending data to 176
accountant(AccountantLink)
receiving accounts list from 196
AccountRight Live 22
bank feeds 23
checking in 58
checking out 58
checking service status 60
discarding offline changes 59
getting started 53
inviting users 35 36
offline file location 57
opening online files 55
purchasing a subscription 53
requirements 54
support 23
synchronising 57 58
troubleshooting connection 60
undoing a check out 59
uploading existing files 54
viewing a read-only copy 60
working offline 58
working online 22
AccountRight updates 191
accounts
adding 32
assigning GST codes to 107
budgets for 163
changing 109
classifications 31
for statement of cash flows 33
combining 111
creating 32
exporting 193
financial information, tracking 161
finding 108
grouping, detail 33
header 31
importing 193
from MYOB Accountants Office 196
indenting 33
list of 27
new 32
numbers 31
opening balances 33
bank accounts 34
reconciling
for the first time 46
transferring money between 80
types of 31
Accounts List window 32
accounts receivable
reconciling accounts at
month-end 171
year-end 171
activation of company files
confirming activation
automatically 191
by telephone 190
over the Internet 190
troubleshooting 191
adjustments
entering in 13th period 177
importing from accountants 177
making at year-end 177
administrator account
passwords 36
See also user accounts
arrows 20
asset accounts 31
auditing company file information 170

B

backing up company files 186
bad debts
writing off 103
bank accounts
adding 32
deposits 78
employee’s bank information for electronic payments 46
opening balances 34
reconciling
for the first time 46
supplier’s bank information 45
bank feeds
application status 182
approving 68
associate account to feed 49
controlling access to 184
managing 182
matching 67
automatically 67
by rules 67
manually 67
overview 66
setting up 49
bank feeds rules 70
allocation options 73
invoice rules 70
search options 72
transaction rules 70
Bank Register window
finding a transaction using 116
Get Statement button 84
recording transactions in 74
Split button 75
bank service charges, recording 83
bank statement
adding transactions from 84
importing 84
reconciling 82 83 84
bills
paying 74
blank lines, inserting between line items 92
Budget Shortcuts window 164
budgets 163
choosing accounts for 163
half-yearly 165
monthly 165
quarterly 165
reports for 164
yearly 165
business contacts, maintaining list of 148

Business Insights
analysing customer information 94
analysing sales 94

C

calculator 20
calendar 19
Card ID field 158
Card Information window 145
cards
adding 145
customer 87
employee 145
personal 145
supplier 145
assigning GST codes to 107
changing 109
creating for
customers 145
employees 145
items 52
suppliers 145
custom lists and fields 151
exporting 193
finding 108
identification code 158
importing 193
inactivating 109
organising in groups 150
personal 145
reactivating 109
synchronising cards and Outlook contacts 152
viewing on a map 150
categories
creating 161
finding 108
setting up 161
using to track financial information 161
check spelling 22
checking in online files 58
checking out online files 58
discarding changes 59
cheques
custom 137
customising 137 141
entering 74 76
previewing 77
printing 134
recurring 77
stubs, customising 141
closing a financial year 176
combining accounts 111
command centres 14 17–18
Company Data Auditor 167 170–172
company file access
user IDs 35
Company File Confirmation window 190
company files
access
removing 179
access control 36
auditing 170
backing up 186
confirming
automatically 191
by telephone 190
over the Internet 190
troubleshooting 191
creating new
library 185
sample 16
security
serial number, entering 30
setting up user access 35
users 35 36
working online 53
confirmation of company files
automatic confirmation 191
by telephone 190
over the Internet 190
over the internet
confirmation codes 190
troubleshooting 191
contact log 148
contact management 145
See also cards
conversion month 26
cost of sales accounts 31
credit card statement
adding transactions from 84
matching transactions with 84
credit control
credit holds 99
credit limits 99
credit terms 42 89
finance charges 99 100
Credit Limit & Hold window 99
credit limits
setting 99
credit terms
changing for
all sales 89
this sale 89
default for sales 42
setting for all sales to a customer 88
current financial year 26
custom fields
creating
for items 114
recording card details using 158
recording item details using 114
custom forms
adding graphics and logos 140
adding lines 141
adding shapes 141
adding tables 140
aligning elements on 143
arranging elements 143
cheques 137
data fields 139
deleting elements from editing objects 142
elements of 131
exporting 144
importing 144
page properties, setting 138
previewing 137
removing elements 142
resizing elements 142
setting up page properties 138
size of 138
text fields 139
tool palette 138
undo changes 143
custom lists
creating for
cards 151
items 113
filtering inventory reports with 114
printing on invoices 114
custom reports
adding graphics and logos 129
adding lines 130
adding shapes 130
adding watermark 130
changing background 130
data fields 129
editing background 131
editing elements 131
saving 132
customer credits
deleting 117
issuing 100
recording 101
settling 102
<table>
<thead>
<tr>
<th>Page</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>165</td>
<td>half-yearly budgets</td>
</tr>
<tr>
<td>31</td>
<td>header accounts</td>
</tr>
<tr>
<td>92</td>
<td>headers line items in transactions</td>
</tr>
<tr>
<td>13</td>
<td>Help centre</td>
</tr>
<tr>
<td>150</td>
<td>Identifiers, using to group cards</td>
</tr>
<tr>
<td>194</td>
<td>Import and Export Assistant window</td>
</tr>
<tr>
<td>196</td>
<td>import log file</td>
</tr>
<tr>
<td>195</td>
<td>importing data</td>
</tr>
<tr>
<td>196</td>
<td>importing statements</td>
</tr>
<tr>
<td>196</td>
<td>from accountants</td>
</tr>
<tr>
<td>156</td>
<td>from Outlook</td>
</tr>
<tr>
<td>105</td>
<td>list adding records to</td>
</tr>
<tr>
<td>113</td>
<td>creating custom for items</td>
</tr>
<tr>
<td>110</td>
<td>deleting records from</td>
</tr>
<tr>
<td>109</td>
<td>inactivating records in</td>
</tr>
<tr>
<td>55</td>
<td>logging in to AccountRight Live</td>
</tr>
<tr>
<td>140</td>
<td>adding to forms</td>
</tr>
<tr>
<td>140</td>
<td>adding to reports</td>
</tr>
<tr>
<td>130</td>
<td>See also pictures</td>
</tr>
<tr>
<td>162</td>
<td>opening balances, entering</td>
</tr>
<tr>
<td>161</td>
<td>setting up</td>
</tr>
<tr>
<td>161</td>
<td>using to track income and expenses</td>
</tr>
<tr>
<td>120</td>
<td>journal entries</td>
</tr>
<tr>
<td>193</td>
<td>creating recurring transactions for</td>
</tr>
<tr>
<td>115</td>
<td>finding</td>
</tr>
<tr>
<td>193</td>
<td>listing for sales</td>
</tr>
<tr>
<td>177</td>
<td>recording</td>
</tr>
<tr>
<td>52</td>
<td>Item Information window</td>
</tr>
<tr>
<td>92</td>
<td>items adding</td>
</tr>
<tr>
<td>137</td>
<td>customising forms sales</td>
</tr>
<tr>
<td>113</td>
<td>custom lists</td>
</tr>
<tr>
<td>114</td>
<td>and inventory reports</td>
</tr>
<tr>
<td>112</td>
<td>customising</td>
</tr>
<tr>
<td>193</td>
<td>exporting</td>
</tr>
<tr>
<td>108</td>
<td>finding</td>
</tr>
<tr>
<td>95</td>
<td>sales history</td>
</tr>
<tr>
<td>114</td>
<td>using custom fields for recording details of</td>
</tr>
<tr>
<td>76</td>
<td>jobs assigning to</td>
</tr>
<tr>
<td>90</td>
<td>receiving blank lines between</td>
</tr>
<tr>
<td>77</td>
<td>showing subtotal of</td>
</tr>
<tr>
<td>92</td>
<td>using headers to group</td>
</tr>
<tr>
<td>37</td>
<td>invitations, for online access</td>
</tr>
<tr>
<td>56</td>
<td>accepting</td>
</tr>
<tr>
<td>180</td>
<td>cancelling</td>
</tr>
<tr>
<td>37</td>
<td>sending</td>
</tr>
<tr>
<td>165</td>
<td>monthly budgets</td>
</tr>
<tr>
<td>185</td>
<td>my.MYOB, login details</td>
</tr>
<tr>
<td>176</td>
<td>exporting data to</td>
</tr>
<tr>
<td>176</td>
<td>MYOB Accountants Office</td>
</tr>
</tbody>
</table>
N

navigation shortcuts 17
network library 185

O

OfficeLink, creating letters using 146
offline, working with AccountRight Live 58
online company file 54
online help 13
opening a company file online 55
opening balances jobs 162
Outlook contacts. See synchronising cards and Outlook contacts
overdue invoices See also credit terms

P

password administrators, setting for 36
company file users changing 179
setting 37
payment method, setting up default 42
payments electronic 79
exporting 194
importing 195
making 74 76
receiving 74 95
personalised letters creating 146
pictures adding to card 159
to cards 159
to forms 140
to reports 130
adding to items 52
removing 159
replacing 159
Portable Document Format (PDF) file creating reports 126
saving sales as 92
preferences Apply Customer Payments Automatically to Oldest Invoice First 102
I Prefer to Use Automated Online Company File Confirmation 29
Transactions CAN’T be Changed; They Must be Reversed 35 119
Prepare Bank Deposit window 118
Prepare Budgets window 164
Prepare Electronic Payments window 80
previewing cheques 77
custom forms 137
custom reports 126
remittance advices 77
sales 92
printing cheques 77
customer statements 173
forms 134
invoices 92
in a batch 134
purchases in a batch 134
receipts 98
remittance advices 77
purchases remittance advice, sending 77
Q

quotes converting to invoices 93
customer 89
quarterly budgets 165
R

records adding 105
using Easy-Add 105
changing 109
creating 145
deleting 110
inactivating 109
reactivating 109
removing 110
reconciling bank accounts 82
receivables accounts 171
Record Journal Entry window entering adjustments 177
recurring transactions 120—124
automatically recording 121
changing 122
cheques 75 76 77
creating 120
creating from an existing entry 122
deleting 123
editing 122
pre-dated 121
recording multiple 123
single 123
rescheduling 123
receiving payments customer payments 95
printing payment receipts 98
recording against invoices 96
receiving payments. See receiving money
reconciled transactions, deleting 118
reconciling bank accounts 82
receivables accounts 171
Receive Money window 75
Receive Payments window 96
receive customer payments 95
cash payments 74
cheque payments 74
credit card payments 74
customer payments 95
exporting transactions 193
grouping with undeposited funds 75
invoice payments 95
credit card payments 74
customer payments 95
exporting transactions 193
grouping with undeposited funds 75
invoice payments 95
receiving payments customer payments 95
printing payment receipts 98
recording against invoices 96
receiving payments. See receiving money
reconciled transactions, deleting 118
reconciling bank accounts 82
receivables accounts 171
Record Journal Entry window entering adjustments 177
records adding 105
using Easy-Add 105
changing 109
creating 145
deleting 110
inactivating 109
reactivating 109
removing 110
recurring transactions 120—124
automatically recording 121
changing 122
cheques 75 76 77
creating 120
creating from an existing entry 122
deleting 123
editing 122
pre-dated 121
recording multiple 123
single 123
rescheduling 123

I N D E X
refunds. See customer credits; supplier debts

remittance advices
preparing 133
previewing 77
sending 77 133

reports 125–132
adding a picture to 130
adding data to 128
adding graphics to 129
adding shapes and lines to 130
adding text to 129
adding watermark 130
changing background of 130
customisation tools 131
customising 127
filters 127
deleting custom 132
designing 128
displaying 125
elements editing 131
filtering data in 127
previewing 126
printing 125–126
reviewing at month-end 172
sales reports 95
saving 126
saving as comma-separated values (CSV) files 127
PDF files 126	table-delimited values files 126
saving custom 132
saving in other formats 126
sending 126
sorting columns in 129

S

sales
analysing using Business Insights 94
assigning GST code to a sale 90
batch printing 134
changing status of 93
choosing type of 90
deleting 118
emailing 92
entering 74 89
exporting 193
history, viewing for item or customer 95
importing 193
invoice 89
layout 90
previewing 92
printing 92
custom lists on invoices 114
in a batch 134
quote 89
recurring 92
reports 95
saving as a PDF file 92
viewing list of unpaid sales 95
Sales command centre 89
Sales Register window 116
Sales window 90
sample company file 16
search icons 20
Select a Recurring Transaction window 123
select columns 20
serial number
entering into company files while activating by telephone 30
while activating over the Internet 30
Settle Returns & Credits window 102
Software Manager 191
software updates 191
spell-check 22
Spend Money window 76
spending money
electronic payments 79
exporting transactions 193
importing transactions 193
sending remittance advice 77
Split button 75
statements
emailing 173
exporting 84
printing 173
reconciling 82
sending at month-end 173
status bar menu 18 57
sub-jobs 162
subscription to AccountRight Live 53
subtotal, showing in transactions 92
suppliers
bank information, entering 45
paying electronically 79
Synchronisation results window 155
157
Synchronise Cards window 154
synchronising cards and Outlook contacts
export cards to Outlook contacts 153
import Outlook contacts to cards 155
including custom fields 153 154
when you use a PDA 153 154
synchronising online files
automatic synchronisation disabling 57
automatic synchronisations enabling 57
manual synchronisation 58

T

taxes
change amount assigned to
Receive Money transactions 76
Spend Money transactions 77
taxes. See GST codes
tool palette 138
Transaction Journal window 116
transactions
changing 118
create recurring 120
create recurring from an existing entry 122
deleting 118
exporting 194
finding 18 115–117
identifying user who entered 36
importing
from bank or credit card statement 84
Transactions CAN'T be Changed; They Must be Reversed

recapping 119
recurring 120–124
reversing 119
unchangeable 118

Transactions CAN'T be Changed; They Must be Reversed

transferring
money 80
tutorial 16

Users
audit access 181
company file access
change password
new 35
setting up 35 36
new 36
online access 180
administrator 180
change 179 180
inviting 37
remove 180
roles 179
transactions 181
users online access
inactivate 180

Variable
View Contact Log window 148
void cheque 75
voiding 75
volume discounts
giving 90

Working
working offline 58
working with a company file online 55

Year, Financial
year-end
close a financial year 178
end of financial year tasks 176
entering budgets 163
entering end-of-year adjustments 177
financial
reconciling accounts 171
provide information to your accountant 176
yearly budgets 165

Zoom
zoom arrows 20